Part 15: Personal Computer Statement. This equipment has been certified to comply with the limits for a Class B computing device, pursuant to Subpart J of Part 15 of FCC Rules. Only peripherals (computing input/output devices, terminals, printers, etc.) certified to comply with the Class B limits may be attached to this computer. Operation with noncertified peripherals is likely to result in interference to radio and television reception.

Part 68: Answer-Supervision Signaling. Allowing this equipment to be operated in a manner that does not provide proper answer-supervision signaling is in violation of Part 68 rules. This equipment returns answer-supervision signals to the public switched network when:

• Answered by the called station
• Answered by the attendant
• Routed to a recorded announcement that can be administered by the CPE user

This equipment returns answer-supervision signals on all DID calls forwarded back to the public switched telephone network. Permissible exceptions are:

• A call is unanswered
• A busy tone is received
• A reorder tone is received

Canadian Department of Communications (DOC) Interference Information

This digital apparatus does not exceed the Class A limits for radio noise emissions set out in the radio interference regulations of the Canadian Department of Communications.

Le Présent Appareil Numérique n’émet pas de bruits radioélectriques dépassant les limites applicables aux appareils numériques de la class A préscrites dans le règlement sur le brouillage radioélectrique édicté par le ministère des Communications du Canada.

Trademarks

• DEFINITY is a registered trademark of Lucent Technologies.
• CentreVu is a registered trademark of Lucent Technologies.
• CONVERSANT is a registered trademark of Lucent Technologies.
• Informix is a registered trademark of Informix Software, Inc.
• Intel is a registered trademark of Intel.
• Microsoft, MS, MS-DOS, Windows, Windows 95, Windows NT, and Access are registered trademarks of Microsoft Corporation.
• OpenLink is a trademark of OpenLink Software.
• Crystal Reports is a trademark of SeaGate Software.
• Solaris is a trademark of Sun Microsystems, Inc.
• SPARC trademarks, including the SCD compliant logo, are trademarks or registered trademarks of SPARC International, Inc.
• SPARCstation, SPARCserver, SPARCengine, SPARCworks, and SPARCCompiler are licensed exclusively to Sun Microsystems, Inc. Products bearing SPARC trademarks are based upon an architecture developed by Sun Microsystems, Inc.
• Sun and Sun Microsystems are trademarks or registered trademarks of Sun Microsystems, Inc.
• Ultra Enterprise 3000 and Ultra 5 are trademarks of Sun Microsystems, Inc.
• UNIX is a registered trademark in the United States and other countries, licensed exclusively through X/Open Company Limited.
• All other products mentioned herein are the trademarks of their respective owners.

Definities

Federal Communications Commission Statement

Part 15: Class A Statement. This equipment has been tested and found to comply with the limits for a Class A digital device, pursuant to Part 15 of the FCC Rules. These limits are designed to provide reasonable protection against harmful interference when the equipment is operated in a commercial environment. This equipment generates, uses, and can radiate radio frequency energy and, if not installed and used in accordance with the instruction manual, may cause harmful interference to radio communications. Operation of this equipment in a residential area is likely to cause interference at his own expense.

Part 15: Class B Statement. This equipment has been tested and found to comply with the limits for a Class B digital device, pursuant to Part 15 of the FCC Rules. These limits are designed to provide reasonable protection against harmful interference in a residential installation. This equipment generates, uses, and can radiate radio-frequency energy and, if not installed and used in accordance with the instructions, may cause harmful interference to radio communications. However, there is no guarantee that interference will not occur in a particular installation. If this equipment does cause harmful interference to radio or television reception, which can be determined by turning the equipment off and on, the user is encouraged to try to correct the interference by one or more of the following measures:

• Reorient the receiving television or radio antenna where this may be done safely.
• To the extent possible, relocate the receiver with respect to the telephone equipment.
• Where the telephone equipment requires ac power, plug the telephone into a different ac outlet so that the telephone equipment and receiver are on different branch circuits.

Lucent Technologies Fraud Intervention

If you suspect that you are being victimized by toll fraud and you need technical support or assistance, call Technical Service Center Toll Fraud Intervention Hotline at 1-800-643-2353.

Notice

Every effort was made to ensure that the information in this book was complete and accurate at the time of printing. However, information is subject to change.

Your Responsibility for Your System’s Security

Toll fraud is the unauthorized use of your telecommunications system by an unauthorized party, for example, persons other than your company’s employees, agents, subcontractors, or persons working on your company’s behalf. Note that there may be a risk of toll fraud associated with your telecommunications system and, if toll fraud occurs, it can result in substantial additional charges for your telecommunications services.

You and your system manager are responsible for the security of your system, such as programming and configuring your equipment to prevent unauthorized use. The system manager is also responsible for reading all installation, instruction, and system administration documents provided with this product in order to fully understand the features that can introduce risk of toll fraud and the steps that can be taken to reduce that risk. Lucent Technologies does not warrant that this product is immune from or will prevent unauthorized use of common-carrier telecommunication services or facilities accessed through or connected to it. Lucent Technologies will not be responsible for any charges that result from such unauthorized use.

Canadian Department of Communications (DOC) Interference Information

This digital apparatus does not exceed the Class A limits for radio noise emissions set out in the radio interference regulations of the Canadian Department of Communications.

Toll fraud is the unauthorized use of your telecommunications system by an unauthorized party, for example, persons other than your company’s employees, agents, subcontractors, or persons working on your company’s behalf. Note that there may be a risk of toll fraud associated with your telecommunications system and, if toll fraud occurs, it can result in substantial additional charges for your telecommunications services.

You and your system manager are responsible for the security of your system, such as programming and configuring your equipment to prevent unauthorized use. The system manager is also responsible for reading all installation, instruction, and system administration documents provided with this product in order to fully understand the features that can introduce risk of toll fraud and the steps that can be taken to reduce that risk. Lucent Technologies does not warrant that this product is immune from or will prevent unauthorized use of common-carrier telecommunication services or facilities accessed through or connected to it. Lucent Technologies will not be responsible for any charges that result from such unauthorized use.

Toll fraud is the unauthorized use of your telecommunications system by an unauthorized party, for example, persons other than your company’s employees, agents, subcontractors, or persons working on your company’s behalf. Note that there may be a risk of toll fraud associated with your telecommunications system and, if toll fraud occurs, it can result in substantial additional charges for your telecommunications services.

You and your system manager are responsible for the security of your system, such as programming and configuring your equipment to prevent unauthorized use. The system manager is also responsible for reading all installation, instruction, and system administration documents provided with this product in order to fully understand the features that can introduce risk of toll fraud and the steps that can be taken to reduce that risk. Lucent Technologies does not warrant that this product is immune from or will prevent unauthorized use of common-carrier telecommunication services or facilities accessed through or connected to it. Lucent Technologies will not be responsible for any charges that result from such unauthorized use.

Federal Communications Commission Statement

Part 15: Class A Statement. This equipment has been tested and found to comply with the limits for a Class A digital device, pursuant to Part 15 of the FCC Rules. These limits are designed to provide reasonable protection against harmful interference when the equipment is operated in a commercial environment. This equipment generates, uses, and can radiate radio frequency energy and, if not installed and used in accordance with the instruction manual, may cause harmful interference to radio communications. Operation of this equipment in a residential area is likely to cause harmful interference, in which case the user will be required to correct the interference at his own expense.

Part 15: Class B Statement. This equipment has been tested and found to comply with the limits for a Class B digital device, pursuant to Part 15 of the FCC Rules. These limits are designed to provide reasonable protection against harmful interference in a residential installation. This equipment generates, uses, and can radiate radio-frequency energy and, if not installed and used in accordance with the instructions, may cause harmful interference to radio communications. However, there is no guarantee that interference will not occur in a particular installation. If this equipment does cause harmful interference to radio or television reception, which can be determined by turning the equipment off and on, the user is encouraged to try to correct the interference by one or more of the following measures:

• Reorient the receiving television or radio antenna where this may be done safely.
• To the extent possible, relocate the receiver with respect to the telephone equipment.
• Where the telephone equipment requires ac power, plug the telephone into a different ac outlet so that the telephone equipment and receiver are on different branch circuits.

Part 15: Personal Computer Statement. This equipment has been certified to comply with the limits for a Class B computing device, pursuant to Subpart J of Part 15 of FCC Rules. Only peripherals (computing input/output devices, terminals, printers, etc.) certified to comply with the Class B limits may be attached to this computer. Operation with noncertified peripherals is likely to result in interference to radio and television reception.

Part 68: Answer-Supervision Signaling. Allowing this equipment to be operated in a manner that does not provide proper answer-supervision signaling is in violation of Part 68 rules. This equipment returns answer-supervision signals to the public switched network when:

• Answered by the called station
• Answered by the attendant
• Routed to a recorded announcement that can be administered by the CPE user

This equipment returns answer-supervision signals on all DID calls forwarded back to the public switched telephone network. Permissible exceptions are:

• A call is unanswered
• A busy tone is received
• A reorder tone is received

Canadian Department of Communications (DOC) Interference Information

This digital apparatus does not exceed the Class A limits for radio noise emissions set out in the radio interference regulations of the Canadian Department of Communications.

Le Présent Appareil Numérique n’émet pas de bruits radioélectriques dépassant les limites applicables aux appareils numériques de la class A préscrites dans le règlement sur le brouillage radioélectrique édicté par le ministère des Communications du Canada.

Trademarks

• DEFINITY is a registered trademark of Lucent Technologies.
• CentreVu is a registered trademark of Lucent Technologies.
• CONVERSANT is a registered trademark of Lucent Technologies.
• Informix is a registered trademark of Informix Software, Inc.
• Intel is a registered trademark of Intel.
• Microsoft, MS, MS-DOS, Windows, Windows 95, Windows NT, and Access are registered trademarks of Microsoft Corporation.
• OpenLink is a trademark of OpenLink Software.
• Crystal Reports is a trademark of SeaGate Software.
• Solaris is a trademark of Sun Microsystems, Inc.
• SPARC trademarks, including the SCD compliant logo, are trademarks or registered trademarks of SPARC International, Inc.
• SPARCstation, SPARCserver, SPARCengine, SPARCworks, and SPARCCompiler are licensed exclusively to Sun Microsystems, Inc. Products bearing SPARC trademarks are based upon an architecture developed by Sun Microsystems, Inc.
• Sun and Sun Microsystems are trademarks or registered trademarks of Sun Microsystems, Inc.
• Ultra Enterprise 3000 and Ultra 5 are trademarks of Sun Microsystems, Inc.
• UNIX is a registered trademark in the United States and other countries, licensed exclusively through X/Open Company Limited.
• All other products mentioned herein are the trademarks of their respective owners.
Ordering Information
Call: Lucent Technologies Publications Center
   Voice: 1-800-457-1235
   International Voice: 317-322-6416
   Fax: 1-800-457-1764
   International Fax: 317-322-6699
Write: Lucent Technologies BCS Publications Center
   2855 N. Franklin Road
   Indianapolis, IN 46219
Order: Document No. 585-210-930
       Comcode 108502196
       Issue 1, December 1999

You can be placed on a Standing Order list for this and other documents you may need. Standing Order will enable you to automatically receive updated versions of individual documents or document sets, billed to account information that you provide. For more information on Standing Orders, or to be put on a list to receive future issues of this document, please contact the Lucent Technologies Publications Center.

Warranty
Lucent Technologies provides a limited warranty on this product. Refer to the “Limited use Software License Agreement” card provided with your package.

European Union Declaration of Conformity
Lucent Technologies Business Communications Systems declares that XXX equipment specified in this document conforms to the referenced European Union (EU) Directives and Harmonized Standards listed below:
EMC Directive 89/336/EEC
Low Voltage Directive 73/23/EEC
The “CE” mark affixed to the equipment means that it conforms to the above Directives.

Disclaimer
Intellectual property related to this product (including trademarks) and registered to AT&T Corporation has been transferred to Lucent Technologies Incorporated.

Any references within this text to American Telephone and Telegraph Corporation or AT&T should be interpreted as references to Lucent Technologies Incorporated. The exception is cross references to books published prior to December 31, 1996, which retain their original AT&T titles.

Heritage Statement
Lucent Technologies—formed as a result of AT&T’s planned restructuring—designs, builds, and delivers a wide range of public and private networks, communication systems and software, consumer and business telephone systems, and microelectronics components. The world-renowned Bell Laboratories is the research and development arm for the company.

Comments
To comment on this document, return the comment card at the front of the document.

Acknowledgment
This document was developed by Lucent Technologies Global Learning Solutions Organization.
# CentreVu® Report Designer Version 8 User Guide

## Table of Contents

1. **Introduction** ................................. 1-1
   - About the Report Designer .................. 1-1
   - About the Report Wizard .................. 1-3
   - Contents of This Document .............. 1-4
   - Conventions Used in This Document .... 1-6
   - Related Documents ...................... 1-7

2. **Using the Report Wizard** .................. 2-1
   - About the Report Wizard .................. 2-1
     - How the Report Wizard Works .......... 2-1
   - Starting the Report Wizard ............. 2-5
     - Toolbar Button ....................... 2-5
     - Report Selector Window ............... 2-6
   - Creating a New Report ..................... 2-7
     - Selecting a Report Type Page .......... 2-8
     - Selecting a Report Layout Page ...... 2-10
     - Defining a Report Layout Section(s) 2-13
     - Selecting the Table Format .......... 2-21
     - Changing Input Captions .............. 2-26
     - Saving the Report ..................... 2-27
     - Finishing the Report .................. 2-29

3. **Using the Report Manager** .............. 3-1
   - Introduction .............................. 3-1
   - About the Report Manager ............ 3-2
   - Viewing or Changing a Report’s Properties 3-3
   - Copying a Report to the Designer Category 3-4
   - Copying a Designer Report to a File .... 3-7
   - Copying a Designer Report from a File 3-9
   - Deleting a Report from the Designer Category 3-11
   - Opening the Report Designer Using the Edit or New Button 3-12
<table>
<thead>
<tr>
<th>Section</th>
<th>Title</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>7</td>
<td>Edit</td>
<td>Queries</td>
</tr>
<tr>
<td></td>
<td>Introduction</td>
<td>7-1</td>
</tr>
<tr>
<td></td>
<td>Defining Queries for a Report</td>
<td>7-2</td>
</tr>
<tr>
<td></td>
<td>Creating a Real-Time or Historical Query</td>
<td>7-3</td>
</tr>
<tr>
<td></td>
<td>Creating an Integrated Query</td>
<td>7-12</td>
</tr>
<tr>
<td></td>
<td>Editing an Existing Real-Time or Historical Query</td>
<td>7-17</td>
</tr>
<tr>
<td></td>
<td>Editing an Existing Integrated Query</td>
<td>7-21</td>
</tr>
<tr>
<td></td>
<td>Copying a Query</td>
<td>7-25</td>
</tr>
<tr>
<td></td>
<td>Deleting a Query</td>
<td>7-26</td>
</tr>
<tr>
<td>8</td>
<td>Insert</td>
<td>Chart</td>
</tr>
<tr>
<td></td>
<td>Introduction</td>
<td>8-1</td>
</tr>
<tr>
<td></td>
<td>Inserting a Chart on a Report</td>
<td>8-2</td>
</tr>
<tr>
<td>9</td>
<td>Insert</td>
<td>Field</td>
</tr>
<tr>
<td></td>
<td>Introduction</td>
<td>9-1</td>
</tr>
<tr>
<td></td>
<td>Using the Field Assistant “Select a field type” Window</td>
<td>9-2</td>
</tr>
<tr>
<td></td>
<td>Inserting an ACD Name Field on the Report</td>
<td>9-3</td>
</tr>
<tr>
<td></td>
<td>Inserting Data Item Fields on the Report</td>
<td>9-4</td>
</tr>
<tr>
<td></td>
<td>Inserting Input Value Fields on the Report</td>
<td>9-5</td>
</tr>
<tr>
<td></td>
<td>Inserting Report Data Start Time Field on the Report</td>
<td>9-6</td>
</tr>
<tr>
<td></td>
<td>Inserting Time Report Run Field on the Report</td>
<td>9-7</td>
</tr>
<tr>
<td>10</td>
<td>Insert</td>
<td>Table</td>
</tr>
<tr>
<td></td>
<td>Introduction</td>
<td>10-1</td>
</tr>
<tr>
<td></td>
<td>Inserting a Table on the Report</td>
<td>10-2</td>
</tr>
<tr>
<td>11</td>
<td>Insert</td>
<td>Text</td>
</tr>
<tr>
<td></td>
<td>Introduction</td>
<td>11-1</td>
</tr>
<tr>
<td></td>
<td>Inserting Text on the Report</td>
<td>11-2</td>
</tr>
<tr>
<td>12</td>
<td>Format</td>
<td>Chart</td>
</tr>
<tr>
<td></td>
<td>Introduction</td>
<td>12-1</td>
</tr>
<tr>
<td></td>
<td>Formatting a Chart in a Report</td>
<td>12-2</td>
</tr>
<tr>
<td></td>
<td>General Tab</td>
<td>12-3</td>
</tr>
<tr>
<td></td>
<td>General Tab Options</td>
<td>12-3</td>
</tr>
<tr>
<td>Section</td>
<td>Page</td>
<td></td>
</tr>
<tr>
<td>---------</td>
<td>------</td>
<td></td>
</tr>
<tr>
<td>Using the General Tab</td>
<td>12-4</td>
<td></td>
</tr>
<tr>
<td>Axis Tab</td>
<td>12-5</td>
<td></td>
</tr>
<tr>
<td>Axis Tab Options</td>
<td>12-5</td>
<td></td>
</tr>
<tr>
<td>Using the Axis Tab</td>
<td>12-7</td>
<td></td>
</tr>
<tr>
<td>Data Tab</td>
<td>12-9</td>
<td></td>
</tr>
<tr>
<td>Data Tab Options</td>
<td>12-9</td>
<td></td>
</tr>
<tr>
<td>Using the Data Tab</td>
<td>12-9</td>
<td></td>
</tr>
<tr>
<td>Data Labels Tab</td>
<td>12-11</td>
<td></td>
</tr>
<tr>
<td>Data Labels Tab Options</td>
<td>12-11</td>
<td></td>
</tr>
<tr>
<td>Using the Data Labels Tab</td>
<td>12-12</td>
<td></td>
</tr>
<tr>
<td>Fonts Tab</td>
<td>12-13</td>
<td></td>
</tr>
<tr>
<td>Fonts Tab Options</td>
<td>12-13</td>
<td></td>
</tr>
<tr>
<td>Using the Fonts Tab</td>
<td>12-13</td>
<td></td>
</tr>
<tr>
<td>Legend Tab</td>
<td>12-15</td>
<td></td>
</tr>
<tr>
<td>Legend Tab Options</td>
<td>12-15</td>
<td></td>
</tr>
<tr>
<td>Using the Legend Tab</td>
<td>12-16</td>
<td></td>
</tr>
<tr>
<td>Series Labels Tab</td>
<td>12-17</td>
<td></td>
</tr>
<tr>
<td>Series Labels Tab Options</td>
<td>12-17</td>
<td></td>
</tr>
<tr>
<td>Using the Series Labels Tab</td>
<td>12-17</td>
<td></td>
</tr>
<tr>
<td>Title Tab</td>
<td>12-18</td>
<td></td>
</tr>
<tr>
<td>Title Tab Options</td>
<td>12-18</td>
<td></td>
</tr>
<tr>
<td>Using the Title Tab</td>
<td>12-18</td>
<td></td>
</tr>
<tr>
<td>Type Tab</td>
<td>12-20</td>
<td></td>
</tr>
<tr>
<td>Type Tab Options</td>
<td>12-20</td>
<td></td>
</tr>
<tr>
<td>Using the Type Tab</td>
<td>12-21</td>
<td></td>
</tr>
<tr>
<td>3D Effects Tab</td>
<td>12-22</td>
<td></td>
</tr>
<tr>
<td>3D Effects Tab Options</td>
<td>12-22</td>
<td></td>
</tr>
<tr>
<td>Using the 3D Effects Tab</td>
<td>12-24</td>
<td></td>
</tr>
<tr>
<td>13 Format</td>
<td>Table</td>
<td>13-1</td>
</tr>
<tr>
<td>Introduction</td>
<td>13-1</td>
<td></td>
</tr>
<tr>
<td>Formatting a Table in a Report</td>
<td>13-2</td>
<td></td>
</tr>
<tr>
<td>General Tab</td>
<td>13-3</td>
<td></td>
</tr>
<tr>
<td>General Tab Options</td>
<td>13-3</td>
<td></td>
</tr>
<tr>
<td>Using the General Tab</td>
<td>13-4</td>
<td></td>
</tr>
<tr>
<td>Data Tab</td>
<td>13-5</td>
<td></td>
</tr>
<tr>
<td>Data Tab Options</td>
<td>13-5</td>
<td></td>
</tr>
<tr>
<td>Using the Data Tab</td>
<td>13-5</td>
<td></td>
</tr>
<tr>
<td>Fonts Tab</td>
<td>13-6</td>
<td></td>
</tr>
<tr>
<td>Fonts Tab Options</td>
<td>13-6</td>
<td></td>
</tr>
<tr>
<td>Using the Fonts Tab</td>
<td>13-7</td>
<td></td>
</tr>
<tr>
<td>Format Tab</td>
<td>13-8</td>
<td></td>
</tr>
<tr>
<td>Section</td>
<td>Page</td>
<td></td>
</tr>
<tr>
<td>------------------------------------------------------------------------</td>
<td>------</td>
<td></td>
</tr>
<tr>
<td>Format Tab Options</td>
<td>13-8</td>
<td></td>
</tr>
<tr>
<td>Using the Format Tab</td>
<td>13-9</td>
<td></td>
</tr>
<tr>
<td>Headers Tab</td>
<td>13-10</td>
<td></td>
</tr>
<tr>
<td>Headers Tab Options</td>
<td>13-10</td>
<td></td>
</tr>
<tr>
<td>Using the Headers Tab</td>
<td>13-10</td>
<td></td>
</tr>
<tr>
<td>Sort Tab</td>
<td>13-11</td>
<td></td>
</tr>
<tr>
<td>Sort Tab Options</td>
<td>13-11</td>
<td></td>
</tr>
<tr>
<td>Using the Sort Tab</td>
<td>13-12</td>
<td></td>
</tr>
<tr>
<td>Summary Tab</td>
<td>13-13</td>
<td></td>
</tr>
<tr>
<td>Summary Tab Options</td>
<td>13-13</td>
<td></td>
</tr>
<tr>
<td>Using the Summary Tab</td>
<td>13-14</td>
<td></td>
</tr>
<tr>
<td>Format</td>
<td>Field</td>
<td>14-1</td>
</tr>
<tr>
<td>Introduction</td>
<td>14-1</td>
<td></td>
</tr>
<tr>
<td>Field Format Window Elements</td>
<td>14-2</td>
<td></td>
</tr>
<tr>
<td>Using the Field Format Options Window</td>
<td>14-4</td>
<td></td>
</tr>
<tr>
<td>Format</td>
<td>Text</td>
<td>15-1</td>
</tr>
<tr>
<td>Introduction</td>
<td>15-1</td>
<td></td>
</tr>
<tr>
<td>Text Format Options Window Elements</td>
<td>15-2</td>
<td></td>
</tr>
<tr>
<td>Formatting Text on the Report</td>
<td>15-3</td>
<td></td>
</tr>
<tr>
<td>Error Messages</td>
<td>16-1</td>
<td></td>
</tr>
<tr>
<td>Introduction</td>
<td>16-1</td>
<td></td>
</tr>
<tr>
<td>Phase 1 Error Messages</td>
<td>16-2</td>
<td></td>
</tr>
<tr>
<td>Phase 2 Historical Report Error Codes</td>
<td>16-5</td>
<td></td>
</tr>
<tr>
<td>Phase 2 Real-Time Report Error Codes</td>
<td>16-11</td>
<td></td>
</tr>
<tr>
<td>How CentreVu® CMS Stores and Retrieves Data</td>
<td>17-1</td>
<td></td>
</tr>
<tr>
<td>Introduction</td>
<td>17-1</td>
<td></td>
</tr>
<tr>
<td>How CentreVu CMS Stores Data</td>
<td>17-2</td>
<td></td>
</tr>
<tr>
<td>How CentreVu CMS Retrieves Data</td>
<td>17-5</td>
<td></td>
</tr>
<tr>
<td>SQL Query and CMS Database Table Basics</td>
<td>18-1</td>
<td></td>
</tr>
<tr>
<td>Introduction</td>
<td>18-1</td>
<td></td>
</tr>
<tr>
<td>About SQL Queries</td>
<td>18-2</td>
<td></td>
</tr>
<tr>
<td>Basic WHERE Clause</td>
<td>18-2</td>
<td></td>
</tr>
<tr>
<td>WHERE Clause with Variable</td>
<td>18-3</td>
<td></td>
</tr>
<tr>
<td>Multiple WHERE Clauses</td>
<td>18-4</td>
<td></td>
</tr>
<tr>
<td>WHERE Clause with a Range/List Variable</td>
<td>18-4</td>
<td></td>
</tr>
</tbody>
</table>
1 Introduction

About the Report Designer

The Report Designer feature can be purchased with the Lucent CentreVu® Supervisor software. The Report Designer allows you to create reports that are tailored to your call center needs. You then run the reports you have created from the Supervisor application.

The Report Designer allows you to create new reports, edit standard Call Management System (CMS) and Supervisor reports, and copy items from one report to another report.

When you use the Report Designer to edit an existing report or to create a new one, you usually begin by creating or modifying a Structured Query Language (SQL) query. Using the database items contained in the table(s) referenced in the query, you can populate fields, grids, and charts for the report. The fields, grids, and charts can then be sized, moved, and changed on the report.

When you have finished creating or editing a report, you save the report on the CMS server. If you assigned Global user permissions to the report, other Supervisor users with the appropriate permissions can run the report.

When you create real-time, historical, and integrated reports, the Report Designer lets you do the following:

- Copy existing report designs, including standard report designs
- Edit reports by adding, moving, copying, and deleting fields, grids, or charts
- Define Automatic Call Distribution (ACD) data for report fields, grids, and charts
- Enter text for field labels, column headers, row headers, or special instructions.

For historical reports only, the Report Designer allows you to do the following:

- Merge data in a report field to include data from different entities within an ACD (for example, defining a field that represents the percentage of calls an agent answered compared to all calls handled by that agent’s split or skill).
- Merge data in a report field to include data with different time frames (for example, defining a field that represents the percentage of calls answered in an intrahour interval compared to all calls answered in the day).
- Include data from custom data tables that you create and populate within the CentreVu CMS database.
If you create custom database tables, as described in Chapter 18, “SQL Query and CMS Database Table Basics” make sure that you name the tables with the prefix “c_.” If you do not use the c_ convention, the custom tables will not automatically be backed up.

If you create custom data tables, then you need to make sure there is enough disk space available to store the data. CMS does not automatically check the available space. If you fill up your disk with custom data, you will lose or damage stored custom and ACD data. See the *CentreVu® CMS R3V8 Administration* (585-210-910) document for more information about disk storage.

Do not tamper with standard ACD data in the CMS database. If you do, then you will lose stored data.

For integrated reports only, the Report Designer allows you to do the following:

- Display real-time and historical data on the same report
- Display cumulative data that shows up-to-the-moment data since a specified interval start time in the past 24 hours.
About the Report Wizard

Report Wizard is a supplement to Report Designer. The Report Wizard feature delivers user assistance, by way of a wizard, to quickly and easily generate new customized reports. The wizard provides instructional help that guides you through a series of tasks that create a new customized report.

The Report Wizard feature is available only if you have purchased the Report Designer feature. Report Wizard can be accessed only when Report Designer is activated on the CMS server and when you have the appropriate permissions to access Report Designer.

All reports created using Report Wizard have the same designation and accessibility as those created in Report Designer. Thus, reports created by Report Wizard are referred to as Report Designer reports. This means that reports created by Report Wizard will be accessible only by CentreVu Supervisor users and cannot be listed, modified, or run through the ASCII terminal interface.
Contents of This Document

This book describes what you need to know to create new reports and to edit existing reports through the Report Designer and Report Wizard. The book is organized as follows:

- **Chapter 1, Introduction** — gives you background information on the Report Designer application and general information about this book.

- **Chapter 2, Using the Report Wizard** — gives you background information on the Report Wizard (features and functionality) and steps you through the creation of a new report.

- **Chapter 3, Using the Report Manager** — teaches you the basic procedures you need to know in order to use the Report Manager feature of Supervisor. The procedures included in this chapter are Viewing a Report’s Properties, Copying a Report to the Designer Category, Copying a Designer Report to a File, Copying a Designer Report from a File, Deleting a Report from the Designer Category, and Opening the Report Designer Using the Edit or New Button.

- **Chapter 4, Report Designer Basics** — teaches you the basic information that you need to know in order to use the Report Designer. The procedures included in this chapter are Starting the Report Designer, Exiting the Report Designer, Report Designer Menus, Steps Required to Create a New Report, and Steps Required to Edit an Existing Report.

- **Chapter 5, Design Mode Basics** — teaches you basic procedures that you will use in the Report Designer design mode. The procedures included in this chapter are Copying an Item and Pasting the Item Into the Same Report, Copying an Item from One Report and Pasting the Item Into Another Report, Cutting an Item from a Report, Deleting an Item from the Report, Using Drag-and-Drop to Arrange Items on the Report, Resizing an Item on the Report, and Selecting Multiple Items on the Report.

- **Chapter 6, Edit | Inputs** — shows you how to edit the existing input fields that are used on the input window for the report you are editing. The procedures included in this chapter are Adding Input Fields to the Input Window, Deleting Input Fields from Input Window, Editing the Order of Input Fields, Editing the Appearance of Input Fields, and Viewing the Input Window.
• Chapter 7, Edit | Queries — shows you how to edit the existing queries and create new queries for the report you are editing. The sections included in this chapter are Defining Queries for a Report, Creating a New Real-Time or Historical Query, Creating a New Integrated Query, Editing an Existing Query, Copying a Query, and Deleting a Query.

• Chapter 8, Insert | Chart — teaches you to insert a chart on a report.

• Chapter 9, Insert | Field — teaches you to insert a field on a report.

• Chapter 10, Insert | Table — teaches you to insert a table on a report.

• Chapter 11, Insert | Text — teaches you to insert text on a report.

• Chapter 12, Format | Chart — gives you general information about the tabs that you access from the Chart option of the Format menu.

• Chapter 13, Format | Table — gives you general information about the tabs that you access from the Table option of the Format menu.

• Chapter 14, Format | Field — gives you general information about the window that you access from the Format option of the Format menu.

• Chapter 15, Format | Text — gives you general information about the window that you access from the Text option of the Format menu.

• Chapter 16, Error Messages — lists the most common errors that you will encounter as a result of errors in queries that you create for reports.

• Chapter 17, How CentreVu CMS Stores and Retrieves Data — gives you general information about how the CMS server stores and retrieves the data that is used in the reports.

• Chapter 18, SQL Query and CMS Database Table Basics — gives you general information about how INFORMIX SQL queries work and how the INFORMIX tables that are used in CMS are structured. If you are not familiar with SQL queries, you need to read this chapter before you attempt to create a query for your report.


*INFORMIX is a registered trademark of Informix Software, Inc.
Conventions Used in This Document

The following conventions are used in this book:

- The instructions given in this book are based on the assumption that you are familiar with your computer and the Windows operating system, including standard Window conventions, such as using the F1 key to activate Help.

- To use this book successfully, you must be familiar with the Supervisor application and have some knowledge of how CMS reports work.

For instructions on using the Supervisor application, refer to the CentreVu® CMS R3V8 Administration (585-210-910) document. For information on CMS reports, refer to the CentreVu® Supervisor Version 8 Reports document (585-210-929).

- Windows refers to the following operating systems:
  - Windows 95†
  - Windows NT‡ 4.0.

- Unless the right button is specified, use the left mouse button whenever you are instructed to click or select an item.

- Menu names, menu items, and window names are shown in initial capital letters. For example: Choose Save from the File menu.

- Italics are used to reference other documents, to reference file names, and for trademarks.

- Sections and chapters that are referred to in text are shown in quotes. For example: See Chapter 1, “Introduction,” for an outline of the information in this book.

- A graphic of each Supervisor window is not included in this book. Graphics are provided to give you general information about a type of window, or to help clarify a procedure that is being described. The examples in this book are taken from Supervisor running in Windows 95.

---

*Windows is a registered trademark of Microsoft Corp.
†Windows 95 is a registered trademark of Microsoft Corp.
‡Windows NT is a registered trademark of Microsoft Corp.
Related Documents

The following documents include additional information about the CMS or Supervisor:

- *CentreVu® Supervisor Version 8 Installation and Getting Started* (585-210-928)
- *CentreVu® CMS Release 3 Version 8 Administration* (585-210-910)
- *CentreVu® Supervisor Version 8 Reports* (585-210-929)
<table>
<thead>
<tr>
<th>Introduction</th>
<th>CentreVu Report Designer Version 8 User Guide</th>
</tr>
</thead>
<tbody>
<tr>
<td>Related Documents</td>
<td>1-8</td>
</tr>
</tbody>
</table>
2 Using the Report Wizard

About the Report Wizard

Report Wizard is a supplement to Report Designer and is available only if you have purchased Report Designer. The Report Wizard feature delivers user assistance, by way of a wizard, to quickly and easily generate new customized reports. The wizard provides instructional help that guides you through a series of tasks that create a new customized report.

The following features are available in the Report Wizard:

- Creating a new report
- Previewing the new report
- Saving the new report
- Running the new report.

All reports created using Report Wizard have the same designation and accessibility as those created in Report Designer. Thus, reports created by Report Wizard are referred to as Report Designer reports. This means that reports created by Report Wizard will be accessible only by CentreVu® Supervisor users.

How the Report Wizard Works

The Report Wizard is based on the completion of report creation tasks. (For a list of the tasks involved in creating a new report, see the “Creating a New Report” section in this chapter.) The report layout you choose will determine the number of tasks you will have to complete to create your report. Report Wizard presents these tasks by way of pages (screens). The title bar of each page contains the following information:

- Step (task) number you are currently working on
- Number of total steps (tasks) required to complete the report
- Action you are performing on that page. For example:
Each page of the Report Wizard contains command buttons to navigate through the wizard and command buttons that help you define your report. The following table for an explanation of these command buttons.

<table>
<thead>
<tr>
<th>Command</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>&lt;Back</td>
<td>Returns to the previous page. (This command button is disabled on the first page of the Report Wizard.) When you back up to previous pages Report Wizard will retain the values you entered unless you back up to a previous page and make changes that impact ensuing pages.</td>
</tr>
<tr>
<td>Next&gt;</td>
<td>Moves to the next page in the sequence, maintaining whatever settings you provided on the previous pages. (This command is replaced with the Finished button on the final page of the wizard.)</td>
</tr>
<tr>
<td>Finished</td>
<td>Applies your settings or the default settings from all pages and completes the task.</td>
</tr>
<tr>
<td>Cancel</td>
<td>Discards any selections you have made (only if you have not saved the report), terminates the process, and closes the Report Wizard. If you saved the report before selecting the Cancel button, Report Wizard closes; however, you will be able to run or edit the report in Report Designer.</td>
</tr>
<tr>
<td>Help</td>
<td>Provides information about the page.</td>
</tr>
<tr>
<td>Data Item Definition</td>
<td>Provides a definition for the selected database item or calculation.</td>
</tr>
<tr>
<td>🔁</td>
<td>Moves a database item or calculation up in the list of Selected Data Items.</td>
</tr>
<tr>
<td>🔽</td>
<td>Moves a database item or calculation down in the list of Selected Data Items.</td>
</tr>
<tr>
<td>🔸</td>
<td>Removes a database item or calculation from the Selected Data Items list.</td>
</tr>
<tr>
<td>▶</td>
<td>Adds a database item or calculation to the Selected Data Items list.</td>
</tr>
</tbody>
</table>
The following list provides the general functionality of the Report Wizard:

- **Report Wizard provides default choices in each task.** You may change any of the defaults to choices that best meet your needs. Each time you use the Report Wizard to create a new report, the original default choices will be shown.

- **Report Wizard can access all database items and standard calculations.** Although you can access all database items and standard calculations, you cannot create new calculations or link fields together with math functions by way of the Report Wizard. However, Report Designer allows you to create new calculations and link fields together with math functions for reports which you create in the Report Wizard.

- **Report Wizard can create a report with charts and tables.** With the Report Wizard you will be able to create a report that contains the following:
  - one or two charts,
  - one or two tables, or
  - one chart and one table.

  You will have to use the Report Designer to enter text or fields containing one data item.

- **Report Wizard does not display queries and database table names used to generate a report.** If you need to see this type of information, use Report Designer.

- **Report Wizard provides access to database item definitions.**

  While in the Select Data Items page of the Report Wizard, you will be able to click on a database item or calculation, and then select the Data Item Definition button to view the definition of the database item or calculation which you highlighted.
• **Report Wizard does not allow editing of a completed report.** Report Wizard is designed to create new reports only. However, you can edit a completed report in Report Designer.

• **Report Wizard does not allow reentry.** Report Wizard does not allow you to leave and then reenter to finish a partially completed report. A report created in Report Wizard must be completely defined before it can be saved. If you close Report Wizard before saving a report, the report is discarded. To make changes to a report created and saved in Report Wizard, use Report Designer.
Starting the Report Wizard

Report Wizard can be accessed only when Report Designer is activated on the CMS server and when you have the appropriate permissions to access Report Designer.

There are two methods available to start the Report Wizard. These methods are as follows:

- Toolbar button on the Controller
- Report Selector window.

### Toolbar Button

If you have purchased the Report Designer feature, a toolbar button will be automatically added to the CentreVu Supervisor Controller window's toolbar.

Selecting the Report Wizard toolbar button will initiate the Report Wizard feature.
Report Selector Window

To access the Report Wizard by way of the Report Selector window, do the following:

1. From the Commands menu (located on the CentreVu Supervisor Controller window), select the Reports... menu item. The Select a Report window appears as shown below:

   ![Select a Report Window](image)

   - **Category**
     - Agent
     - Other
     - Steam/Agent
     - Split/Skill
     - Trunk/Trunk Group
     - VDN
     - Vector
     - CMS custom
     - Designer
   - **Run Report for ACD**
     - acl_report
   - **Description**
     - Shows status of agents in an agent group, and reason for ALCX agents

   ![New Report Dialog Box](image)

2. Select the New button. The New Report dialog box, as shown below, will appear and ask you if you want to run the Report Wizard.

   ![New Report Dialog Box](image)


   If you select No, Report Designer will open.
Creating a New Report

When you start the Report Wizard, the Report Wizard page appears. The Report Wizard page provides a list of the tasks involved in creating a new report.

**CentreVu Supervisor Report Wizard**

This wizard helps you build a custom report. Reports present data in charts, tables, or a combination of both.

The Report Wizard will guide you through the following report creation steps:

1. Selecting the type of report you want to create.
2. Choosing a general report layout.
3. Selecting data for each table or chart.
4. Previewing table or chart report segments.
5. Customizing report input fields.
6. Running the report, continuing edits within the Report Designer, or access the report some other time.

Press the Next > button to start creating your report. You may choose Cancel at any time to exit the wizard.
To begin the creation of a new report, select the Next> button. This will advance you to the Select a Report Type page of the wizard. The Select a Report Type page is the first page of the wizard. Go to the next section, “Selecting a Report Type Page,” in this chapter.

Selecting a Report Type Page

Selecting a report type is the first task in creating a new report. The report type determines whether the data in the report is real-time, integrated, or historical. For example, if you select a real-time report, you will not be able to specify historical data in the report. The following list provides information about each type of report:

- **Real-Time**—Reports that refresh in real time.
  
  Real-time reports are reports that display current ACD call activity on agents, splits/skills, trunks, trunk groups, vectors, and vector directory numbers (VDNs) for the current interval (15, 30, or 60 minutes). Current intrahour interval real-time reports are periodically updated as data changes during the interval.

- **Integrated**—Reports that refresh in real-time and show information that is accumulated from any point in time in the past 24 hours of ACD, agent, split/skill, trunk, trunk group, vector, and VDN activities.
Historical—Reports that give information tabulated over a period of time. Historical reports display past ACD data for various agent, split/skill, trunk, trunk group, vector or VDN activities. You must select a historical report if you want to include the following data:

- Exceptions
- Call Work Code
- Agent Trace
- Call Record.

The default for report type is always Real-Time.

To select a report type other than the default, do the following from the Select a Report Type page:

1. Click on the radio button to the left of the report type you want to use.

Selecting a Report Layout Page

Selecting a report layout is the second task in creating a new report. The layout determines how your data will be represented in the report. Report layouts are in the form of charts, tables, or both. Charts provide a graphical representation of data, and tables provide data in columns and rows. Each chart or table in the layout is referred to as a section. A report layout can contain one or two sections. See the following table for a description of the different types of report layouts available to you in the Report Wizard.

<table>
<thead>
<tr>
<th>Charts</th>
<th>Tables</th>
<th>Combination</th>
</tr>
</thead>
<tbody>
<tr>
<td>Single chart (one section)</td>
<td>Single table (one section)</td>
<td>Table and chart side by side (two sections)</td>
</tr>
<tr>
<td>—Default—</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Two charts side by side</td>
<td>Two tables side by side</td>
<td>Chart and table side by side (two sections)</td>
</tr>
<tr>
<td>(two sections)</td>
<td>(two sections)</td>
<td></td>
</tr>
<tr>
<td>Two charts: one on top</td>
<td></td>
<td>Chart on top and table on bottom (two sections)</td>
</tr>
<tr>
<td>and one on bottom (two</td>
<td></td>
<td></td>
</tr>
<tr>
<td>sections)</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Each section of a report layout must be defined. Defining a section includes the following tasks:

- Selecting a data group (accomplished through the Select a Data Group page).
- Selecting data group items (accomplished through the Select Data Items page).
- Selecting a format for the chart or table in the section (accomplished through the Select the Chart Format page or on the Select the Table Format page).
- Previewing the section (accomplished through the Preview page) Optional.

To select a report layout, do the following:

1. Click on the image that represents the layout you want for your new report. Text describing the selected layout will appear on the lower portion of the page under the Selected Layout field.

   If you specified a report layout that contains one section (for example, a single table), go to Step 2 now.
If you specified a report layout that contains more than one section (for example, one table and one chart), the Selection Layout page of the wizard appears as shown on page 11. This page provides the following information:

- Section you are about to define—a section that appears to be pressed with an arrow pointing to it.

- Section you have not defined—a section that appears not to be pressed, without an arrow.

Report Wizard will guide you through each task for defining a section. When one section is defined, the Report Wizard will bring you back to the Current Selection page to help you define another section. Report Wizard will continue this cycle until you have defined all sections.
If you specified a report layout that contains one section, the Selection Layout page will not appear. Instead, the Select a Data Group page will appear as shown on page 12.

2. Select Next> to begin defining the report layout section(s). The Select a Data Group page appears as shown below. Go to the next section, “Defining a Report Layout Section(s),” in this chapter.

To redefine a previous section, select the <Back button.

For example, if you have already defined a section of your report and select the <Back button, the wizard takes you to the Preview page for the last section defined. From here, you can continue to select <Back to go back through the various tasks involved in defining a section.
Defining a Report Layout Section(s)

Defining a report layout section(s) consists of the following tasks:

- Selecting a data group
- Selecting data items
- Selecting the chart or table format
- Previewing the work already done on the report (optional).

Selecting a Data Group Page

The Select a Data Group page provides only those data groups specific to the type of report (real-time, integrated, or historical) you chose earlier and the current section (table or chart) being defined.
The data groups available are placed in a tree view structure. There can be up to three levels of data, the last level containing the individual data groups. From this tree view structure, you will select an individual data group for the section you are defining. A description of the different levels is as follows:

- **First Level**—the highest classification level of data. For example, the highest classification levels of data for a real-time table are Agent, Split/Skills (multiple), Trunk Group, VDN (single), VDNs (multiple), and Vectors.

- **Second Level**—a breakdown of the first classification levels of data. For example, the second levels of data for the Split/Skills (multiple) category are Multi-ACD, Top Agent Skills Information, Expected Wait Time at each priority, Number of Agents in AUX Work States, Performance, Type of Agents Staffed, and No Pre-selection. Individual data groups are contained under this level of data also.

- **Third Level**—a breakdown of the second classification levels of data. For example, the third level of data for the Split/Skills (multiple) Top Agent Skills Information category is Top Agents Staffed and No Pre-selection. If there are three levels of data, the individual data groups will be listed under the third level.
Categories of data and sub-categories of data can be expanded (represented with a “+” sign) and collapsed (represented with a “-” sign). By default, when the Select a Data Group page of the wizard appears, one category will be expanded with one data group selected. The default is based on the information (report type and report layout) which you provided to the wizard previously.

To choose a data group, do the following:

1. Expand the categories of data until you reach the individual data groups. (Individual data groups cannot be expanded, they are the lowest category of data.) At this point you have not yet selected the actual individual data group, you have just narrowed your selection of a specific category of data. The Next> button will be disabled until you select a data group—go to Step 2.

2. Under the first, second, or third level of data, click on the data group you want to use for the section you are defining. The data group is highlighted and the Next> button is enabled.

You are not required to preselect data for your report. Each category of data will include a category called No Pre-selection. If you choose the No Pre-selection option, no data items and calculations will be listed in the Selected Data Items list view on the Select Data Items page of the wizard. You will need to manually select the data items you want to use. See the “Selecting Data Items Page” section in this chapter for more information about the list views.

3. Select the Next> button to select the data items available for the data group you chose in Step 2. The Select Data Items page appears. Go to the next section, “Selecting Data Items Page,” in this chapter.
The Select Data Items page is where you finalize the actual data (data items and calculations) that will be displayed in your report. Data items are specific types of data stored in one of the CMS databases.

The data group you chose earlier is used to populate the following list views in the Select Data Items page:

- **Available Data Items list view**—contains all the data items associated with the data group. This list allows you to add data items to the Selected Data Items list view.

- **Selected Data Items list view**—contains predefined database items and calculations from the Available Data Items list that will be used in your report.

If you remove a calculation from the Available Data Items list, you will have to back up to the Select a Data Group page and reselect the data group to have the calculation appear in the list again.

If you chose the No Pre-selection data group, then the Selected Data Items list view will not be populated with preselected data; however, the Available Data Items list view will contain all the data items available for your report. To select the data items for your report, you need to manually add them (from the Available Data Items list view) to the Selected Data Items list view. At least one database item or calculation must be in the Selected Data Items list view before the wizard will let you proceed.
Both list views contain the following three elements:

- **Icon**—if the data type is alphanumeric or has a graphical representation. Synonyms that are defined for data items are in parenthesis.
- **Item Heading**—default heading for the database item or calculation. The item heading is the heading used in standard CMS reports.
- **Data Item**—database item or calculation (internal name).

From the Select Data Items page, you can do the following:

- Filter data group items that appears in the Available Data Items list view.
- Sort data group items in the Item Heading or Database Items columns of the list views.
- Add data group items to the Selected Data Items list view.
- Access definitions for data group items.
- Remove data group items from the Selected Data Items list view.
- Reposition (move up or down) data group items in the Selected Data Items list view.
- Edit item headings to create custom report headings.

**Filtering Data Group Items**

You can display data group items specific to the characters entered in the Display Data Group items that contain: text box. Any string you enter into this field will be compared against both columns of the Available Data Items list view.
To filter data group items, do the following:

- In the Display Data Group items that contain text box, enter the characters of the data items that you want Report Wizard to display. For example, if you want to list only those data group items that contain the text “logonsk,” then you would need to enter “logonsk.”
- To redisplay all data group items available to the data group, delete all text in the Display Data Group items that contain text box.

Report Wizard disables the Next> button whenever the “Display Data Group items that contain” text box has focus.

### Sorting Data Group Items
You can sort the data group items by clicking on the Item Heading column or the Data Item column in the Available Data Items list view. All data group items will be sorted alphabetically.

### Adding Data Group Items to the Selected Data Items List View
You may want to add more data group items to your report than what is already preselected in the Selected Data Items list view. You can add any data group item(s) listed in the Available Data Items list view to the Selected Data Items list view by doing one of the following:

- Dragging and dropping the selected data group item(s) onto the Selected Data Items list view. With this method, you can drop a data group item(s) anywhere on the list.
- Clicking on the data group item(s), and then selecting the Add button. Report Wizard enables the Add button only when a data group item(s) is selected in the Available Data Items list view. With this method, a data group item(s) is added to the bottom of the list.
- Double-clicking on the selected data group item(s) from the Available Data Items list view. With this method, a data group item(s) is added to the bottom of the list.
- Clicking on the data group item(s) in the Available Data Items list view, and then pressing the ALT+right arrow key on your keyboard. With this method, a data item(s) is added to the bottom of the list.
## Accessing Definitions for a Data Group Item

Report Wizard provides definitions for all the data group items listed in both list views. To see a definition for a specific data group item, do the following:

1. Click on the data group item for which you want a definition.
2. Select the Data Item Definition button located under the Available Data Items list view.

Report Wizard enables the Data Item Definition button only when you select a single data item or calculation.

## Removing Data Group Items from the Selected Data Items List View

You may want to remove a data group item(s) that Report Wizard preselected for your report. You can remove any data group item(s) listed in the Selected Data Items list view by doing one of the following:

- Dragging and dropping the selected data group item(s) onto the Available Data Items list view.
- Clicking on the data group item(s), and then selecting the remove button. Report Wizard enables the remove button only when a data group item(s) is selected in the Selected Data Items list view.
- Double-clicking on the selected data group item(s) in the Selected Data Items list view.
- Clicking on the data group item(s) in the Selected Data Items view list, and then pressing the ALT+left arrow key on your keyboard.

When you remove a data group item(s), ensuing data group items are shifted up accordingly.

If you remove all the data group items in the Selected Data Items view list, Report Wizard disables the Next> button, and you cannot move to the next page of the wizard. You must have one or more data group items listed in the Select Data Items list view.
Repositioning (Moving Up or Down) Data Group Items in the Selected Data Items List View

Report Wizard allows you to reorganize the list of data group items in the Selected Data Items list view by moving them up or down. With this feature, you can dictate the order the database group items will appear in the report. You can reorganize data group items through the following methods:

- Clicking on the data group item(s), and then selecting the up button to move data group item(s) up or by selecting the down button to move the data group item(s) down. Report Wizard enables the up and down button only when a data group item(s) is selected in the Selected Data Items list view.

- Clicking on the data group item(s) in the Selected Data Items view list, and then pressing the ALT+up arrow key to move data group item(s) up or pressing the ALT+down arrow key to move the data group item(s).

Editing Item Headings to Create Custom Report Headings

Report Wizard allows you to change the Item Heading of any data item in the Selected Data Items list view. You may want to change data item heading to a more meaningful name to use as your custom report heading. You can change the data item heading by clicking on the specific data item heading, and then selecting the Edit Item Heading button located below the Selected Data Items list view.

When you have finished selecting and manipulating database items for a specific section, the next task for that section is to define its appearance. Selecting the Next> button from the Select Data Items page will advance you to the correct page to format either the table or chart you are defining. If the section contains a table, go to the next section, “Selecting the Table Format,” in this chapter. If the section contains a chart, go to the “Selecting the Chart Format” section in this chapter.
Selecting the Table Format

From the Select Table Format page in the wizard, you define the characteristics of your table layout. The default is a table in row order with grid lines.

The following types of table layouts are available to you:

- Row oriented table with grid lines
- Row oriented table without grid lines
- Column oriented table with grid lines
- Column oriented table without grid lines.
Example of a row-oriented report

![Example of a row-oriented report]

Example of a Column Oriented Report

![Example of a Column Oriented Report]
To choose a format for your table, do the following:

1. Select the Fill Table by Row radio button if you want your report to have a row format, or select the Fill Table by Column radio button if you want your report to have a column format.

2. Select the Display Grid Lines check box if you want grid lines to separate the data on your report.

3. Select Next> to advance to the next page of the wizard. The Preview page appears. Go to the next section, “Previewing the Report,” on page 25 in this chapter.

**Selecting the Chart Format**

From the Select Chart Format page in the wizard, you define the format of your chart. The default is a vertical 2D bar chart that displays the data by value.
The following chart formats are available to you:

<table>
<thead>
<tr>
<th>2D Vertical Bar Chart</th>
<th>3D Horizontal Bar Chart</th>
<th>2D Stacked Area Bar Chart</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image1" alt="2D Vertical Bar Chart" /></td>
<td><img src="image2" alt="3D Horizontal Bar Chart" /></td>
<td><img src="image3" alt="2D Stacked Area Bar Chart" /></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>2D Horizontal Bar Chart</th>
<th>3D Vertical Stacked Bar Chart</th>
<th>2D Pie Bar Chart</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image4" alt="2D Horizontal Bar Chart" /></td>
<td><img src="image5" alt="3D Vertical Stacked Bar Chart" /></td>
<td><img src="image6" alt="2D Pie Bar Chart" /></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>2D Vertical Stacked Bar Chart</th>
<th>3D Horizontal Stacked Bar Chart</th>
<th>3D Vertical Bar Chart</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image7" alt="2D Vertical Stacked Bar Chart" /></td>
<td><img src="image8" alt="3D Horizontal Stacked Bar Chart" /></td>
<td><img src="image9" alt="3D Vertical Bar Chart" /></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>2D Horizontal Stacked Bar Chart</th>
<th>3D Line Chart</th>
<th>3D Pie Chart</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image10" alt="2D Horizontal Stacked Bar Chart" /></td>
<td><img src="image11" alt="3D Line Chart" /></td>
<td><img src="image12" alt="3D Pie Chart" /></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>2D Line Bar Chart</th>
<th>3D Stacked Area Chart</th>
<th>3D Vertical Cluster Bar Chart</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image13" alt="2D Line Bar Chart" /></td>
<td><img src="image14" alt="3D Stacked Area Chart" /></td>
<td><img src="image15" alt="3D Vertical Cluster Bar Chart" /></td>
</tr>
</tbody>
</table>

To format your chart, do the following:

1. Select the Show Value radio button if you want to display your data as a numeric value, or click on the Show Percentage radio button if you want to display your data as a percentage.

2. Select the Display Legend check box if you want to display a legend on your report. The legend is a description of the data items contained in the chart and is displayed in the right corner of the chart.
3. Select the Display Data Labels check box if you want to show the data labels on your report. Report Wizard will display the data labels as either values or percentages (depending on what you have chosen in Step 1) and will be displayed above point.

4. Select the Use First data item as chart title check box if you want to use the first data item as your title.

5. Click on the graphic that best represents the chart format you want to use for your report.

6. Select the Next> button to advance to the next page of the wizard. The Preview page appears. Go to the next section, “Previewing the Report,” in this chapter.

**Previewing the Report**

The Preview page of the wizard allows you to preview what you have defined for your report, exit the preview, and then either use the <Back button to modify the report section or use the Next> button to advance to the next page of the wizard. A previewed version of a report contains real data for each completed section; however, if the report is designated as real-time then there will be no refresh of data. The only option while in a previewed version of a report is to exit the preview.

**Two-Section Report**

When you preview the first section of the report, you will be prompted to provide input values for that section. When you preview the second section of the report, you will again be asked to provide input values; however, you are now asked to provide input values for both sections.
<table>
<thead>
<tr>
<th><strong>Previewing the Report</strong></th>
<th>To preview your report, click on the Preview button. Report Wizard will display everything you have defined for your report up to this point.</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Exiting the Preview of the Report</strong></td>
<td>To exit the previewed version of your report section, click the Exit button or the Close button in the title bar. When you exit the previewed version of your report section, Report Wizard returns you to the Preview page.</td>
</tr>
<tr>
<td><strong>Backing Up to Previous Page</strong></td>
<td>While still in the Preview page of the wizard you can modify your report section by selecting the &lt;Back button. Continuing to select the &lt;Back button brings you through the various tasks involved in defining a section.</td>
</tr>
<tr>
<td><strong>Moving Forward to Next Page</strong></td>
<td>If you do not want to modify your report section, select the Next&gt; button to advance. If you still have undefined report sections, Report Wizard will display the Selection Layout page. From the Selection Layout page you will begin to define your next report section. Select the Next&gt; button to advance to the next page of the report wizard (go to the “Defining a Report Layout Section[s]” on page 13 in this chapter for information on defining report layouts). If you have defined all report sections then Report Wizard will display the Change Input Captions page. Go to the next section, “Changing Input Captions,” in this chapter.</td>
</tr>
<tr>
<td><strong>Changing Input Captions</strong></td>
<td>When you are finished defining all report sections, the Change Input Captions page appears. This page of the wizard allows you to change the input captions that will appear in the Report Input window for your new report. The number of entries displayed in the Change Input Captions page will depend on the data group you assigned to each section of your report. From this page, you can change only the input captions and not the inputs that will appear in your report. To change the input caption(s), do the following: 1. Highlight the input caption you want to change. 2. Type the new input caption. 3. Repeat Steps 1 and 2 for each input caption you want to change.</td>
</tr>
</tbody>
</table>
4. Select the Next> button to advance to the next page. The Save Report page appears. Go to the next section, “Saving the Report,” in this chapter.

Saving the Report

From this page, you determine whether you want to save your newly defined report and whether your report will be available to everyone or just yourself. Your report will be saved when you enter a report name and select the Next> button. The report type and data group selections you made for your report will determine the category your report will be saved under (for example, Real-Time). You are not required to save your report at this time. If you do not save your report in the Save Report page, Report Wizard will still allow you to advance to the next page (the Finish page).
To save your report, do the following:

1. Enter the name of your report in the Report Name text box. When entering a name to save your new designer category report (global or private), you will be presented with one of the following three scenarios:

   - There is no existing designer category report with the name you have selected for your new report. In this case, Report Wizard will save the report with the name you have selected.

   - There is an existing designer category report with the same name that you have selected for your new report; however, you are the owner of this report. In this case, you will get a message warning you that you are about to overwrite an existing report. You can either overwrite the existing report or select a different name for your new report.

   - There is an existing designer category report with the same name that you have selected for your new report; however, you are not the owner of this report. In this case, you will get a message stating that you cannot overwrite the existing report. You will have to select a different name for your new report.

   If you do not enter a report name your report will not be saved when you advance to the Finish page of the wizard. Neglecting to save your report in either the Save Report page or the Finish page will discard your report.

2. If you want your report to be available to everyone, click on the Everyone radio button. If you want your report to be available only to you, click on the Only Me radio button. The following provides information about each choice:

   - **Everyone** radio button (default)—provides global access to the report. By selecting the Everyone radio button, you give other users the following capabilities:
     - Other users can run the report
     - Other users can copy the report design when designing their own custom report in Report Designer.

     The CMS user permission structure is still applicable.

   - **Only Me** radio button—only you and the CentreVu CMS administrator(s) can run the report. In addition, no other users, except for CentreVu CMS administrator(s), can copy or run the report design for use in their own custom reports.
3. Select the Next> button to advance to the next page. The Finish page appears. Go to the next section, “Finishing the Report,” in this chapter.

**Finishing the Report**

When all the required tasks are completed to create a report, you will have to determine whether you want to run the report, edit the report through Report Designer, or exit without doing anything (enabled for saved report only).

**Running the Report**

When you run your report from the Finish page of the Report Wizard, it will be run with the appropriate inputs, will access the CMS database, and will produce real data. You will be running a live report.

If you run an unsaved report you will be prompted to save the report upon its completion. The report will be saved as a Report Designer report and placed in the appropriate folder (real-time, historical, or integrated). If you elect not to save your report, you can press the Exit button, and the report will close, or you can select the Return button to return to the running report.
To run your report, do the following:

1. From the Run Report for ACD combo box, select the ACD.
2. Click on the Run Report radio button, and then select the Finish button.

**Editing Your Report**

When you choose to edit your report from the Finish page of the Report Wizard, the Report Designer starts. All edits to your report are now done through the Report Designer. You can also edit your report using the Report Wizard by selecting the <Back buttons on the various pages of the wizard.

To edit your report, do the following:

1. From the Run Report for ACD combo box, select the ACD.
2. Click on the Edit Report in Report Designer radio button, and then select the Finish button.

**Exiting Report Wizard**

To exit Report Wizard without running your report or editing your report, click on the Run or Edit report at a later time radio button (this option will be disabled if you have not entered a report name for your report), and then select the Finish button. You can also select the Cancel button.

Selecting the Cancel button when your report has not been saved will discard your report. Report Wizard will warn you if you try to cancel without first saving your report.
3 Using the Report Manager

Introduction

This chapter teaches you how to use the report manager feature of the Supervisor application. The sections of the chapter are as follows:

- About Report Manager
- Viewing Report Properties
- Copying a Report to the Designer Category
- Copying a Designer Report to a File
- Copying a Designer Report from a File
- Deleting a Report from the Custom or Designer Category
- Starting the Report Designer using the New or the Edit Button.
About the Report Manager

The report manager is the feature of the Supervisor application that allows you to view report properties, copy reports, and access the Report Designer to edit reports or create new reports.

The report manager is incorporated into the Reports Selector window, as shown below:

You can use the **Properties**, **Copy**, and **Edit** buttons on the Report Selector window to manage the standard CMS and Supervisor reports, and to Copy reports to the Designer category for editing. You can use the **New** button to create a new Designer report from scratch. You can use the **Delete** button to delete reports from the Designer category (standard CMS, CMS Custom, and standard Supervisor reports cannot be deleted).

**NOTE:**

For information on using the **Add Bookmark** button, see the *CentreVu® CMS R3V8 Administration* (585-210-910) document.
Viewing or Changing a Report’s Properties

The Report Manager gives you the ability to view report properties, such as the report name, description, owner, type, folder, category, and scope (Everyone or Only Me), and the folder the report is stored in.

To view a report’s properties, complete the following steps:

1. Open the Report Selector window.
2. Select the report for which you want to view properties.
3. Click the Properties button.

The Properties window for the report appears as shown below:

![Properties Window]

From the Properties window, you can change the name, description, owner, and scope of a report.

4. To change the Name, Description, or Owner of a report, place the cursor in the appropriate field and make your edits. To change the scope, or who the Report is Available to, of a report, select either the Everyone or Only Me radio button. When you are done making your changes, select the OK button to save the changes.

If you attempt to give a report the same name as an existing designer report, the Report Already Exists window displays. This window allows you to overwrite the existing report or to give the report you are saving a different name.
Copying a Report to the Designer Category

Using the Report Manager, you can copy a report from any category (Agent, Other, Queue/Agent, Split/Skill, Trunk/Trunk Group, VDN, Vector, Custom, or Designer) and folder (Real-Time, Historical, or Integrated) into the Designer category of any folder.

Reports that are created or edited using the Report Designer can only be accessed from the Supervisor interface to the CMS server. Therefore, if you edit a CMS Custom Report using the Report Designer, the changes to that report will not be available when the report is run from the Terminal Emulator or another terminal interface to the CMS.

To copy a report, complete the following steps:

1. Open the Report Selector window.
2. Select the report that you want to copy.
3. Click the Copy button.
   
   The Copy Report window appears. This window allows you to select where you are copying the report to (the Designer category, a PC file, or from a PC file to the CMS server).

4. Select the To Designer Category radio button.
5. Select the OK button.

   The Copy Report To Designer Window displays, which is where you will define the name, description, folder, and scope of the report.

   ![Copy Report To Designer Window](image)

   - **Name:** Copy of Graphical Status
   - **Description:** Shows agent status, time in state, and split/skill statistics
   - **Folder:** Real-Time
   - **Category:** Designer
   - **Report Available To:** Everyone

   Select the OK button.
To define the properties information for a copied report, complete the following steps:

6. Enter a name for your report in the **Name** field. The name can have up to 40 characters, including blanks. Because the name you give your report should be unique, you may want to look at existing report names before entering a name for your report.

7. Move the cursor to the **Description** field and enter a description of the report. The description can have up to 100 characters, including blanks. It is not required that you enter a report description.

   **Do not use** the \ (backslash), ; (semicolon), ' (grave accent), ~ (tilde), “ (double quote), | (pipe), * (asterisk), or ? (question mark) characters in your description of the report.

8. Move the cursor to the **Folder** field. Use the pull-down list to select Real-Time, Historical, or Integrated. The report will be stored in the Designer category of the folder you select here.

   When you edit the report you will access the database for the folder you select here. If you select Real-Time, you will not be able to access the Historical database tables to define queries for the report. If you select Historical, you will not be able to access the Real-Time database tables to define queries for the report. However, if you select Integrated, you will be able to access both the Real-Time and Historical databases to define queries for the report.

   You **must** select the Historical or Integrated folder if you want to include the following:

   - Exceptions data
   - Agent trace data
   - Call record data.

9. Select the **Everyone** radio button to make the report accessible to all CMS users who have the appropriate permissions, or select the **Only Me** radio button to make the report accessible only to yourself.

   It is a good idea **initially** to make your reports available only to yourself until they have been debugged and run successfully. This prevents the possibility of other users running reports that you have saved but not yet tested.

   Assigning “Everyone” access to the report allows other users to run the report and to copy the report to create new designer reports.

   Assigning “Only Me” access to the report means that only you (and the CMS administrator(s)) can run the report. In addition, no other users, except for CMS administrators, can copy the report design for use in their own designer reports.
No other CMS user other than a user with CMS administration permissions can modify a report design you create, regardless of whether the report is accessible by all or only by you. A user with CMS administration permissions always has the ability to modify your report design, even if you make it available only to yourself.

10. Select **OK** to save the report properties.

After you have copied the report to the Designer category, you can use the **Edit** button to access the Report Designer and edit the report.
Copying a Designer Report to a File

You can use the Report Manager Copy button to copy any designer report that you create to a file, either on diskette, on your hard drive, or on a network drive. You can use this feature to easily transport designer reports from one PC to another.

If a report was created by Lucent Technologies Professional Services, only a user with CMS services permissions can copy the report.

To copy a report, complete the following steps:

1. Open the Report Selector window.
2. Select the Designer Category.
3. Select the designer report that you want to copy.
4. Click the Copy button.

The Copy Report window displays with the To a PC File option enabled. This window allows you to select where you are copying the report to (the Designer category, a PC file, or from a PC file to the CMS server).

5. Select the To a PC File radio button.
6. Select the OK button.

The Save Report to PC File window appears as shown below:

This window is a standard Windows browse window.
7. Select the File name and Folder to which you want to save the report.

You can copy the report to any drive to which you have access, including the floppy (usually a:\) drive on your PC.

You can save the report to a network drive by selecting the Network button, which allows you to access the network drives that you have permissions for.

8. Select the OK button.

9. The file is saved and, upon successful completion of the save, a confirmation window displays.

*Windows is a registered trademark of Microsoft Corp.*
Copying a Designer Report from a File

You can use the Report Manager Copy button to copy any designer report that has been saved to a file (either on diskette or on a network drive) onto the CMS server.

To copy a report from a file to the server, complete the following steps:

1. Open the Report Selector window.
2. Click the Copy button.

   The Copy Report window displays. This window allows you to select where you are copying the report to (the Designer category, a PC file, or from a PC file to the CMS server).

3. Select the From a PC File to the CMS Server radio button.
4. Select the OK button.

   The Load Report From PC File window appears as shown below:

   ![Load Report From PC File Window]

   This window is a standard Windows browse window.

5. Select the file that you want to copy to the CMS server.
6. Select the OK button.
7. The file is copied to the CMS server and, upon successful completion of the copy, a confirmation window displays.
If a report with the same name already exists on the CMS server, the following window appears as shown below:

![Report Already Exists](image)

Select the **Overwrite the existing report** radio button to replace the report that currently resides on the CMS server. Select the **Save the report being copied as** radio button and enter a new name for the report if you want to retain the version of the report that currently resides on the CMS server.
Deleting a Report from the Designer Category

The Report Manager allows you to delete any report that resides in the Designer category except purchased reports from Professional Services. You cannot delete any of the standard CMS, CMS Custom, or standard Supervisor reports (reports that reside in the Agent, Other, Queue/Agent, Split/Skill, Trunk/Trunk Group, VDN, Vector, and Custom categories).

To delete a Designer report, complete the following steps:

1. Open the Report Selector window.
2. Select the Designer category under any tab.
3. Highlight the name of the report that you want to delete.
4. Click the **Delete** button.
5. A message confirming the delete displays. Select **OK** to delete the report or **Cancel** if you do not want to delete the report.
You can use the Report Manager to open the Report Designer by selecting a report from the Designer category and then clicking the **Edit** button, or by clicking the **New** button to create a new report.

You can also access the Report Designer from a report output window. To do so, select Design from the Report menu on the report.

In addition to the above methods, you can open the Report Designer from the last page of Report Wizard.
4 Report Designer Basics

Introduction

This chapter outlines the features of the Report Designer and teaches you general use of the Report Designer.

The following sections are included in this chapter:

- Starting the Report Designer
- Exiting the Report Designer
- Report Designer Menus
- Online Access to Database Definitions
- Steps Required to Create a New Report
- Steps Required to Edit an Existing Report.
Starting the Report Designer

To access the Report Designer and to run Designer reports, you must have read and write permissions assigned for Custom Reports. These permissions are set using the User Permissions tool. See the CentreVu® Call Management System Release 3 Version 8 Administration (585-210-910) document for instructions on setting up user permissions.

You can start the Report Designer using one of four methods:

- Select a report from the Designer category in any folder and clicking the Edit button on the Reports Selector window
- Click the New button on the Reports Selector window to create a new report
- Run a report and then selecting Design from the Report menu on the report
- Enter Report Designer from the Final page of the Report Wizard.

Any one of these methods of starting the Report Designer will take you to the Design Mode window (the window will be blank if you are creating a new report or will have report information if you are editing an existing report), as shown below:
Exiting the Report Designer

You can close the Report Designer using any of the standard *Windows* methods:

- Select **Exit** from the **Report** menu.
- Double-click the System button.
- Select the Close button at the top of the window.

If you try to exit the Report Designer without first saving the report you have been working on, a warning gives you the opportunity to save the report before closing the Report Designer.
Report Designer Menus

This section details the Report Designer Design Mode window. The following picture illustrates the Report Designer Design Mode window:

Menu Bar

The menu bar lists the available drop-down menus. The following menus are available from the Report Designer Design Mode window:

- Report
- Edit
- Format
- Options
- Insert
- Help.

The following paragraphs outline the options available from each menu.

Report

From this menu, you can test the report you are working on, save the report, and exit the Design Mode window. The Report menu has the following options:

<table>
<thead>
<tr>
<th>Menu Item</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Run</strong></td>
<td>Selecting <strong>Run</strong> takes you out of design mode and runs the report you are working on. You will use <strong>Run</strong> to test the changes/additions you have made to a report.</td>
</tr>
<tr>
<td><strong>Save</strong></td>
<td>Selecting <strong>Save</strong> saves the report on which you have been working.</td>
</tr>
</tbody>
</table>
You will use the **Edit** menu (shown below) to add information to and delete information from the report output window, and to create the report input window and the queries that are used to retrieve data for the output.

The **Edit** menu has the following options:

<table>
<thead>
<tr>
<th>Menu Item</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Save As</strong></td>
<td>Selecting <strong>Save As</strong> allows you to save the report on which you have been working with a new name or with the current name.</td>
</tr>
<tr>
<td><strong>Exit</strong></td>
<td>Selecting <strong>Exit</strong> closes the Report Designer without saving the changes and additions you have made to the report. You are prompted to save changes if you made any modifications to the report.</td>
</tr>
</tbody>
</table>

**Edit**

You will use the **Edit** menu (shown below) to add information to and delete information from the report output window, and to create the report input window and the queries that are used to retrieve data for the output.

The **Edit** menu has the following options:

<table>
<thead>
<tr>
<th>Menu Item</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Undo</strong></td>
<td>If you accidentally cut or delete an item from the report that you are designing, you can select <strong>Undo Cut/Delete</strong> to place the item back on the report.</td>
</tr>
<tr>
<td><strong>Cut/Delete</strong></td>
<td>If you are not satisfied with the alignment you made, then you can select <strong>Undo Align Controls</strong> to place the fields back to their original position.</td>
</tr>
<tr>
<td><strong>Undo</strong></td>
<td></td>
</tr>
<tr>
<td><strong>Align Controls</strong></td>
<td></td>
</tr>
<tr>
<td><strong>Cut</strong></td>
<td>Selecting <strong>Cut</strong> removes the item that you have selected from the report and places it on the Windows’ clipboard.</td>
</tr>
<tr>
<td>Menu Item</td>
<td>Action</td>
</tr>
<tr>
<td>------------</td>
<td>--------</td>
</tr>
<tr>
<td><strong>Copy</strong></td>
<td>Selecting <strong>Copy</strong> copies the item(s) that you have selected on the report and places it on the Windows clipboard. You can copy only entire grids and entire charts. It is not possible to copy only a portion of a grid or chart. If you would like to rearrange the order of the columns on a grid, use the Format Grid window. You can copy from one report to another report. To do so, complete these steps:</td>
</tr>
<tr>
<td></td>
<td>1. Open the report from which you want to copy.</td>
</tr>
<tr>
<td></td>
<td>2. Select the items that you want to copy.</td>
</tr>
<tr>
<td></td>
<td>3. Select <strong>Copy</strong> from the <strong>Edit</strong> menu.</td>
</tr>
<tr>
<td></td>
<td>4. Open the report to which you want to copy.</td>
</tr>
<tr>
<td></td>
<td>5. Select <strong>Paste</strong> from the <strong>Edit</strong> menu.</td>
</tr>
<tr>
<td><strong>Paste</strong></td>
<td>Selecting <strong>Paste</strong> places the item(s) currently on the Windows clipboard to the report that is currently selected in Design Mode.</td>
</tr>
<tr>
<td><strong>Delete</strong></td>
<td>Selecting <strong>Delete</strong> removes the currently selected item(s) from the report.</td>
</tr>
<tr>
<td><strong>Align Controls</strong></td>
<td>Selecting <strong>Align Controls</strong> aligns multiple fields and aligns them according to the controls in the Align Controls dialog box. This option is enabled only when multiple fields are selected.</td>
</tr>
<tr>
<td><strong>Inputs</strong></td>
<td>Selecting <strong>Inputs</strong> starts the Select Inputs assistant, which is where you choose the items that will be included on the report input window for this report. For instructions on how to use the Select Inputs assistant, see Chapter 6, “**Edit</td>
</tr>
<tr>
<td><strong>Queries</strong></td>
<td>Selecting <strong>Queries</strong> starts the Create a Query assistant, which is where you define the SQL queries that will be used to retrieve the data to be displayed on the report. For instructions on how to use the Create a Query assistant, see Chapter 7, “**Edit</td>
</tr>
</tbody>
</table>

*Windows is a registered trademark of Microsoft Corp.*
**Format**

From this menu, you can edit the charts, grids, and fields that appear on the report. The **Format** menu has the following options:

<table>
<thead>
<tr>
<th>Menu Item</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Chart</strong></td>
<td>Selecting <strong>Chart</strong> opens the Chart Format Options window. The Chart Format Options window gives you access to the General, Axis, Data, Data Labels, Fonts, Legend, Series Labels, Title, Type, and 3D Effects tabs for formatting charts on reports. For more information on using the Chart Format Options window, see Chapter 12, “Format</td>
</tr>
<tr>
<td><strong>Field</strong></td>
<td>Selecting <strong>Field</strong> opens the Field Format Options window. The Field Format Options window is where you will choose the formats for fields defined in queries. For more information on using the Field Format Options window, see Chapter 14, “Format</td>
</tr>
<tr>
<td><strong>Table</strong></td>
<td>Selecting <strong>Table</strong> opens the Table Format Options window. The Table Format Options window gives you access to the General, Data, Fonts, Format, Headers, Sort, and Summary tabs for formatting tables on reports. For more information on the Table Format Options window, see Chapter 13, “Format</td>
</tr>
<tr>
<td><strong>Sort by</strong></td>
<td>Selecting <strong>Sort by</strong> opens the Table Format Options window with the Sort tab active. The Table Format Options window gives you access to the General and Sort by tabs for formatting tables on reports. For more information on the Table Format Options window, see Chapter 13, “Format</td>
</tr>
<tr>
<td><strong>Text</strong></td>
<td>Selecting <strong>Text</strong> when a text item on the report is selected opens the Text Format Options window. The Text Format Options window allows you to change the font display characteristics for the selected text. For more information on the Text Format Options window, see Chapter 15, “Format</td>
</tr>
</tbody>
</table>
Options

From this menu, you can define whether a status bar will appear on the report and set the alignment of text fields to grids. The **Options** menu has the following options:

<table>
<thead>
<tr>
<th>Menu Item</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Status Bar</td>
<td>Selecting <strong>Status Bar</strong> includes a status bar on the bottom of the report you are designing. <strong>Status Bar</strong> is selected when there is a check mark next to the menu item.</td>
</tr>
<tr>
<td>Align To Grid</td>
<td>Selecting <strong>Align To Grid</strong> aligns the currently selected items on the report to the Design Mode grid when they are moved. The Design Mode grid is the grid that is shown on the window, behind any charts, grids, or text, when you are in Design Mode. <strong>Align To Grid</strong> is selected when there is a check mark next to the menu item.</td>
</tr>
</tbody>
</table>

Insert

From this menu, you can add charts, grids, fields, and text to the report. The **Insert** menu has the following options:

<table>
<thead>
<tr>
<th>Menu Item</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Chart</td>
<td>Selecting <strong>Chart</strong> opens the Chart Assistant, which is where you define the contents of a chart (graphical presentation of the report information). This menu item is grayed-out if no queries have been defined. For more information on using the Chart Assistant, see Chapter 8, “Insert</td>
</tr>
<tr>
<td>Field</td>
<td>Selecting <strong>Field</strong> opens the Field Assistant, which is where you define the contents of a field to be placed on the report. For more information on using the Field Assistant, see Chapter 9, “Insert</td>
</tr>
</tbody>
</table>
You can access Supervisor on-line help for the Report Designer from all of the windows in the Report Designer. There are three ways of accessing the help:

- **Pressing the F1 key** — displays help specific to the current window.
- **Selecting the Help button** (if available) — displays help specific to the current window.
- **Selecting Help from the menu bar** (shown below) — allows you to choose from the following options:

<table>
<thead>
<tr>
<th>Menu Item</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Contents</strong></td>
<td>Selecting <strong>Contents</strong> opens the Help Topics: dialog for Report Designer.</td>
</tr>
<tr>
<td><strong>Technical Support</strong></td>
<td>Selecting <strong>Technical Support</strong> opens a window that provides Technical Support information.</td>
</tr>
<tr>
<td><strong>About CentreVu Supervisor</strong></td>
<td>Selecting <strong>About CentreVu Supervisor</strong> opens the Supervisor Help About window, which shows the software version number.</td>
</tr>
</tbody>
</table>
Other Attributes of the Design Mode Window

In addition to the available menus, the Design Mode window also makes use of the following standard Windows conventions:

- **System Menu Box** — the system menu box allows you to perform common windows conventions, such as closing the current window or application.
- **Title Bar** — the title bar shows the name of the application.
- **Maximize, Minimize, and Close Buttons** — these buttons adjust the size of the window, or close the window.

Online Access to Database Definitions

Report Designer provides access to online database item definitions when you are adding database items and calculations to a query. With this feature you do not have to refer to hard-copy documentation to learn about database items and calculations. To access a database item definition or calculation, do the following:

Online access to database items and calculations is located in the Query Assistant: “Add the database items and calculations for the SELECT portion of the query” window.

![Query Assistant Window](image)

1. Click on the data group item or calculation for which you want a definition.

2. Select the Data Item definition button located under the Database Items and Calculations list boxes.
Steps Required to Create a New Report

The following table lists 10 tasks you need to complete to create a custom report. If you consistently do all of these tasks for each report you create, then your reports will run properly and you will be able to create them efficiently.

Things you should know before creating a new report:

- If you are customizing the Historical Call Record Report with CentreVu Report Designer, the Disposition report field will display the numerical values for DISPOSITION, and not the state names. See the CentreVu® CMS R3V8 Database Items and Calculations document (585-210-939) for more information.

- With the addition of the split/skill I_OL1TIME and I_OL2 TIME database items, row data will be archived for those items if the skill row spent any time in overload 1 or overload 2. If the row (skill) spent all of its time in the normal state, and has no other reason to be archived (that is, no agent staffed time, no calls handled, and so on), then it will not be archived. When creating a report through CentreVu Report Designer, data should be summed across intervals in order to see meaningful data.

<table>
<thead>
<tr>
<th>Step</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>1.</td>
<td>Access the Report Designer in Design Mode (Chapter 3) &lt;br&gt;Access the Report Designer so that you can design the report.</td>
</tr>
<tr>
<td>2.</td>
<td>Define the Inputs for the Report Input Window (Chapter 6) &lt;br&gt;Define inputs for the report input window so that users can run the report using parameters they choose (that is, what split, agent, time, date, and so on). &lt;br&gt;Inputs can also be defined while you are creating a query. To do so, select the Inputs button on the WHERE clause window.</td>
</tr>
<tr>
<td>3.</td>
<td>Define the Queries for the Report (Chapter 7) &lt;br&gt;Define report type and rows of data from specific CMS database tables will supply data for the grids and charts on the report.</td>
</tr>
<tr>
<td>4.</td>
<td>Insert Charts, Tables, and Fields on the Report (Chapters 8, 9, and 10) &lt;br&gt;Define what data from the queries should appear in each chart, field, or table on the report.</td>
</tr>
<tr>
<td>Step</td>
<td>Description</td>
</tr>
<tr>
<td>------</td>
<td>-------------</td>
</tr>
<tr>
<td>5.</td>
<td><strong>Enter Report Text (Chapter 15) (optional)</strong>&lt;br&gt;Enter text to provide headings for the grids and charts on the report, and to provide additional information, such as the report name.</td>
</tr>
<tr>
<td>6.</td>
<td><strong>Define Fields to Show Run Time/Date and User Inputs (Chapter 9) (optional)</strong>&lt;br&gt;Define fields on the report to show when the report was run and what items the report covers (as defined in the report input window).</td>
</tr>
<tr>
<td>7.</td>
<td><strong>Edit the Appearance of the Report (Chapter 5)</strong>&lt;br&gt;Edit a report design using the <strong>Cut, Copy, and Paste Edit</strong> menu options and standard <em>Windows</em> drag-and-drop conventions. Editing an existing report design lets you rearrange and delete sections of the report quickly and easily.</td>
</tr>
<tr>
<td>8.</td>
<td><strong>Save the Report Design (Chapter 3)</strong>&lt;br&gt;Save the report you have been working on prior to testing the report.</td>
</tr>
<tr>
<td>9.</td>
<td><strong>Define a Report's Properties (Chapter 4)</strong>&lt;br&gt;Define the <em>name</em> that you use both to run the report and to access the report design if you want to change the design. Define access to determine whether other users can run the report and copy the report’s design to create their own custom reports. Define the <em>type</em> as real-time, historical, or integrated.</td>
</tr>
<tr>
<td>10.</td>
<td><strong>Test (Run) the Report Design (Chapter 3)</strong>&lt;br&gt;Test your report immediately after designing and saving it. Testing helps eliminate wasted time in running a report whose design is incomplete.</td>
</tr>
</tbody>
</table>
The following table lists 11 tasks you need to complete to edit an exiting report in the Report Designer. If you consistently do all of these tasks for each report you want to edit, then your reports will run properly and you will be able to create them efficiently. The tasks are as follows:

<table>
<thead>
<tr>
<th>Step</th>
<th>Action</th>
</tr>
</thead>
</table>
| 1.   | **Copy an Existing Report to the Designer Category (Chapter 4)**  
      | Copy an existing report so that you start the design process with existing report headings, data fields, queries, charts, grids, and other report features. When you copy a report to the Designer category, the original report remains intact and is still located in the original report category. You can also run a report and then select **Design** from the **Report** menu. This takes you directly into design mode, and you will be asked if you want to save the report (with a new name, in the Designer category) when you exit design mode. |
| 2.   | **Define a Report’s Properties (Chapter 4)**  
      | Define the name that you use both to run the report and to access the report design if you want to change the design. Define access to determine whether other users can run the report and copy the report’s design to create their own custom reports. Define the type as real-time, historical, or integrated. When you copy a report to the Designer category using the Report Manager, the Properties window automatically displays as part of the copy process. |
| 3.   | **Access the Report Designer in Design Mode (Chapter 3)**  
      | Access the Report Designer so that you can design the report. |
| 4.   | **Edit the Appearance of the Report (Chapter 5) (optional)**  
<pre><code>  | Edit a report design using the **Cut**, **Copy**, and **Paste** **Edit** menu options and standard **Windows** drag-and-drop conventions. Editing an existing report design lets you rearrange and delete sections of the report quickly and easily. |
</code></pre>
<table>
<thead>
<tr>
<th></th>
<th>Define Inputs for the Report Input Window (Chapter 6) (optional)</th>
</tr>
</thead>
<tbody>
<tr>
<td>5.</td>
<td>Define inputs for the report input window so that users can run the report using parameters they choose (that is, what split, agent, time, date, and so on). If you copy a report design, the definition of that report’s input window is copied. You can then modify the input fields as required.</td>
</tr>
<tr>
<td></td>
<td>Inputs can also be defined while you are creating a query. To do so, select the Inputs button on the WHERE clause window.</td>
</tr>
<tr>
<td></td>
<td>Define the Queries for the Report (Chapter 7) (optional)</td>
</tr>
<tr>
<td>6.</td>
<td>Define which rows of data from specific CMS database tables will supply data for the grids and charts on the report. If you copy a report design, the definitions of that report’s queries are copied. You can then modify the queries, as required.</td>
</tr>
<tr>
<td></td>
<td>Insert Charts, Tables, and Fields on the Report (Chapters 8, 9, and 10) (optional)</td>
</tr>
<tr>
<td>7.</td>
<td>Define what data from the queries should appear in each chart, field, or table on the report. If you copy a report design, the definitions of that report’s charts, fields, and tables are copied. You can then modify the data as required.</td>
</tr>
<tr>
<td></td>
<td>Enter Report Text (Chapter 11) (optional)</td>
</tr>
<tr>
<td>8.</td>
<td>Enter text to provide headings for the tables and charts on the report, and to provide additional information, such as the report name. If you copy a report design the text of that report is copied. You can then modify the text, as desired.</td>
</tr>
<tr>
<td></td>
<td>Define Fields to Show Run Time/Date and User Inputs (Chapter 9) (optional)</td>
</tr>
<tr>
<td>9.</td>
<td>Define fields on the report to show when the report was run and what items the report covers (as defined in the report input window). If you copy a report design these fields are copied. You can modify them as required.</td>
</tr>
<tr>
<td></td>
<td>Save the Report Design (Chapter 3)</td>
</tr>
<tr>
<td>10.</td>
<td>Save the report you have been working on prior to testing the report.</td>
</tr>
<tr>
<td></td>
<td>Test (Run) the Report Design (Chapter 3)</td>
</tr>
<tr>
<td>11.</td>
<td>Test your report immediately after designing and saving it. Testing helps eliminate wasted time in running a report whose design is incomplete.</td>
</tr>
</tbody>
</table>
5 Design Mode Basics

Introduction

This chapter teaches you to how to use the basic Windows® features of the Report Designer Design Mode window, including:

- Copying an Item and Pasting the Item Into the Same Report
- Copying an Item from One Report and Pasting the Item Into Another Report
- Cutting an Item from the Report
- Deleting an Item from the Report
- Using Drag-and-Drop to Arrange Items on the Report
- Resizing an Item on the Report
- Selecting Multiple Items on the Report
- Changing the Width of a Column in a Table
- Changing Column Headings
- Aligning Fields
- Scale to Page.

*Windows is a registered trademark of Microsoft Corp.
You can copy an item in one report and paste the copy into the same report. To do so, complete the following steps:

1. Open the report from which you want to copy.
2. Select the item(s) that you want to copy.
3. Select **Copy** from the **Edit** menu, or press CTRL+C.
4. Select **Paste** from the **Edit** menu, or press CTRL+V.

The item(s) is placed in the upper left-hand corner of the Design Mode window.
Copying an Item from One Report and Pasting the Item Into Another Report

You can copy items from one report to another report. To do so, complete the following steps:

1. Open the report from which you want to copy.
2. Select the items that you want to copy.
3. Select Copy from the Edit menu, or press CTRL+C.
4. Open the report to which you want to copy.
5. Select Paste from the Edit menu, or press CTRL+V.

Note that both reports must be open in design mode in order to copy from one report to another report.

If you want to copy an item from a report that is not a Designer report, complete the following steps:

1. Run the report.
2. Select Design from the Report menu.
3. Copy the item to the clipboard (using the steps above).
4. Select Run from the Report menu.

As long as you do not make any changes to the report, you will automatically be returned to the run mode. If you inadvertently make changes to the report, a message displays that gives you the option to save the changes. Select No if you do not want to save the changes.
Cutting an Item from the Report

Selecting Cut removes the currently selected item from the report and places it on the Windows clipboard.

To cut an item from a report and place the information on the Windows clipboard, complete these steps:

1. Select the item by placing your mouse cursor on the item and clicking.
2. Select Cut from the Edit menu, or press CTRL+X.
Deleting an Item from the Report

Selecting **Delete** permanently removes the currently selected item(s) from the report.

To delete an item from a report, complete the following steps:

1. Select the item by placing your mouse cursor on the item and clicking.
2. Select **Delete** from the **Edit** menu, or press the DELETE key.

The item is removed from the report and is *no longer* available to be pasted on the report. If you accidentally delete an item that you would like to keep on the report, you can select **Undo** from the **Edit** menu (if you haven’t done anything else). If you do not immediately realize that you inadvertently deleted an item, you can use the **Insert** menu to recreate the item.
Using Drag-and-Drop to Arrange Items on the Report

You can move one or more items around on a report using the Windows drag-and-drop method. To do this, complete these steps:

1. Select an item(s) by pointing the mouse cursor at the item and clicking one time.

   You can select additional items by holding down the CTRL key and clicking the mouse cursor on the items.

   You will know when an item is selected because there will be either a frame around the item or sizing handles will display on the corners of the item.

2. Hold down the left mouse button.

3. Move the mouse cursor to the position in which you would like the item to reside.

4. Let go of the mouse button.
Resizing an Item on the Report

To resize an item on a report, complete the following steps:

1. Select the item by placing the mouse cursor over the item and clicking one time.
2. Place the mouse cursor over one of the sizing handles on the item.
3. Press the left mouse button.
4. Drag the mouse cursor until the item is the appropriate size.
5. Release the mouse button.
Selecting and Moving Multiple Items on the Report

To select multiple items on a report (for instance, to copy more than one item at a time), complete the following steps:

1. Select the first item.
2. Hold down the CTRL key.
3. Select the second item. Handles around the items appear.

To move the group of items on a report, complete the following steps:

1. Place the cursor within the selected items.
2. Hold down the left mouse button and drag the selected items to the desired area. There is a visual indication that your selected items are moving (as a group) with the cursor. As you move the selected items, an outline of the items appears and then moves with your cursor.
3. Once at the desired location, release the mouse button. The selected items appear in the desired location.
Changing the Width of a Column in a Table

You can quickly and easily change the column widths in your table while in the design mode. To change a column width, do the following:

1. Place the mouse pointer on the border between the column heading. The mouse pointer changes to the following shape:

```
  | |
```

2. Hold down the left mouse button and drag the column border to the left or right. The column width automatically decreases or increases depending on how you moved the column border.
Changing the Column Headings

You can quickly and easily change the column headings in your table while in the design mode. To change a column heading, do the following:

1. Click on the heading name you want to change. A dialog box appears with the current heading highlighted.

   ![Edit Table Header Dialog]

2. Enter the new name of the heading in the Name text box.

3. Select OK.
Aligning Fields

The Report Designer Edit menu has two new menu items: Align Controls and Undo Align Controls.

You can now select multiple fields and align them according to the controls in the Align Controls dialog box. In addition, you can undo the alignment if you are not satisfied with the results. The Align Controls dialog box provides six alignment choices. When you select multiple fields, an outline around the fields appears. Any alignment choice you select will align the fields within this outline.
Scale to Page

When printing a report that is too large to fit on one page, you will be prompted with a message(s) (the number of messages will depend on how large your report is) asking if you want Report Designer’s Scale to Page function to attempt to fit your report onto one page.
6 Edit | Inputs

Introduction

This chapter teaches you about report input fields and gives you instruction on how to add, delete, and edit the input fields for a Report Designer report. The sections in this chapter are as follows:

- About Report Input Fields
- Adding Input Fields to the Input Window
- Deleting Input fields from the Input Window
- Editing the Order of Input Fields
- Editing the Appearance of Input Fields
- Setting Up Inputs for a Multi-ACD Report
- Viewing the Input Window.
About Report Input Fields

To run a report, you first access a Report Input window. The Report Input window gives you control over what data (which splits/skills, trunks, dates, intrahour intervals, and so on) are included in the report.

To define report input fields for a designer report, use the Define Input window. When you or another user runs the report, this input window appears with the field prompt(s) and the input field(s) you defined.

You define fields for the Report Input window using the steps described in the following pages.

In the example of an input window that is shown below, the user has entered a split number of 1, a date of 07/01/96, and intrahour intervals from 8:00 a.m. to 11:00 a.m.

Because the report this input window is associated with is a Historical Interval report, CMS will retrieve the data for the report from the historical database tables, which are designated with an “h” (hagent, hsplit, htrunk, and so on). For more information on how CMS stores and retrieves data, refer to Chapter 15, “How CMS Stores and Retrieves Data” and the CentreVu® CMS R3V8 Database Items and Calculations document (585-210-939).
Adding Input Fields to the Input Window

Defining the type of an input field enables CMS to do the following when a user runs the report:

- Check that the user's entries are valid system values and are values CMS can use to search the database tables.
- Check that the user has permissions to run a report for the entries.
- Allow the user to enter names defined in the Dictionary subsystem.

Add only inputs that are used in the report queries. If you add additional inputs (that are not used in the queries), then irrelevant information that references those inputs will display on the input window for the report.

To define the input fields for a report, complete the following steps:

1. Select Inputs from the Edit menu.

   The Edit Inputs “Select inputs for this report” window displays, as shown next. If you are editing an existing report, the items that already appear on the input window for the report are shown in the Inputs list. If you are creating a new report, the Inputs list is blank.

2. In the Input Types list, highlight the first input you want to require for the report. See the following table for definitions of the available Input Types.

3. Select the Add button.

   The item displays on the Inputs list.
4. Repeat Step 2 until you have added all of the inputs required for the report.

<table>
<thead>
<tr>
<th>For this type of input:</th>
<th>The user must enter the following information:</th>
</tr>
</thead>
<tbody>
<tr>
<td>ACD</td>
<td>An ACD number or name.</td>
</tr>
<tr>
<td>Agent</td>
<td>An agent name (as defined in the Dictionary) or agent login ID. The Agent input field can only be a single-value input for integrated reports.</td>
</tr>
<tr>
<td>Agent group</td>
<td>An agent group name (as defined in the Dictionary). Use the following query: ACD=$acd and OLDEST_LOGON &gt; 0 and LOGID in (select value from agroups where acd_no=$acd and item_name = [Agent Group:]).</td>
</tr>
<tr>
<td>Agent state</td>
<td>An agent state name (standard or new name as defined in the Dictionary). Standard names are ACD, AUX, ACW, and so on.</td>
</tr>
<tr>
<td>Call Work Code</td>
<td>A call work code name or number.</td>
</tr>
<tr>
<td>Date</td>
<td>A date must be entered. Dates can be entered in region-specific format or as a relative number (for example, -7 for 7 days ago).</td>
</tr>
<tr>
<td>Extension</td>
<td>An extension number of one to five digits (as administered for System 75/Generic 1/Generic 3) or three to five digits (as administered for System 85/Generic 2).</td>
</tr>
<tr>
<td>For this type of input:</td>
<td>The user must enter the following information:</td>
</tr>
<tr>
<td>------------------------</td>
<td>------------------------------------------------</td>
</tr>
<tr>
<td>Location ID</td>
<td>A location ID can be assigned to either an agent or to a trunk equipment location. For an agent, the location ID is actually assigned to the agent’s terminal, and is associated with the DEFINITY® port network to which the terminal is assigned. Agent location IDs are available only for reports for agents who are currently logged in. Agent location ID is part of the Agent Site Tracking feature. Trunk location IDs are assigned to the trunk equipment location, and are associated with the DEFINITY port network location. Trunk equipment location ID is part of the Multi-Locations feature on DEFINITY. Location IDs are between 1 and 44 characters.</td>
</tr>
<tr>
<td>Login ID</td>
<td>A login ID of one to nine digits (as administered for System 75/Generic 1/Generic 3) or four digits (as administered for System 85/Generic 2).</td>
</tr>
<tr>
<td>Number</td>
<td>A number, which may include digits to the right of the decimal point. This type applies if your variable field asks for specific values about ACD performance (for example, number of ACD calls or percent within service level).</td>
</tr>
<tr>
<td>Split/Skill</td>
<td>A split/skill number or name.</td>
</tr>
<tr>
<td>String</td>
<td>A character string. Select this type only if one of the following is true: 1. Your variable field is linked to a custom database item that you identify in INFORMIX® as a CHAR column. 2. Your variable field is linked to a standard database item that is a CHAR column, AND you want to allow the user to do pattern searching when running the report. See the following section in this chapter, “Input Fields That Allow Pattern Matching.”</td>
</tr>
<tr>
<td>For this type of input:</td>
<td>The user must enter the following information:</td>
</tr>
<tr>
<td>------------------------</td>
<td>-----------------------------------------------</td>
</tr>
<tr>
<td>Time (duration)</td>
<td>A number, including decimals, of seconds. This type applies only if your variable field asks for specific values regarding ACD performance (for example, time in AUX work, average speed of answer, or average talk time).</td>
</tr>
<tr>
<td>Time (point in time)</td>
<td>A specific time of day in hh:mm format, either as 24-hour time or with AM or PM appended.</td>
</tr>
<tr>
<td>Trunk</td>
<td>A trunk name or number. The Trunk input field can only be a single-value input for integrated reports.</td>
</tr>
<tr>
<td>Trunk group</td>
<td>The number or name of a trunk group.</td>
</tr>
<tr>
<td>Trunk state</td>
<td>A trunk state name (standard name or new name as defined in the Dictionary subsystem). Standard names are <code>IDLE</code>, <code>SEIZED</code>, <code>QUEUED</code>, and so on. <strong>NOTE:</strong> If you use Trunk state as an input in an integrated report, the input <strong>must</strong> be used in a real-time query. It cannot be used in an integrated query.</td>
</tr>
<tr>
<td>VDN</td>
<td>A Vector Directory Number of one to five digits (as administered for System 75/Generic 1/Generic 3) or three to five digits (as administered for System 85/Generic 2) or a VDN name. The VDN input field can only be a single-value input for integrated reports.</td>
</tr>
<tr>
<td>Vector</td>
<td>A vector number or name. The Vector input field can only be a single-value input for integrated reports.</td>
</tr>
</tbody>
</table>

*INFORMIX is a registered trademark of Informix Software, Inc.*

If you are defining a real-time report, you **cannot** and **do not need to** define an “Update Rate in Seconds” input field because the field is automatically included in the Report Input window.

If you are defining a historical report, you **cannot** and **do not need to** define a “Report Destination” input field because the field is automatically included in the Report Input window.
If you are defining an integrated report, you **cannot** and **do not need to** define a “Start Time” input field because the field is automatically included in the Report Input window.

### Input Fields That Allow Pattern Matching

CMS can search for values in certain database items according to wild card search patterns. As a result, you can create a report that allows inputs based on character strings, plus either an asterisk (matches on blank and all characters) or a question mark (matches on any single character). CMS then includes data for all items that match the character strings the user entered.

The standard database items that allow this type of searching are as follows:

- VDN (the value is a VDN number)
- EXTENSION (the value is an extension number)
- LOGID (the value is an agent login ID)
- EQLOC (the value is a 9-digit trunk location number)
- CWC (the value is a call work code)
- ROW_DATE (the value is a date)

In addition, any custom database items that you define as CHAR columns in *INFORMIX* also allow this type of searching.

As an example of matching with an asterisk (*), if an input field were a **String** type and were associated with the LOGID database item, the user could enter `1*`, and CMS would include data for all agents with login IDs that start with 1 (1, 10, 1238, 190, and so on, depending on the switch’s administered login length). As an example of matching with a question mark (?), if an input field were a **String** type and were associated with the VDN database item, the user could enter `21?0`, and CMS would include data for all VDNs that start with 21, end with 0, and have any single character appearing between the 21 and the 0 (2100, 2110, 2120, 2130, and so on).

If you select **String** for an input field, CMS does not check a user’s inputs in that field for appropriate read permissions or valid switch parameters. If you want CMS to check permissions for a VDN input field, you must select the **VDN** field type. If you want CMS to check switch parameters for a VDN, login ID, extension, or call work code input field, you must select that field type, **not** **String**. In addition, if you select **String** for a field, the user will not be able to enter Dictionary names. So, again, if you want to let the user enter VDN, login ID, or call work code names to run a report, you must select that specific field type, **not** **String**.
Deleting Input Fields from the Input Window

To delete one of the inputs you have added for a report input window, complete the following steps:

If a field is used in a query, the input cannot be removed until the query is removed or modified to eliminate the reference to the input.

1. Select **Inputs** from the **Edit** menu
2. On the **Inputs** table, highlight the row of the item you want to delete by clicking on the left-hand (numbered) column of the row.
3. Select the **Remove** button.
Editing the Order of Input Fields

You can change the order in which input fields appear on the report input window by completing the following steps:

1. Select **Inputs** from the **Edit** menu.

2. Add the **Input Types** that will appear on the input window to the **Inputs** table.

3. Select the entire row of the input for which you want to change positions by clicking on the left-hand (numbered) column of the row.

4. Use the **Up** and **Down** buttons to move the entire row up or down one row at a time.

5. Using the **Inputs** list, you can edit the name of the prompt for each input field, control whether multiple values are allowed in the input field, and define the ACD with which the input will be associated.

6. When you are finished editing the order of the input fields, select **OK**.
Editing the Appearance of Input Fields

Using the Inputs list, you can edit the name of the prompt for each input field, control whether multiple values are allowed in the input field, and define the ACD with which the input will be associated.

When you add an item from the Input Types list to the Inputs list, the columns of the Inputs table are populated with the default values for that input item. The columns of the Inputs table are as follows:

<table>
<thead>
<tr>
<th>Column</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Type</td>
<td>The Type column shows the input field name. You can use the pull-down list to the right of the column to change the input in a particular row to another type.</td>
</tr>
<tr>
<td>Multi-value</td>
<td>Select the Multi-Value check box if you want to allow users to enter multiple values in the input field.</td>
</tr>
<tr>
<td>Column</td>
<td>Function</td>
</tr>
<tr>
<td>------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Prompt</td>
<td>The prompt column shows the text that will display on the report input window for this input field. You can edit the text for the prompt by selecting the cell in the table and then typing the text that you want to display. If you want to delete the existing prompt text, use the backspace key to erase the letters. You can enter a name with up to 30 characters long, including blank spaces. The prompt name should describe the information (what split/skill, what date, what time, and so on) a user must enter in the field when ordering the report. For example, if you want the user to enter a date, “Date” would be an appropriate prompt. However, if the user can enter more than one date in the field, “Dates” would be more appropriate.</td>
</tr>
</tbody>
</table>
| Associated ACD | The Associated ACD column lets you use the Current ACD or assign a specific ACD to be used for this input. The default for this column is Current ACD. If you want to allow the user to pick a specific ACD for the input field, use the pull-down list to the right of the column to select ACD. If the Associated ACD column is blank, the input cannot be associated with a specific ACD. Select Current ACD if either of the following conditions is true:  
  - You have only one ACD  
  - You always want the report to show data for the user's current ACD. Select ACD if the people who will be running the report have read permissions for more than one ACD. Allowing the user to select the ACD for the input is most useful when you are creating a multi-ACD report. |
| Default Value | You can define a default value for most input fields. To do this, select the browse button to the right of the column. The available values for this type of input are displayed. Highlight one and select OK. If you select a default value, the user can change the value on the input window. |
Setting Up Inputs for a Multi-ACD Report

Two types of multi-ACD reports are available:

- Multi-ACD reports that show data for multiple splits/skills on multiple ACDs, and
- Multi-ACD reports that show data for multiple VDNs on multiple ACDs.

If you are creating a multi-ACD report, you need to make sure that you set up the inputs as detailed below so that the query for the report will work properly.

The following instructions use the split/skill multi-ACD report inputs as the example. To create the inputs for a VDN multi-ACD report, use these same instructions, but use the VDN input instead of the Split/Skill input.

The following instructions show you how to create the inputs for a multi-ACD report that allows inputs for up to four ACDs:

1. Select Inputs from the Edit menu.
2. Select ACD from the Input Types box.
3. Select the Add button.
4. Repeat Steps 2 and 3 three times.

The Inputs table will look like this:

5. Select Split/Skill on the Input Types box.
6. Select the Add button.
7. Repeat Steps 5 and 6 three times.

The Inputs table will look like this:

8. For the Split/Skill(2) prompt (line 6 of the Inputs table), use the Associated ACD drop-down list to select ACD(2) as the associated ACD.

9. For the Split/Skill(3) prompt (line 7 of the Inputs table), use the Associated ACD drop-down list to select ACD(3) as the associated ACD.

10. For the Split/Skill(4) prompt (line 8 of the Inputs table), use the Associated ACD drop-down list to select ACD(4) as the associated ACD.
The Inputs table looks like this:

11. Select **OK** to save the inputs for this multi-ACD report.
Viewing the Input Window

You can view what the input window will look like at any point during the process of designing the report by selecting Run from the Report menu.

To return to the design mode from the report input menu, select the Cancel button.
A report consists of fields, charts, and grids which display data that is retrieved from the Call Management System (CMS) database tables. The definition of what data is retrieved for a specific report is done using queries. This chapter teaches you to create queries for reports using the Query Assistant, which is accessed by selecting **Query** from the **Edit** menu. The sections of this chapter are:

- Defining Queries for a Report
- Creating a Real-Time or Historical Query
- Creating an Integrated Query
- Editing an Existing Real-Time or Historical Query
- Editing an Existing Integrated Query
- Copying a Query
- Deleting a Query.
Defining Queries for a Report

To complete the definition of a report’s grids, charts, or fields, you must define the queries that select the rows of the appropriate tables in the CMS database.

Queries are values for either database items or calculations. In most cases, the queries specify the input variables rather than specific values as criteria for retrieving information from the database. The input variables allow CMS to use the values entered in the Report Input window as the query criteria for the report.

If you change the prompt in the Edit Inputs window, it is automatically updated in the query.

Queries tell CentreVu® CMS two things:

- Where to get the data, and
- How to use the data.

CentreVu CMS selects values from a table with both row and column identifiers. CentreVu CMS identifies rows of data according to the user’s inputs and the row search conditions you define. CentreVu CMS identifies columns according to the data expression you define here.

For more information about SQL queries and the CMS Database Tables, refer to Chapter 18, “SQL Queries and CMS Database Tables Basics” and the CentreVu® CMS R3V8 Database Items and Calculations document (585-210-939).
Creating a Real-Time or Historical Query

To create a new query to be used in a Designer Report, complete the following steps from the Report Designer Design Mode window:

1. Select **Query** from the **Edit** menu.

   The Query Select “Select an existing query or add a new one” window appears as shown below:

   2. Select the **New** button.

   The Query Assistant “Select a database and one or more tables for the query” window in appears as shown below:
3. Depending on the type of report you are creating, select the **Database** radio button next to **Real-Time** or **Historical**.

   The tables that are available for the type of database (Real-Time, Historical, or Integrated) selected display.

   For instructions on creating an integrated query, see the “Creating an Integrated Query” section in this chapter.

4. In the **Table** list, highlight the name(s) of the table(s) which includes the database items that you want to include in the query. For Real-Time reports, you can select only one table name. For Historical reports, you can select up to three table names.

   Note that the calculations that are associated with the database items in the table(s) you choose will also be available for you to use in your query.

   For information on the database items and calculations available in each table, see the *CentreVu® CMS R3V8 Database Items and Calculations* document (585-210-939).

5. Select the **Next** button.

   The Query Assistant “Add the database items and calculations for the SELECT portion of the query” window displays, as shown below. On this window, you will add and remove database items and calculations that will be included in the query.
6. In either the **Database Items** or **Calculations** box, highlight the first database item or calculation that you will reference in the query. To see a definition of the database item or calculation, click on the database item or calculation and then select the Data Item definition button.

In the **Other** box, you can type the names of Database Items or Calculations, strings, or constants that you want to use in the query. For instance, if you know that you would like the report to include information that subtracts the quantity of one database item from the quantity of another database item (for instance, ACDCALLS - ACDAUXOUTCALLS), then you could type a “-” in the **Other** box and add it to the list of Query Items. When you create the WHERE clause for the query, you can specify a calculation of ACDCALLS - ACDAUXOUTCALLS for the report.

Constants that have been defined in the Dictionary are listed in the **Calculations** box in addition to the calculations.

7. Select the **Add** button, or double click on the item. You can view any database item or calculation by selecting the database item or calculation and then selecting the **Data Item Definition** button.

The item is listed in the **Query Items** box.

8. Repeat Steps 6 and 7 until all of the database items and calculations that you believe will be referenced in the query are listed in the **Query Items** box.

You can remove an item from the **Query Items** box by highlighting the item and selecting the Remove button.

You can rearrange the order of the items in the **Query Items** box using the **Move Up** and **Move Down** buttons.

You can edit an item in the **Query Items** box by highlighting the item and selecting the **Edit** button. When you select the **Edit** button, the following window appears as shown below:

An example of how you might want to edit an item would be to create a custom calculation in the edit box. For instance, you may add “calls offered -” to the abncalls item shown above, so that the item would then read “calls offered - abncalls” and that is the calculation that would be available for you to use in the query.
9. Select the **Next** button.

The Query Assistant “Choose functions for the SELECT items” window appears as shown below:

If you are creating a query that uses Integrated Data, the steps differ from this point on. See the “Creating an Integrated Query” section for the correct steps.

You will use this window to assign aggregate (AVG, MAX, MIN, and SUM) functions to the **Query Items**. A function is a prefix that is attached to a database item, a calculation, parts of a calculation, or a calculation name. CMS will display only one value on the report if an aggregate function (SUM, AVG, MIN, or MAX) is assigned to a database item or calculation.

10. Highlight the first **query item** to which you want to assign an aggregate function.

11. Highlight the **Function** that you would like to assign to the item.

The available functions are:

- **MAX** — The MAX aggregate function retrieves the highest value for a calculation or database item over the time frame of the report. For example, if the Intrahour Split table contained data as shown in the following figure and you assigned the MAX function to the ACDCALLS database item, then ran the report for Split 1 for all intervals on 07/02/93, CMS would find all of the rows that are shown in bold. However, CMS would display only the value 418 (shown in the box), which is the maximum number of ACD calls in any single interval on 07/02/93. Likewise, if you assigned the MAX function to the
ACDTIME and ACDCALLS database items and then defined a where clause of ACDTIME/ACDCALLS for a report field, CMS would display the value 101.53 (which is the highest average talk time in any single interval on 07/02/93).

- **MIN** — The MIN aggregate function retrieves the lowest value for a calculation or database item over the time frame of the report. For example, using the previous example, if you assigned the MIN function to the ACDCALLS database item (instead of the MAX function) and then ran the report for Split 1 for all intervals on 07/02/93, CMS would display only the value 394 which is the smallest number of ACD calls in any single interval on 07/02/93.

- **SUM** — The SUM aggregate function retrieves the sum of all values for a calculation or database item over the time frame of the report. For example, if the Intrahour Split table contained data as shown in above and you assign the SUM function to the ACDCALLS database item, then ran the report for Split 1 and all intervals on 07/02/93, CMS would add all of the values for the ACDCALLS column on that date to display the value 1611.

- **AVG** — The AVG aggregate function retrieves the average of all values found over the time frame of the report. Using the sample table in above, if you assigned the AVG function to the ACDCALLS database item, and then ran the report for Split 1 for all intervals on 07/02/95, the value 402.75, which is the average of 399, 400, 394, and 418, would be displayed on the report.

12. Repeat Steps 10 and 11 until you have assigned Functions to the appropriate Query Items.
If you are creating a Real-Time query, you must assign Functions to all of the query items, or to none of the query items. Therefore, if any one of the query items does not have an applicable aggregate function, you cannot assign an aggregate function to any of the query items.

13. Select the **Next** button.

14. If you did not select more than one Historical database table for your query, skip to Step 19.

If you selected the Historical Database for your query and are using more than one table in the query, the “Specify all field joins for the tables” window appears as shown below:

This window allows you to require that items between two or three tables be equal in order to be used in the report. For instance, you might want to select the “acd” item from each agent and make a join clause to ensure that the report is for the same ACD information across the tables.

15. Highlight an item in one of the table lists.

16. Highlight an item in one or both of the remaining table lists.

17. Select the **Join** button.

The join clause is shown in the **Join Criteria** box.

18. Repeat Steps 15 through 17 until all of the necessary join clauses are listed.

19. The Query Assistant “Enter the SQL WHERE criteria” window displays, as shown below.
If you are creating a Historical query, a **Unique** check box displays next to the **SELECT** box. Select this check box to make this query unique in the current report. What this means is that, if the query returns multiple rows of the same data, then only one row of the data will display on the report.

This window is where you will define the SQL “where” clauses that will be used to retrieve data for the report. The SQL where clause tells the CMS to retrieve the data defined in the **SELECT** box that matches the criteria defined in the **WHERE** box. The **SELECT** box specifies which columns of data to consider in the database table(s). The **WHERE** box specifies which rows of data to consider in the database table(s).

For more information on SQL where clauses, see Chapter 18, “SQL Query and CMS Database Tables Basics” in this document.

This window includes the following elements:

<table>
<thead>
<tr>
<th>Item</th>
<th>Purpose</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>SELECT box</strong></td>
<td>Shows the Query Items that were defined on the previous windows, including the database items and calculations and any associated functions assigned to the items, and the database table from which the database items and calculations are to be retrieved. The information displayed in the <strong>SELECT</strong> box cannot be edited.</td>
</tr>
</tbody>
</table>
The ACD operand is automatically added to the beginning of each WHERE clause.

20. In the Operand1 box, highlight the first database item or calculation which you want considered in the WHERE clause.

21. In the Operator box, highlight the appropriate operation.

22. In the Operand2 box, highlight the second item (input, database item, calculation, or item defined in the Other box on the “Add the database items and calculations for the SELECT portion of the query” window) which you want considered in the WHERE clause.

For example, if you wanted the report to select the data from the table when the number of ACDCALLS is greater than the number of ACWINCALLS, then you would select acdcalls in the Operand1 box, the > sign in the Operator box, and ACWINCALLS in the Operand2 box.

23. Select the AND or the OR button, as appropriate.

If you place “and” between clauses, then both of the clauses must be true in order for CMS to retrieve the SELECT data from the table.
If you place “or” between clauses, then either of the clauses can be true in order for CMS to retrieve the SELECT data from the table.

24. Repeat Steps 20 through 23 until you have completed the query.

You can add your own text in the WHERE clause (such as parenthesis and numbers) by placing your cursor where you would like the text to appear and then typing in the text.

If you are creating a report that will display data for multiple splits/skills or VDNs on multiple ACDs, you can type MULTI_ACD in the where clause, instead of entering each individual OR statement. This will only work if you have correctly set up the inputs for the multi-ACD report. See Chapter 6, “Edit | Inputs,” for information on setting up the inputs for a multi-ACD report.

25. Select the Test button.

CMS checks the syntax of the query and returns a message with any errors.

For information on the most common query errors, see Chapter 16, “Error Messages,” in this document.

Note that some errors are not detected until you run the report.

26. Correct any of the errors detected in the Test.

27. Select the Next button.

The Query Assistant “Enter a name for this query” window appears:

28. In the Name text box, type the name that you would like to assign to the query you created.

29. Select the Done button.
Creating an Integrated Query

To create a new query to be used in a Designer Report, complete the following steps from the Report Designer Design Mode window:

1. Select **Query** from the **Edit** menu.

   The Query Select window appears:

   ![Query Select Window]

   2. Select the **New** button.

   The Query Assistant “Select a database and one or more tables for the query” window in appears:

   ![Query Assistant Window]

   3. Select the **Database** radio button next to **Integrated**.

   The tables that are available for integrated reports display.
4. In the **Table** list, highlight the name of the table which includes the database items or calculations that you want to include in the query.

For integrated reports, you can select one table per query.

For information on the database items and calculations available in each table, see the *CentreVu® CMS R3V8 Database Items and Calculations* document (585-210-939).

5. Select the **Next** button.

The Query Assistant “Add the database items and calculations for the SELECT portion of the query” window displays, as shown below. On this window, you will add and remove database items and calculations that will be included in the query.

6. In either the **Database Items** or **Calculations** box, highlight the first database item or calculation that you will reference in the query.

7. Select the **Add** button.

The item is listed in the **Query Items** box.

8. Repeat Steps 6 and 7 until all of the database items and calculations that you believe will be referenced in the query are listed in the **Query Items** box.
9. Select the **Next** button.

The Query Assistant “Enter the start time for this integrated query” window appears:

![Query Assistant Window](image)

10. Select the **Input Start Time** or **Select Start Time Now** radio button.

If you select the **Select Start Time Now** radio button, you need to define the time that the integrated data will always begin accumulating for this report.

If you select the Input Start Time, a “Start Time” field will be added to the report input window and users can individually define the time that data will begin accumulating for the report.
11. Select the **Next** button.

The Query Assistant “Select the input used to indicate the xxx for this query” window appears:

On this window, you can choose the input item that will be used for the query.

12. Highlight the input(s) you would like to use as criteria for the query. You can create a new input by selecting the **New Input** button, which takes you to the **Edit Inputs** assistant.

Only the inputs that apply to the table you selected for this query will appear.

13. Select the **Next** button.
The Query Assistant “Enter a name for this query” window appears:

14. In the **Name** text box, type the name that you would like to assign to the query you created.

15. Select the **Done** button.
Editing an Existing Real-Time or Historical Query

To edit an existing real-time or historical query used in a Designer Report, complete the following steps from the Report Designer Design Mode window:

1. Select **Query** from the **Edit** menu.
   
The Query Select window appears:

   ![Query Select Window](image)

2. In the **Queries** box, highlight the name of the query you would like to edit.

3. Select the **Edit** button.
   
The Query Assistant “Add the database items and calculations for the SELECT portion of the query” window appears. The Database Items and Calculations that are already included in the query are listed in the Query Items list.
4. If you would like to add database items or calculations to the **Query Items** list, highlight the item in the **Database Items** or **Calculations** box and then select the **Add** button.

If you would like to remove a database item or calculation from the **Query Items** list, highlight the item in the list and then select the **Remove** button.

If you would like to edit a database item or calculation on the **Query Items** list, highlight the item in the list and then select the **Edit** button. The following window appears:

An example of how you might want to edit an item would be to create a custom calculation in the edit box. For instance, you may add “callsoffered -” to the abncalls item shown above, so that the item would then read “callsoffered - abncalls” and that is the calculation that would be available for you to use in the query.

5. Repeat Step 4 until all of the database items and calculations that you believe will be referenced in the query are listed in the **Query Items** box.

6. Select the **Where** button.
The Query Assistant “Enter the SQL WHERE criteria” window appears, as shown below:

<table>
<thead>
<tr>
<th>Item</th>
<th>Purpose</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>SELECT box</strong></td>
<td>Shows the Query Items that were defined on the previous windows, including the database items and calculations and any associated functions assigned to the items, and the database table from which the database items and calculations are to be retrieved.</td>
</tr>
<tr>
<td><strong>Operand1 box</strong></td>
<td>Lists the database items and calculations that can be used in the <strong>WHERE</strong> clause.</td>
</tr>
<tr>
<td><strong>Operator box</strong></td>
<td>Lists the standard mathematical operations that can be used in the <strong>WHERE</strong> clause.</td>
</tr>
<tr>
<td><strong>Operand2 box</strong></td>
<td>Lists the database items and calculations that can be used in the <strong>WHERE</strong> clause.</td>
</tr>
<tr>
<td><strong>WHERE box</strong></td>
<td>Shows the current <strong>WHERE</strong> clause.</td>
</tr>
</tbody>
</table>
7. In the Operand1 box, highlight the first database item or calculation which you want considered in the WHERE clause.

8. In the Operator box, highlight the appropriate database operation.

9. In the Operand2 box, highlight the second database item or calculation which you want considered in the WHERE clause.

   For example, if you wanted the report to select the data from the table when the number of ACDCALLS is greater than the number of ACWINCALLS, then you would select ACDCALLS in the Operand1 box, the > sign in the Operator box, and ACWINCALLS in the Operand2 box.

10. Select the AND or the OR button, as appropriate.

   If you place “and” between clauses, then both of the clauses must be true in order for CMS to retrieve the SELECT data from the table.

   If you place “or” between clauses, then either of the clauses can be true in order for CMS to retrieve the SELECT data from the table.

11. Repeat Steps 7 through 10 until you have completed the query.

   You can add your own text in the WHERE clause (such as parenthesis and numbers) by placing your cursor where you would like the text to appear and then typing in the text.

12. Select the Test button.

   CMS checks the syntax of the query and returns a message with any errors.

13. Correct any of the errors detected in the Test.

14. Select the Save button.

15. The changes to the query are saved and the Query Select window displays.

<table>
<thead>
<tr>
<th>Item</th>
<th>Purpose</th>
</tr>
</thead>
<tbody>
<tr>
<td>AND button</td>
<td>Places an AND before the currently selected Operand1, Operator, and Operand2.</td>
</tr>
<tr>
<td>OR button</td>
<td>Places an OR before the currently selected Operand1, Operator, and Operand2.</td>
</tr>
<tr>
<td>New Input</td>
<td>Takes you to the Edit Inputs window, where you can add new input fields for the Report Input window.</td>
</tr>
<tr>
<td>Test button</td>
<td>Allows you to test the query for basic SQL syntax errors.</td>
</tr>
</tbody>
</table>
Editing an Existing Integrated Query

To edit an existing integrated query used in a Designer Report, complete the following steps from the Report Designer Design Mode window:

1. Select **Query** from the **Edit** menu.

   The Query Select window appears:

   ![Query Select Window](image)

2. In the **Queries** box, highlight the name of the integrated query you would like to edit.

3. Select the **Edit** button.

   The Query Assistant “Add the database items and calculations for the SELECT portion of the query” window appears. On this window, you will add and remove database items and calculations that will be included in the query.
4. In either the **Database Items** or **Calculations** box, highlight the first database item or calculation that you will reference in the query.

5. Select the **Add** button or double click on the item.

   The item is listed in the **Query Items** box.

6. Repeat Steps 4 and 5 until all of the database items and calculations that you believe will be referenced in the query are listed in the **Query Items** box.

7. Select the **Next** button.
The Query Assistant “Enter the start time for this integrated query” window appears:

8. Select the **Input Start Time** or **Select Start Time Now** radio button.

If you select the **Select Start Time Now** radio button, you need to define the time that the integrated data will always begin accumulating for this report.

If you select the **Input Start Time**, a “Start Time” field will be added to the report input window and users can individually define the time that data will begin accumulating for the report.

9. Select the **Next** button.
The Query Assistant “Select the input used to indicate the xxx for this query” window appears:

On this window, you can choose the input item that will be used for the query.

10. Highlight the input(s) you would like to use as criteria for the query. You can create a new input by selecting the **New Input** button, which takes you to the **Edit Inputs** assistant.

Only the inputs that apply to the table you selected for this query will appear.

11. Select the **Save** button.
Copying a Query

To copy an existing query, complete the following steps from the Report Designer Design Mode:

1. Select **Query** from the **Edit** menu.

   The Query Select window appears:

   ![Query Select Window]

   - In the **Queries** box, highlight the name of the query you would like to copy.

2. Select the **Copy** button.

   The Copy Query window appears:

   ![Copy Query Window]

   - In the **To** text box, type the name you would like to assign to the copied query.

3. Select the **OK** button.

   The query is copied to the new name and the Query Select window appears, including the new query in the **Queries** list.
Deleting a Query

To delete an existing query, complete the following steps from the Report Designer Design Mode:

If you delete a query that is used in the report, the report will not run.

1. Select **Query** from the **Edit** menu.

   The Query Select window appears:

   ![Query Select Window](image)

2. In the **Queries** box, highlight the name of the query you would like to delete.

3. Select the **Delete** button.

   A message confirming the delete displays.

4. Select **OK** to delete the query.
Once you have defined queries (see Chapter 7, “Edit | Queries”) to be used for a report, you can use those queries to add a chart to your report using the Chart Assistant, which is accessed by selecting Chart from the Insert menu.

This chapter includes the following sections:

- Inserting a chart on the report
- Using the Chart Assistant “Select the query and data items you wish to plot on the chart” window (Steps 2 through 4)
- Using the Chart Assistant “Specify a chart type” window (Steps 5 through 9)
- Using the Chart Assistant “Make category and series selections” window (Steps 10 - 15).

There are two things to keep in mind when inserting charts onto the report:

- When you insert a chart on a report, the chart is shown with sample data to help you visualize how the chart will appear when you run the report.
- Each item is initially inserted in the upper left hand corner of the report. You will need to drag-and-drop the chart to the location where you would like it to display on the report.

If you would like to edit a chart, select the chart and then choose Chart from the Format menu.
Inserting a Chart on a Report

If the report includes both a chart and a grid, you need to place the chart above the grid on the report. The reason for this is that, if the grid spans multiple pages when printed and the chart is below the grid on the report, then the grid will print on top of the chart.

Do not position any fields or text on top of the chart because the chart will display on top of the field or text and the field or text will not be visible.

To insert a chart in your report, complete the following steps:

1. Select Chart from the Insert menu.

   The first window of the Chart Assistant displays:

   2. From the Queries drop-down list, select the query from which you want to take data for the chart. Note that any queries that have been created, but still include errors are grayed-out.

      The Available Data box is populated with the data that was previously defined for the query.

   3. Use the Add, Add All, Remove, and Remove All buttons to add and remove items from the Available Data box to the Data on Chart box.

      Use the Move Up and Move Down buttons to arrange the items in the order in which you would like them displayed on the chart.

      Items that are added to the Data on Chart box will be shown in the chart you are creating.

      The maximum number of columns that can be included on a chart is 16.
If you are creating a chart that will use categories and series as controls on the axis, you need to verify that the first item listed on the Data on Chart box is the item that you want to use as the series for the chart.

4. Select the Next button.

The “Specify a chart type” window of the Chart Assistant appears:

Any of the options you select in the following steps can be changed at any time after you insert the chart on the report by selecting the Format | Chart menu item.

5. Select the 2D radio button if you would like the chart to display in two dimensional format.

Select the 3D radio button if you would like the chart to display in three dimensional format.

6. Select which type of chart you would like to display from the Chart Types box. If you are not sure what each type of chart will look like, you can highlight the type and an example of the chart displays on the right-hand side of the window.

7. Select the Stacked, % Axis, and Gradient check boxes, as appropriate. Note that you must select Stacked if you want to select % Axis.

Stacked - Causes the data for all series to be stacked rather than shown separately. This check box is disabled for pie charts.
% Axis - Causes the value axis (y-axis) to be displayed as percentages rather than as actual data values. This can be combined with the stacked check box to produce a percentage stacked chart.

Gradient - Allows you to specify whether the backdrop of the chart is a solid color or whether it is displayed as a gradient, a smooth transition from one color to another. The gradient transition can be one of the following: Horizontal, Vertical, Rectangle, or Oval. The quality of the gradient effect will vary depending on the video card installed in the PC, or the capabilities of the printer for printed reports.

8. Select the Rolling check box if you want the real-time chart report to scroll through the refreshes as they occur. If you select the Rolling check box, you need to define the Number of Data Points (refreshes) that will be included on the chart.

9. Select the Next button.

The “Make category and series selections” window appears:

This window is where you define how the data will be displayed on the axis of the chart

There are three columns used to define the category and series for the chart. The information gathered by each column is as follows:

- Column 1 — Category (can be “none”)
- Column 2 — Series (usually Split)
- Column 3 — Data.
In the following example, the Category (Column 1) is the Time that was selected on the input window, the Series are the Splits that were selected on the input window, and the Data is the data that was retrieved from the CentreVu® Call Management System (CMS) database for those splits/skills on the specified date for the specified time period.

10. In the Category **Available Data** box, select the database item that you would like to use as the category for the chart. The Category is usually “none” for real-time charts, or a time database item for historical charts. As you select from the list of available items, the currently selected item moves to the top of the Available Data list and the example on the right side of the window reflects what the chart might look like with that item selected as the chart Category.

11. Select the **Show Value as Name** check box if you would like to show the selected category as a Dictionary name. Note that this check box is only available when the selected category is an item that can be defined in the Dictionary.

12. Select the **Format** in which the category will display. Use the drop-down list to select for the applicable formats for the selected category. If you would like to view all of the available formats for all types of data, select the **Show All Formats** check box.
13. Select the **One Data Value per Row** check box to show one line of data when multiple rows of data are retrieved in the query. When **One Data Value per Row** is selected, the first item listed in the **Category Available** Items box is the item that is used for the chart category.

The previous example showed a report with **One Data Value per Row** selected. Below is an example of the same report, using the same Category item (STARTTIME), without **One Data Value per Row** selected.

In the first example, you can see that the report shows one “row” of data for the interval beginning at 10:00 AM, one “row” of data that includes information for each split/skill for the interval beginning at 10:30 AM, and one “row” of data for the interval beginning at 11:00 AM. In the second example, There is a “row” of data shown for each split/skill for each interval.

14. Select the **Done** button.
The time or date when a report is run is not stored in any database table. The Call Management System (CMS), if requested, displays information from the start time specified by the user (for integrated and historical data). Similarly, CMS knows what the currently selected ACD is when you run a report and can display the current ACD name or number on the report.

The Field Assistant (accessed by selecting Field from the Insert menu) allows you to insert fields in a Designer Report to display the report’s run-time, run-date, current ACD, data, and/or any of the fields that were required in the report input window.

See the following sections for instructions on adding any of the available types of fields to the report.

- Using the Field Assistant “Select a field type” window
- Inserting an ACD field on the report
- Inserting a Data Item field on the report, including Using the Field Assistant “Select a query and associated data item for this field” window
- Inserting an Input Value field on the report, including using the Field Assistant “Select an input for your field” window.
- Inserting a Start Time field on the report
- Inserting a Time Report Run field on the report.

Each item is initially inserted in the upper left hand corner of the report. You will need to drag-and-drop the field to the location where you would like it to display on the report.

If you would like to edit a field, select the field and then choose Field from the Format menu.
Using the Field Assistant “Select a field type” Window

To use this window, complete the following steps:

1. Select **Field** from the **Insert** menu.

   The Field Assistant “Select a field type” window appears:

   ![Field Assistant Window](image)

2. Select an item from the **Types** list. Note that the Report Data Start Time type is available only with an Integrated Report.


   If you highlighted **Data Item**, then select the **Next** button. Go to the Field Assistant “Select a query and associated data item for this field” window, which appears when you select Data Item from the Types list.

   If you highlighted **Input Value**, then select the **Next** button. Go to the Field Assistant “Select an input for your field” window, which appears when you select a Input Value from the Types list.

4. Select the **Done** button.

   The field is inserted in the upper left-hand corner of the report.
Inserting an ACD Name Field on the Report

Do not position the field on top of any grids or charts because the grid/chart will display on top of the field and the field will not be visible.

To insert the name of the ACD for which the report was run, complete the following steps:

1. Select **Field** from the **Insert** menu.
   
   The Field Assistant wizard opens.

2. Highlight **ACD Name** in the **Types** box.

3. Select the **Done** button.
   
   The ACD name field is placed in the upper left-hand corner of the report.

4. Click on the item and drag-and-drop it to the location at which you would like it displayed in the report.
Inserting Data Item Fields on the Report

Do not position the field on top of any grids or charts because the grid/chart will display on top of the field and the field will not be visible.

Before you can insert a data item on a report, the data item must be used in a query that is associated with this report.

To insert data item fields on the report, complete the following steps:

1. Select **Field** from the **Insert** menu.
   
The Field Assistant wizard opens.

2. Highlight **Data Items** in the **Types** box.

3. Select the **Next** button.
   
The “Select a query and associated data item for this field” window appears.

4. Highlight the name of the query from which you would like to select the data item.
   
The available data items for the selected query display in the **Available Data** box.

5. Highlight the data item that you want to display on the report.

6. Select the **Done** button.
   
The Data Item field is placed in the upper left-hand corner of the report.

7. Click on the item and drag-and-drop it to the location at which you would like it displayed in the report.
Inserting Input Value Fields on the Report

Do not position the field on top of any grids or charts because the grid/chart will display on top of the field and the field will not be visible.

To insert input value fields on the report, complete the following steps:

1. Select Field from the Insert menu.
   The Field Assistant wizard opens.
2. Highlight Input Value in the Types box.
3. Select the Next button.
   The “Select an input for your field” window appears.
4. Highlight the name of the input that you would like to show on the report, or create a new input by selecting the New Input button. The Edit Inputs wizard opens. For information on creating inputs for a report, see Chapter 6, “Edit | Inputs,” in this document.
5. Select the Done button.
   The Input Value field is placed in the upper left-hand corner of the report.
6. Click on the item and drag-and-drop it to the location where you would like it displayed in the report.
Inserting Report Data Start Time Field on the Report

Do not position the field on top of any grids or charts because the grid/chart will display on top of the field and the field will not be visible.

This type of field applies only to integrated reports.

To insert the initial start time (the time at which data began accumulating) for an integrated report, complete the following steps:

1. Select Field from the Insert menu.
   The Field Assistant wizard opens.

2. Highlight Report Data Start Time in the Types box.

3. Select the Done button.
   The Report Data Start Time field is placed in the upper left-hand corner of the report.

4. Click on the item and drag-and-drop it to the location where you would like it displayed in the report.
Inserting Time Report Run Field on the Report

Do not position the field on top of any grids or charts because the grid/chart will display on top of the field and the field will not be visible.

To insert on the report the time at which the report was run, complete the following steps:

1. Select **Field** from the **Insert** menu.
   
The Field Assistant wizard opens.

2. Highlight **Time Report Run** in the **Types** box.

3. Select the **Done** button.
   
The Time Report Run field is placed in the upper left-hand corner of the report.

4. Click on the item and drag-and-drop it to the location where you would like it displayed in the report.
10 Insert | Table
Introduction

Once you have defined queries (see Chapter 7, “Edit | Queries”) to be used for a report, you can use those queries to add a table to the report using the Table Assistant, which is accessed by selecting Table from the Insert menu.

This chapter teaches you to use the Insert | Table menu option. The sections of the chapter are as follows:

- Inserting a table on the report
- Using the Table Assistant “Select a query and associated database items for the table” window (Steps 2 through 4)
- Using the Table Assistant “Select a table layout” window (Steps 5 through 9)
- Using the Table Assistant “Select an existing query for the Summary line on your table, or create a new one” window (Steps 10 through 11).

Each item is initially inserted in the upper left hand corner of the report. You will need to drag-and-drop the table to the location where you would like it to display on the report.

If you would like to edit a table, select the table and then choose Table from the Format menu.
Inserting a Table on the Report

If the report includes both a chart and a table, you need to place the chart above the table on the report. The reason for this is, if the table spans multiple pages when printed and the chart is below the table on the report, then the table will print on top of the chart.

Do not position text and fields on top of the table because the table will display on top of the text/field and the text/field will not be visible.

To insert a table on a report, complete these steps:

1. Select **Table** from the **Insert** menu.

   The “Select a query and associated database items for the table” window of the Table Assistant appears:

2. From the **Queries** drop-down list, select the query from which you want to take data for the table. Note that any queries that have been created, but still include errors are greyed-out.

   The **Available Data** box is populated with the data that was previously defined for the query.

3. Use the **Add**, **Add All**, **Remove**, and **Remove All** buttons to add and remove items from the **Available Data** box to the **Data on Table** box.

   Use the **Move Up** and **Move Down** buttons to place the data items shown in the **Data on Table** box in the order in which you want them to appear on the table.

   Items that are added to the Data on Table box will be shown in the table you are creating.
4. Select the **Next** button.

The “Select a table layout” window appears.

![Table Assistant](image)

**NOTE:**

Any of the options you select in Steps 5 through 10 can be changed after you have inserted the table on the report by selecting the **Format | Table** menu item.

5. Define the **Orientation** of the table by selecting either the **Horizontal** or the **Vertical** radio button.

6. Add a **Summary** line to the table by selecting the **Top** radio button to place the Totals line at the top of the table (as standard CMS reports do) or the **Bottom** radio button to place the Totals line at the bottom of the table. Select the **None** radio button if you do not want to include a Totals line on this table.

7. Select the **Headers On** check box if you would like to include column headers on the table.

8. Select the **Grid Lines On** check box if you would like the table to include lines between the columns and rows.

9. If you elected to include no Summary line on the table, select the **Done** button. The Table Assistant closes and the table is placed on the report template.

   If you elected to include a Summary line on the table, select the **Next** button.
The “Select an existing query for the Summary line on your table, or create a new one” window appears.

10. If you would like to create a new query for the summary line on this table, complete the following steps:
   
a. Select the **Build a New Query** radio button.
   
b. Type a name for the summary query in the **Name** field.
   
c. Edit the table to include the database items and summary information that you feel is appropriate for this summary query.
   
d. Select the **Done** button.

If you would like to use an existing query for the summary line on this table, complete the following steps:

a. Select the **Select an Existing Query** radio button.

   The “Select an Existing query for the Summary line on your table, or create a new one” window for the existing query selection appears.
b. Select the name of one of the existing queries from the drop-down **Queries** list.

11. Select the **Done** button.
11 Insert | Text

Introduction

The Report Designer allows you to include text strings (with no associated data) on your report. You will use the Text option from the Insert menu to add items such as the report name to your designer reports.

This chapter teaches you how to use the Insert | Text menu option.

Each item is initially inserted in the upper left hand corner of the report. You will need to drag-and-drop the text to the location where you would like it to display on the report.

If you would like to edit text, select the text and then choose Text from the Format menu.
Inserting Text on the Report

Do not position the text on top of any tables or charts because the table/chart will display on top of the text and the text will not be visible.

To insert a text string on a report, complete these steps:

1. Select **Text** from the **Insert** menu.

   The Text Assistant appears:

   ![Text Assistant](image)

2. Type the text that you want to appear on the report in the **Text contents** field.

3. If you want to select a specific font for the text, select the **Font** button.

   If you want to leave the font set to the default, go to Step 6.

   The Font selector window, which is a standard Windows® window, displays.

4. Select the **Font**, **Style**, **Point size**, **Effects**, and **Script** that will apply to the text string you are creating.

5. Select the **OK** button.

   The Font selector window closes.

6. On the Text Assistant window, select the **OK** button to insert the text string and close the window, or select the **Apply** button to apply the changes you have made and keep the window open.

   The text is inserted, by default, in the upper lefthand corner of the Design Mode window. You can use the cut, copy, or drag-and-drop method, as outlined in Chapter 4, to move the text to the appropriate location on the report.

---

*Windows is a registered trademark of Microsoft Corp.*
12 Format | Chart

Introduction

The Report Designer allows you to format report charts after they have been inserted on the report. You will use the Chart option from the Format menu to edit charts on your designer reports.

This chapter teaches you to use the Format | Chart menu option. The sections of this chapter are as follows:

Formatting a Chart in a Report

- General Tab
- Axis Tab
- Data Tab
- Data Labels Tab
- Fonts Tab
- Series Labels Tab
- Legend Tab
- Title Tab
- Type Tab
- 3D Effects Tab.
Formatting a Chart in a Report

The changes you make to a report’s format affect only your view of the report. The changes do not affect how other CMS users see the report unless you are in Design Mode.

Selecting Chart from the Format menu opens the Chart Format Options window. The Chart Format Options window gives you access to the General, Axis, Data, Data Labels, Fonts, Series Labels, Legend, Title, Type, and 3D Effects tabs for formatting charts on reports.

Charts provide a graphical representation of data. Values or data points are displayed in formats such as bars, lines, filled areas, and pie charts. These data points are grouped into series that are identified with unique colors. In many chart types, one data point from each series is grouped together by category across an axis. A chart can also have a title and a legend. Categories are plotted along the x-axis, values are plotted along the y-axis. A two-dimensional chart shows series next to each other, while a three-dimensional chart plots series along the z-axis.

If the report you are designing includes a chart, you can format how the chart is displayed and what is displayed on the chart. The formatting is done in the Chart Format Options window, which is accessed by doing the following:

- Double-clicking on a chart in the report,
- Selecting Chart from the Format menu, or
- Selecting Format Chart from the right mouse button pop-up menu.

The following sections describe each of the tabs.
General Tab

The General tab allows you to specify several general options that apply to the chart.

The following chart parameters can be changed:

- **Background Color** — You can specify whether the backdrop of the chart is a solid color or whether it is displayed as a gradient, a smooth transition from one color to another. The gradient transition can be one of the following: Horizontal, Vertical, Rectangle, or Oval. The quality of the gradient effect will vary depending on the video card installed in the PC, or the capabilities of the printer for printed reports.

- **Options** — Select the check boxes, as appropriate, to include or omit grid lines, chart borders, and legend borders on the report.

- **Real-Time** — If the chart is part of a real-time report and is a rolling chart, you can specify the number of data points to be displayed in the chart. Permitted values are 2 through 100, with 10 being the default. A rolling chart is a line chart that is initially displayed with no data points. For each refresh of the report, a data point is added. As data points are added, the chart “rolls” from left to right. When enough refreshes have occurred that the chart is displaying the number of specified data points, at the next refresh, the oldest data point is dropped from the display and the newest data point is displayed.
Using the General Tab

To use the General tab, complete the following steps:

1. In the **Background Color** box, select the Report Background, Solid, or Gradient radio button.
   - If you select **Report Background**, the background of the report will default to the color you set on the Options Report Colors tab which is accessed from the Controller Tools menu.
   - If you select **Solid**, you can set the color of the report background by clicking on the square next to the Background Color option.
   - If you select **Gradient**, the report background will combine the two colors you select in the squares to the right of the Gradient Colors option.
     You can select the type of gradient that will be used from the drop-down list below the Gradient option. The available types are Horizontal, Vertical, Rectangle, and Oval.

2. In the **Options** box, select the check boxes, as appropriate.
   - Select **Grid Lines On** to include the lines between rows and columns on any grid that appears on the chart.
   - Select **Chart Border On** to include a border around the chart.
   - Select **Legend Border On** to include a border around the chart legend.

3. If the report you are designing is a real-time report, or if this is a real-time component of an integrated report, you can elect to make the chart a rolling chart. To do this, select the **Rolling Chart** check box and then define the Number of Data Points that you would like displayed on the chart. Permitted values for the number of data points are 2 through 100.

4. Select the **Apply** button to make the changes and to keep the Chart Format Options window open.

Select the **OK** button to make the changes and to close the Chart Format Options window.
Axis Tab

The Axis tab allows you to specify the title that will display on each axis of the chart report.

Axis Tab Options

The following chart parameters can be changed:

- **Axis Display** — makes each of the axes visible or invisible. The choices are **X Axis**, **Y Axis**, **2nd Y Axis**, and **Z Axis**.

  The 2nd Y Axis is available only for bar charts. Selecting this check box will display the y-axis information on the right-hand side of the bar chart (in contrast to the standard y-axis display on the left-hand side of the chart).

  The Z Axis is available only for 3D bar charts. Selecting this check box will make the chart display with a z-axis, making it appear 3-dimensional.

- **Category** — select the category (database item) that will be used as the x-axis on the chart. You can use the drop-down menu to select any of the database items you included in the query for this chart.

  - **Category for X-Axis**: (same as the Available Items box in the Insert Query Chart Assistant), select the database item that you would like to use as the category for the chart. The Category is usually “none” for real-time charts, or a time database item for historical charts.

  - **Show Value as Name**: shows the selected category as a Dictionary name.
— **Format:** use the drop-down list to select the applicable formats for the selected category. If you would like to view all of the available formats for all types of data, select the **Show All Formats** check box.

There are three columns used to define the category and series for the chart. The information gathered by each column is as follows:

- **Column 1 — Category** (can be “none”)
- **Column 2 — Series** (usually Split)
- **Column 3 — Data.**

In the following example, the Category (Column 1) is the Time that was selected on the input window, the Series are the Splits that were selected on the input window, and the Data is the data that was retrieved from the *CentreVu*® CMS database for those splits/skills on the specified date for the specified time period. Also, the “Show Value as Name” field was not checked.

- **One data value per row** — shows one line of data when multiple rows of data are retrieved in the query. When One Data Value per Row is selected, the first item listed in the Category for X-Axis drop-down list is the item that is used for the chart category.
The previous example showed a report with One Data Value per Row selected. Following is an example of the same report, using the same Category item (STARTTIME), without One Data Value per Row selected.

In the first example, you can see that the report shows one “row” of data for the interval beginning at 10:00 AM, one “row” of data that includes information for each split/skill for the interval beginning at 10:30 AM, and one “row” of data for the interval beginning at 11:00 AM. In the second example, there is a “row” of data shown for each split/skill for each interval.

Using the Axis Tab

To use the Axis tab, complete the following steps:

1. Depending on the type of chart (bar, line, area, step, clustered bar, horizontal bar, or pie, as selected on the Type tab) you are formatting, select the appropriate Axis check box.

2. Type the Title you would like assigned to the axis in the appropriate text box.

3. In the Category for X-Axis box (same as the Available Items box in the Insert Query Chart Assistant), select the database item that you would like to use as the category for the chart. The Category is usually “none” for real-time charts, or a time database item for historical charts.
4. Select the **Show Value as Name** check box if you would like to show the selected category as a Dictionary name. Note that this check box is available only when the selected category is an item that can be defined in the Dictionary.

5. Select the **Format** in which the category will display. Use the drop-down list to select for the applicable formats for the selected category. If you would like to view all of the available formats for all types of data, select the **Show All Formats** check box.

6. Select the **One Data Value per Row** check box to show one line of data when multiple rows of data are retrieved in the query. When One Data Value per Row is selected, the first item listed in the Category for X-Axis drop-down list is the item that is used for the chart category.

7. Select the **Apply** button to make the changes and to keep the Chart Format Options window open.

Select the **OK** button to make the changes and to close the Chart Format Options window.
The Data tab lets you add and remove data items to be used in the chart. The available data items are the data items that are specified in the query that this chart uses.

The following chart parameters can be changed:

- **Available Data** — Lists all of the data items that are available, based on the query that is being used, for the chart or table.

- **Data on Chart** — Displays the data items that are currently used in the chart.

To use the Data tab window, complete these steps:

1. To add data items to the chart, select an item from the Available Data list and click the Add button.

2. To remove data items from the chart, select an item from the Data on Chart list and click the Delete button.
3. To rearrange the order in which items appear on the chart, select an item on the **Data on Chart** list and use the **Up** and **Down** buttons to move the item to the appropriate place on the list.

4. Select the **Apply** button to make the changes and to keep the Chart Format Options window open.

Select the **OK** button to make the changes and to close the Chart Format Options window.
Data Labels Tab

The Data Labels tab allows you to define where the labels of each data point on the chart will appear and to define how the labels will be displayed.

Data Labels Tab Options

The following parameters can be specified:

- **None** — No labels displayed.
- **Above Point** — The label is displayed above the data point. This location is valid only for bar, line, area, and step charts.
- **Below Point** — The label is displayed below the data point. This location is valid only for bar, line, area, and step charts.
- **Center** — The label is displayed centered on the data point. This location is valid only for bar, line, area, and step charts.
- **Base** — The label is displayed along the category axis, directly beneath the data point. This location is valid only for bar, line, area, and step charts.
- **Inside** — The label is displayed inside a pie slice. This location is valid only for pie charts.
- **Outside** — The label is displayed outside a pie slice. This location is valid only for pie charts.
- **Left** — The label is displayed to the left of the related data point.
- **Right** — The label is displayed to the right of the related data point.
If data point labels are displayed, you can specify that they include one of the following:

- **Value** — The value of the data point appears in the label.
- **Percent** — The value of the data point appears in the label as a percentage.
- **Series Name** — The series name is used to label the data point.
- **Category Name** — The category name is used to label the data point.

The position of data point labels can affect the readability of the chart. The label text may overlap in some situations, making it difficult or impossible to read the labels.

### Using the Data Labels Tab

To use the Data Labels tab, complete the following steps:

1. In the **Location** box, select the radio button next to the option (None, Above Point, Below Point, Center, Base, Inside, Outside, Left, Right) that corresponds with the location where you would like the data point labels to display on the chart.

2. In the **Show Label Text** box, select the radio button next to the option (Value, Percent, Series Name, Category Name) that corresponds with how you would like the data point labels to display on the chart.

3. Select the **Apply** button to make the changes and to keep the Chart Format Options window open.

Select the **OK** button to make the changes and to close the Chart Format Options window.
Fonts Tab

The Chart Format Options Fonts tab allows you to edit the fonts of the title, data point labels, legend, axes and series labels on the chart report.

Fonts Tab Options

- **Fonts** — Lists all of the available report items for which you can edit the fonts.
- **Choose Font** — takes you to the Font selector window, where you can edit the font size and style for each type of text.

Using the Fonts Tab

To change the fonts, complete the following steps:

1. Select the **Choose font** button next to the report item for which you would like to change the font.
2. The **Font** window, which is a standard *Windows* window, displays.
3. Select the **Font, Font style, Size, Effects, Color, and Script** which you want assigned to the selected text.

*Windows is a registered trademark of Microsoft Corp.*
4. Select the **OK** button.

5. The Chart Format Options window displays.

6. Select the **Apply** button to make the changes and to keep the Chart Format Options window open.

Select the **OK** button to make the changes and to close the Chart Format Options window.
Legend Tab

The Legend tab allows you to control the location of the chart legend.

Legend Tab Options

The available options on the Legend tab are as follows:

- **Visible** check box — allows you to display or not to display the report legends.

- **Location** of legend — if you elect to have report legends visible, you can select where the legend displays. The available options are Top left, Top (center), Top right, Left, Right, Bottom left, Bottom (center), and Bottom right.

Since legends take up space, the drawn chart will be smaller if you have selected Visible. To increase the size of the chart, do not select the Visible option or maximize the report window.
## Using the Legend Tab

To use the Legend tab, complete the following steps:

1. Select the **Visible** check box to make the legend of the chart appear on the report.

2. Select the **Location** (Top Left, Top, Top Right, Left, Right, Bottom Left, Bottom, or Bottom Right) where you would like the legend to appear on the chart.

3. Select the **Apply** button to make the changes and to keep the Chart Format Options window open.

Select the **OK** button to make the changes and to close the Chart Format Options window.
Series Labels Tab

The Chart Format Options Series Labels tab is where you can edit the labels (headings) that are assigned to each data item that is used in a chart.

### Series Labels Tab Option

**Labels table** — Shows the labels that are currently used in the chart. To edit the text, place the cursor in the Label column and type the appropriate information.

### Using the Series Labels Tab

To use the Series Labels tab, complete the following steps:

1. Place the cursor in the table cell that contains the label (heading) you would like to modify.
2. Type the new name or edit the existing name.
3. Select the **Apply** button to make the changes and to keep the Chart Format Options window open.

Select the **OK** button to make the changes and to close the Chart Format Options window.
Title Tab

The Title tab allows you to control the location of the chart title.

Title Tab Options

The available options on the Title tab are as follows:

- **Visible** check box — allows you to display or not to display the report titles.
- **Location** of title — if you elect to have report titles visible, you can select where the titles display. The available options are Top left, Top (center), Top right, Left, Right, Bottom left, Bottom (center), and Bottom right.

Since the title takes up space, the drawn chart will be smaller if you have selected Visible. To increase the size of the chart, do not select the Visible option or maximize the report window.

Using the Title Tab

To use the Title tab, complete the following steps:

1. Select the **Visible** check box to make the title of the chart appear on the report.
2. In the **Title** text box, edit the content of the chart title.
3. Select the **Location** (Top Left, Top, Top Right, Left, Right, Bottom Left, Bottom, or Bottom Right) where you would like the title to appear on the chart.

4. Select the **Apply** button to make the changes and to keep the Chart Format Options window open.

Select the **OK** button to make the changes and to close the Chart Format Options window.
Type Tab

The Type tab lets you change the chart type.

Type Tab Options

The available options on the Type tab are as follows:

- **2D and 3D** — Changes the chart between 2-dimensional and 3-dimensional views. 2D charts update faster than 3D charts, so if the drawing speed seems too slow, you may want to display charts as 2D.

- **Chart Type** — Specifies how the data is presented. You choose a chart type from the list. The types of charts available vary slightly depending on whether a 2D or 3D chart has been selected. All possible chart types are listed here:
  - Bar Chart (2D and 3D)
  - Line Chart (2D and 3D)
  - Area Chart (2D and 3D)
  - Step Chart (2D and 3D)
  - Horizontal Bar Chart (2D and 3D)
  - Clustered Bar Chart (3D only)
  - Pie Chart (2D and 3D).

- **Stacked** check box — Causes the data for all series to be stacked rather than shown separately. This check box is disabled for pie charts.
% Axis check box — causes the value axis (y-axis) to be displayed as percentages rather than as actual data values. This can be combined with the stacked check box to produce a percentage stacked chart.

### Using the Type Tab

To use the Type tab, complete the following steps:

1. Select the 2D or 3D radio button, based on whether you would like the report to display two-dimensionally or three-dimensionally.

2. Select the Chart Type.
   - The available types for two-dimensional charts are Bar, Line, Area, Step, Horizontal Bar, and Pie.
   - The available types for three-dimensional charts are Bar, Line, Area, Step, Clustered Bar, Horizontal Bar, and Pie.

3. For any type of report, other than Pie, you can select the Stacked check box to display all series together rather than separately.
   - If you select the Stacked check box, you can also select the % Axis check box, which causes the y-axis to be displayed as percentages rather than as data values.

4. Select the Apply button to make the changes and to keep the Chart Format Options window open.
   - Select the OK button to make the changes and to close the Chart Format Options window.
The 3D Effects tab allows you to control the 3D appearance of the chart. If the current chart is a 2D chart, this tab is disabled.

The following parameters can be changed:

- **Elevation** — This is a number from 0 through 90 degrees, and describes the relative height from which a chart is viewed. An elevation of 90 looks directly down on the top of the chart, while an elevation of 0 looks directly at the side of the chart. The example charts throughout this document use an elevation of 30 degrees.

- **Rotation** — This is a number from -360 through 360 degrees, and specifies the angle that the chart is turned relative to the viewing position. The example charts throughout this document use a rotation of 60 degrees. Rotation does not apply to 3D pie charts.
• **Projection** — This selects one of three mathematical algorithms used to give a 3D appearance on a 2D sheet of paper or computer screen. The following values can be chosen:

  — **Oblique**: The chart has depth but the X-Y plane does not change when the chart is rotated or elevated.

  ![Oblique Projection Example](image)

  — **Orthogonal**: Perspective is not applied to the chart, resulting in less of a 3D effect. The advantage of using this type of projection is that vertical lines remain vertical, making some charts easier to read.

  ![Orthogonal Projection Example](image)

  — **Perspective**: This provides the most realistic 3D appearance. Objects farther away from you converge toward a vanishing point.

  ![Perspective Projection Example](image)

• **Viewing Distance** — This is a number from 50 through 1000 that represents the distance from which the chart is viewed as a percentage of the depth of the chart.
Using the 3D Effects Tab

To use the 3D Effects tab, complete the following steps:

1. Change the degree of **Elevation** (top to bottom) of the chart by typing a new number in the Elevation box.

2. Change the degree of **Rotation** of the chart by typing a new number in the Rotation box.

3. Change the type of **Projection** used for the chart by selecting a type from the Projection drop-down list.

4. Edit the ratios of width to height and depth to height, as appropriate.

5. Select the **Apply** button to make the changes and to keep the Chart Format Options window open.

Select the **OK** button to make the changes and to close the Chart Format Options window.

- **Width to Height** — This is a number from 5 through 2000 that represents the percentage of the chart’s height that is used to draw the chart’s width.

- **Depth to Height** — This is a number from 5 through 2000 that represents the percentage of the chart’s height that is used to draw the chart’s depth.
13 Format | Table

Introduction

The Report Designer allows you to format report tables after they have been inserted on the report. You will use the **Table** option from the **Format** menu to edit tables on your designer reports.

This chapter teaches you to use the **Format | Table** menu option. The sections of this chapter are as follows:

- Formatting a Table in a Report
- General Tab
- Data Tab
- Fonts Tab
- Format Tab
- Headers Tab
- Sort Tab
- Summary Tab.

If this table includes an integrated query, then the Summary tab will not display.
Formatting a Table in a Report

The changes you make to a report’s format affect only your view of the report. The changes do not affect how other Supervisor users see the report.

If you are in a report containing a table (table), you can format how the table is displayed and what is displayed on the table. The formatting is done in the Table Format Options window, which is accessed by doing the following:

- Double-clicking on a column heading in the report, or
- Selecting **Format Table** or **Sort by** from the **Format** menu list or the right mouse button pop-up menu.
  - If you select **Format Table**, the Table Format Options window displays with the General tab active.
  - If you select **Sort by**, the Table Format Options window displays with the Sort tab active.

The Table Format Options window allows you to make layout changes to a table. All changes made are saved as part of the report view when you save the report.

The following sections describe the Table Format Options tabs.
General Tab

The General tab allows you to make format changes to a table.

The following table parameters can be changed:

- **Show Gridlines** — This specifies whether grid lines are to be shown in the table.
- **Fixed Columns** — This specifies the number of columns from the left of the table that are fixed in place and do not scroll. Valid values are in the range of 0 through 99. You can use the spin boxes to select a valid value or type the value in.
- **Fixed Rows** — This specifies the number of rows from the top of the table that are fixed in place and do not scroll. Valid values are in the range of 0 through 99. You can use the spin boxes to select a valid value or type the value in.
- **Orientation** — Horizontal builds the table with the column names across the top of the table, so that the table reads left to right. Vertical builds the table with the column names down the left-hand side of the table, so that the table reads top to bottom.
Using the General Tab

To use the General tab, complete the following steps:

1. Select the **Show Gridlines** check box if you want the table to include lines between the columns and rows.

2. In the **Fixed Region** box, define the number of Columns on the table that will not scroll. You can type the appropriate number or use the up and down arrows to select a valid number.

3. In the **Fixed Region** box, define the number of Rows on the table that will not scroll. You can type the appropriate number or use the up and down arrows to select a valid number.

4. In the **Orientation** box, select the Horizontal radio button if you would like the table to display with the column names across the top of the table. Select the Vertical radio button if you would like the table to display with the column names down the left-hand side of the table.

5. Select the **Apply** button to make the changes and to keep the Table Format Options window open.

Select the **OK** button to make the changes and to close the Table Format Options window.
Data Tab

Use the Table Format Data tab to add data items to, remove data items from, and to reorganize the order of data items on the currently selected table.

Data Tab Options

- **Available Data** — Lists all of the data items that are available, based on the query that is being used, for the chart or table.

- **Data on Table** — Displays the data items that are currently used in the table.

Using the Data Tab

To use the Data tab window, complete these steps:

1. To add data items to the table, select an item from the **Available Data** list and click the Add button.

2. To remove data items from the table, select an item from the **Data on Table** list and click the Delete button.

3. To rearrange the order in which items appear on the table, select an item on the **Data on Table** list and use the **Up** and **Down** buttons to move the item to the appropriate place on the list.

4. Select the **Apply** button to make the changes and to keep the Table Format Options window open.

Select the **OK** button to make the changes and to close the Table Format Options window.
Fonts Tab

The Table Format Options Fonts tab allows you to edit the fonts of the data, headers, and summary information on the table report.

Fonts Tab Options

- **Fonts** — Lists all of the available report items for which you can edit the fonts.
- **Choose Font** — Takes you to the Font selector window, where you can edit the font size and style for each type of text.
Using the Fonts Tab

To change the fonts, complete the following steps:

1. Select the Choose font button next to the report item for which you would like to change the font.

2. The Font window, which is a standard Windows* window, appears.

3. Select the Font, Font style, Size, Effects, Color, and Script which you want assigned to the selected text.

4. Select the OK button.

   The Table Format Options window appears.

5. Select the Apply button to make the changes and to keep the Table Format Options window open.

Select the OK button to make the changes and to close the Table Format Options window.

*Windows is a registered trademark of Microsoft Corp.
Format Tab

The Table Format tab allows you to alter the format of each column that is included in the table. The Database Items that make up the columns of the table are listed in the Item column of the Table table. For each Item, you can assign a variety of formatting characteristics.

Format Tab Options

- **Item** — Shows the database item (and table from which the data is retrieved) that is used for this column of the table.

- **Show Value As** — Use the drop-down list to select the format in which you would like the value to be displayed. The Show Value As formatting applies only to data types that can be defined in the Dictionary.

- **Align** — Allows you to select the alignment of a field or column in a table. Available options for alignment are Left, Right, and Center.

- **Format** — The options available for the format will depend on the type of item you are editing. For instance, a field that displays time will allow you to choose from a variety of time formats. A field that is a number will allow you to choose from a variety of number formats.

- **Show All Formats** — You can select the Show All Formats check box to display the formats that are available for all field types. Note that the selection of this check box is active only during the current use of the Format Table window. The next time you access the window, the check box will not be selected.
To use the Format tab, complete the following steps:

1. In the **Item** column of the table, select the data item for which you would like to edit the formatting on the table.

2. In the **Show Value As** column, use the drop-down list to select how you would like to have the data item displayed in the table. The available values will vary, depending on the data item.

3. In the **Align** column, use the drop-down list to select how you would like the data item to be aligned on the table. Available values are Left, Right, and Center.

4. In the **Format** column (if available), select the time format or the number format (as appropriate) in which you would like the data item displayed. The available choices reflect the specific data item you are formatting.

5. In the **Show All Formats** column, select the check box if you would like the Format column to display all of the available data formats, regardless of the type of data item that you are working with.

6. In the **Zeros as Blanks** column, select the check box if you would like to display cells on the table that contain zeros as blank. If you do not select the check box, the cells that contain zeros will display zeros.

7. In the **Merge with Next** column, select the check box to merge this column with the column to the right on the table.
 Headers Tab

The Headers tab allows you to turn table headers on and off and to edit the text that appears in each column heading of the table.

Headers Tab Options

- **Header Option** — Select the Show Headers check box if you would like the table report to include the headers.
- **Table Header** — This table shows the column headings that are currently used on the report.

Using the Headers Tab

To change the column headings on the table, complete these steps:

1. Place the cursor in the table cell that contains the heading you would like to modify.
2. Type the new name or edit the existing name.
3. Select the **Apply** button to make the changes and to keep the Table Format Options window open.

Select the **OK** button to make the changes and to close the Table Format Options window.
Sort Tab

The Sort tab allows you to specify the order in which the information on the real-time table report is displayed.

Sort Tab Options

- **Sort by** — When you are setting up display order for a real-time report, specify the sort column (Sort By) and the sort order (Ascending or Descending). The drop-down list for the Sort By lists all of the database table and item names used in the report.
Using the Sort Tab

When you are setting up display order for a report, specify the sort column (Sort By) and the sort order (Ascending or Descending). The drop-down list for the Sort By lists all of the database table and item names used in the report.

Some examples of sorting are as follows:

- Viewing a list of agents alphabetically — select “Name” from the first Sort By drop-down list, select Ascending as the sort order, and leave the other two Sort By boxes set to “(none)”.

- Searching for agents who have been in a certain state for too long — select “WORKMODE” from the first Sort By drop-down list, then select “TIME” from the second Sort By drop-down list, and then select Descending as the sort order for the second Sort By.

Sorting may cause the report to take longer to refresh. If you wish to speed up the refresh rate, turn off the sort options by selecting “(none)” for all of the Sort By criteria.
Summary Tab

Use the Table Format Summary tab to include or exclude summary lines from the currently select table. You can include a summary line for each query that is used in the report.

If this table includes an integrated query, then the Summary tab will not display.

Summary Tab Options

- **Summary Options** — Allows you to include or exclude summary (totals) lines on table reports.

Select the check box to include a summary line on the table, then select the query for which you would like to include a summary.
Using the Summary Tab

To include a summary line, complete the following steps:

1. Select the **Show Summary** check box.
2. Select a query from the **Query** box.
3. Select the **Top** or the **Bottom** radio button, based on where you would like the summary line to be located.
4. Select the **Apply** button to make the changes and to keep the Table Format Options window open.

Select the **OK** button to make the changes and to close the Table Format Options window.
14 Format | Field

Introduction

The Report Designer allows you to format report fields after they have been inserted on the report. You will use the Field option from the Format menu to edit fields on your designer reports.

This chapter teaches you how to use the Format | Field menu option. The sections of this chapter are as follows:

- Field Format Window Elements
- Using the Field Format Window.
Field Format Window Elements

Selecting Field from the Format menu opens the Field Format Options window. The Field Format Options window is where you will choose the formats for fields defined in queries.

The Field Format window includes the following options:

- **Field Label Location frame** — the Field Label Location frame provides the following options:
  - **Visible check box** — allows you to display or not display report legends.
  - **Location of legend** — if you elect to have report legends visible, you can select where the legend displays. The available options are Top left, Top (center), Top right, Left, Right, Bottom left, Bottom (center), and Bottom right.

- **Label box** — Type a brief description of the field. For instance, for a field that displays the name of the split/skill for which the report was run, you might label the field “Split/Skill.”

- **Font box** — Opens the Font window, which allows you to change the Font, Font style, Size, Effects, Color, or Script box; or the OK, Cancel, or Help button to access quick definitions of the window elements.

- **Field Content Format box** — Shows the query and the database item that this field is associated with.

- **Align box** — Allows you to select the alignment of a field or column in a table. Available options for alignment are Left, Right, and Center.
• **Format** — Use the drop-down list to select the format which you would like the value to be displayed.

• **Show Value as Name** — Shows the field as name.

• **Font box** — Opens the Font window, which allows you to change the Font, Font style, Size, Effects, Color, or Script box.

Under field content, Effects and Color are not available.
Using the Field Format Options Window

To format a field on your report, complete the following steps:

1. Select the field on the report.
2. Select **Field** from the **Format** menu.
   
The Field Format Options window appears. This window allows you to create a label (heading) for the field and to edit the format of the field itself.

3. To create or change a **label** (heading) for the field, complete the following steps in the Field Label box:
   
a. Select the **Visible** check box.

b. Select the **Location** (Above, Below, Left, or Right) where you would like the label to appear in relation to the field by selecting the appropriate radio button.

c. In the **Label** field, type the word(s) that you would like the label to display.

d. To change the font of the label, select the **Font** button to access the Font window.

4. To edit the format of the **field**, complete the following steps in the **Field Content** box:
   
a. Select the format in which the field will display from the **Format** drop-down list.
   
The options available for the field format will depend on the type of field you are editing. For instance, a field that displays time will allow you to choose from a variety of time formats. A field that is a number will allow you to choose from a variety of number formats.
   
   You can select the Show All Formats check box to display the formats that are available for all field types.

b. Select the alignment of the field from the **Align** drop-down list.
   
The options available for alignment are Left, Right, and Center.
c. Select the **Show Value as Name** check box if you are editing a field that displays a CMS entity (split/skill, agent, and so on) that can be named in the Dictionary and you would like the Dictionary name for the field to display instead of the number.

d. To change the font of the field, select the **Font** button to access the Font window.

5. Select **Apply** to make the changes but to keep the Field Format Options window open for additional changes.

Select **OK** to apply the font changes and to close the Field Format Options window.
<table>
<thead>
<tr>
<th>Format</th>
<th>Field</th>
</tr>
</thead>
</table>

*Using the Field Format Options Window*
15 Format | Text

Introduction

The Report Designer allows you to format the font style and size of text that appears on a report. You will use the Text option from the Format menu to edit text on a report.

This chapter teaches you to use the Format | Text menu option.
Text Format Options Window Elements

Selecting Text from the Format menu when a text item on the report is selected opens the Text Format Options window. The Text Format Options window allows you to change the font display characteristics for the selected text.

- **Text contents** — Type the word or phrase that you would like to insert on the report in this text box.

- **Text font** — Opens the Font window, which allows you to change the Font, Font style, Size, Effects, Color, or Script box; or the OK, Cancel, or Help button to access quick definitions of the window elements.
To format text on a report, complete these steps:

1. Select the text on the report.
2. Select **Text** from the **Format** menu.

The Insert Text window appears:

3. Select the **Font** button.

   The Font selector window, which is a standard *Windows* window, appears.

4. Select the **Font**, **Style**, **Point size**, **Effects**, and **Script** that will apply to the text string you are editing.

5. Select the **OK** button.

   The Font selector window closes.

6. On the Text Format Options window, select the **OK** button to accept the font changes and to close the window.

   Select the **Apply** button to apply the changes you have made and to keep the window open.

*Windows is a registered trademark of Microsoft Corp.*
16 Error Messages

Introduction

This chapter describes the kinds of error messages that Report Designer displays and tells you what to do when error messages appear.

Test design error messages are divided into three categories:

- Phase 1 Error Messages
- Phase 2 Historical Report Error Messages
- Phase 2 Real-Time Report Error Messages.

The errors described in this chapter usually are the result of a problem in the query that you are testing.
Phase 1 Error Messages

This section contains Phase 1 error messages. The following table lists the messages alphabetically, and includes a cause and a recommended solution for each message.

<p>| Message: $&lt;variable name&gt; not defined | Cause: The WHERE clause contains a variable that is not defined. |
| Solution: Define the variable using the define input action or remove the variable from the row search criteria. |
| Message: Cannot mix aggregates and nonaggregates in the select | Cause: You cannot specify both aggregate columns and nonaggregate columns in the same select for real-time reports. |
| Solution: Create two identical row search conditions and apply one to the aggregate columns and one to the nonaggregate columns. |
| Message: Cannot use the SYN function for order by | Cause: You cannot use a synonym to sort the output in the query. |
| Solution: Remove the aggregate from the Order by field. Use grid sorting to order the item. |
| Message: CMS system error - Check the error log | Cause: A CentreVu® CMS system error occurred while the select executed. The error should be recorded in the error log. |
| Solution: Check the error in the error log to initiate corrective action. If you run a report that merges data from two tables (particularly tables with large amounts of data) into a single field and your Select rows where statement is not specific enough, you may get this error message. The specific cause may be that the number of selected rows is very large, and CentreVu CMS does not have enough space to create temporary files. If this is the case, you should add additional “where” clauses to the row search criteria. |
| Message: CMS system error - Data collection off |</p>
<table>
<thead>
<tr>
<th>Message</th>
<th>Cause</th>
<th>Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Phase 1 Error Messages</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Cause:</strong> CentreVu CMS cannot test the row search criteria while data collection is off.</td>
<td><strong>Solution:</strong> Turn data collection on and rerun test of report design.</td>
<td></td>
</tr>
<tr>
<td><strong>Message:</strong> CMS system error - Too much data retrieved - try a more restrictive search</td>
<td><strong>Cause:</strong> Too much data was retrieved with the given row search criteria.</td>
<td><strong>Solution:</strong> Add more conditions to the row search criteria so that fewer rows are retrieved.</td>
</tr>
<tr>
<td><strong>Message:</strong> CMS system error - Updating translations</td>
<td><strong>Cause:</strong> CentreVu CMS cannot test the row search criteria while CentreVu CMS is receiving the set of configuration data from the switch.</td>
<td><strong>Solution:</strong> Wait until configuration data has been sent. Then rerun the test of report design.</td>
</tr>
<tr>
<td><strong>Message:</strong> keyword AVG invalid in where clause</td>
<td><strong>Cause:</strong> You cannot use the keyword AVG in a row search criteria.</td>
<td><strong>Solution:</strong> Remove the keyword AVG from the row search criteria.</td>
</tr>
<tr>
<td><strong>Message:</strong> keyword BETWEEN invalid for real-time</td>
<td><strong>Cause:</strong> You cannot use the keyword BETWEEN in a row search criteria for a real-time report.</td>
<td><strong>Solution:</strong> Remove the keyword BETWEEN from the row search criteria.</td>
</tr>
<tr>
<td><strong>Message:</strong> keyword COUNT invalid in where clause</td>
<td><strong>Cause:</strong> You cannot use the keyword COUNT in a row search criteria.</td>
<td><strong>Solution:</strong> Remove the keyword COUNT from the row search criteria.</td>
</tr>
<tr>
<td><strong>Message:</strong> keyword MAX invalid in where clause.</td>
<td><strong>Cause:</strong> You cannot use the keyword MAX in a row search criteria.</td>
<td><strong>Solution:</strong> Remove the keyword MAX from the row search criteria.</td>
</tr>
<tr>
<td><strong>Message:</strong> keyword MIN invalid in where clause.</td>
<td><strong>Cause:</strong> You cannot use the keyword MIN in a row search criteria.</td>
<td><strong>Solution:</strong></td>
</tr>
<tr>
<td>Solution:</td>
<td>Remove the keyword MIN from the row search criteria.</td>
<td></td>
</tr>
<tr>
<td>------------</td>
<td>-----------------------------------------------------</td>
<td></td>
</tr>
<tr>
<td>Message:</td>
<td>keyword SUM invalid in where clause.</td>
<td></td>
</tr>
<tr>
<td>Cause:</td>
<td>You cannot use the keyword SUM in a row search criteria.</td>
<td></td>
</tr>
<tr>
<td>Solution:</td>
<td>Remove the keyword SUM from the row search criteria.</td>
<td></td>
</tr>
<tr>
<td>Message:</td>
<td>keyword SYN invalid in where clause.</td>
<td></td>
</tr>
<tr>
<td>Cause:</td>
<td>You cannot use the keyword SYN in a row search criteria.</td>
<td></td>
</tr>
<tr>
<td>Solution:</td>
<td>Remove the keyword SYN from the row search criteria.</td>
<td></td>
</tr>
</tbody>
</table>
Phase 2 Historical Report Error Codes

This section contains the INFORMIX® error codes most likely to appear for CentreVu CMS historical reports. Each code includes a description of the error and the recommended corrective action.

These errors are reported in the following format:

INFORMIX error: <error number>

In addition, a circumflex (^) may appear in the listed Select statement(s) to mark the location of an error.

If an error code appears that is not listed in this document, see the INFORMIX SQL Relational Database Management System Reference Guide for INFORMIX SQL.

<table>
<thead>
<tr>
<th>Error</th>
<th>Description/Solution</th>
</tr>
</thead>
</table>
| 201   | **Description:** A syntax error has occurred.  
       **Solution:** Check that you have not misspelled an RDSQL statement, placed key words out of sequence, or included an INFORMIX-SQL reserved word in your query. |
| 202   | **Description:** An illegal character has been found in the statement.  
       **Solution:** Remove the illegal character (often a nonprintable control character) and resubmit the statement. |
| 203   | **Description:** An illegal integer has been found in the statement.  
       **Solution:** Integers must be whole numbers from -2,147,483,647 to 2,147,483,647. Check that you have not included a number with a fractional portion or a number outside the acceptable range. Check also that you have not inadvertently entered a letter in place of a number (for example, 125p3 instead of 12503). |
| 204   | **Description:** An illegal floating-point number has been found in the statement.  
       **Solution:** Check that you have not inadvertently entered a letter in place of a number (for example, 125p3 instead of 125.03). |
| 206   | **Description:** The specified table name is not in the database. |

*INFORMIX is a registered trademark of Informix Software, Inc.*
<table>
<thead>
<tr>
<th>Error</th>
<th>Description/Solution</th>
</tr>
</thead>
</table>
| 217   | Description: Column *column-name* not found in any table in the query.  
       | Solution: Correct the spelling of the database item and ensure that the item exists in the database table. Check for the presence of required commas and quotes. |
| 219   | Description: Wildcard matching may not be used with noncharacter types.  
       | Solution: Wildcards (*, ?) and characters enclosed in brackets [ ] can be used only with CHAR data types. Check the data type for the offending column. |
| 220   | Description: There is no "FROM" clause in the query.  
       | Solution: Must include a “FROM” clause in the query. Check that you do not have an illegal character ($, #, &, and so on, or a CONTROL character) in the line prior to the FROM keyword. |
| 223   | Description: Duplicate table name *table-name* in the FROM clause.  
       | Solution: Remove the redundant table name from the statement or use an alias to rename one of the tables. |
| 228   | Description: cannot have negative characters.  
       | Solution: Check that you have not included a negative CHAR data type (for example, -a or -p) in your statement. |
| 278   | Description: Too many ORDER BY columns; maximum is eight.  
       | Solution: Reduce the number of columns included in the ORDER BY clause to eight or less. |
| 280   | Description: Total size of ORDER BY columns exceeds 120 bytes.  
<pre><code>   | Solution: Reduce the number of columns included in the ORDER BY clause so that the total number of characters is less than or equal to 120 (perhaps delete a CHAR column of 30 or more characters). |
</code></pre>
<p>| 282   | Description: Found a quote for which there is no matching quote. |</p>
<table>
<thead>
<tr>
<th>Error</th>
<th>Description/Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td><strong>Solution:</strong> Check that all quoted strings are properly terminated with a quote.</td>
</tr>
</tbody>
</table>
| 284   | **Description:** A subquery has not returned exactly one value.  
**Solution:** Check data for the subquery. Restructure the subquery by adding more components in the "WHERE" clause so that only one value is returned. |
| 297   | **Description:** The SELECT list may not contain a subquery.  
**Solution:** Remove the subquery from the SELECT list in the statement. |
| 300   | **Description:** There are too many GROUP BY columns (maximum is eight).  
**Solution:** Reduce to eight or less the number of nonaggregate database items that are assigned the same row search ID as that assigned to an aggregate function. |
<table>
<thead>
<tr>
<th>Error</th>
<th>Description/Solution</th>
</tr>
</thead>
</table>
| 301   | **Description:** The total size of the GROUP BY columns exceeds 120 characters.  
**Solution:** The total number of characters in all columns listed in the GROUP BY list exceeds 120 characters. Reduce the number of nonaggregate database items that are assigned to a row search ID that is also assigned to an aggregate function. |
| 303   | **Description:** Expression mixes columns with aggregates.  
**Solution:** Restructure your query so that columns and aggregates are not included in the same expression. |
| 309   | **Description:** ORDER BY database item must be included in a report field to which the row search ID is assigned.  
**Solution:** Check that database items included in the ORDER BY clause appear in the report and are assigned to row search ID. |
| 324   | **Description:** Ambiguous database item.  
**Solution:** A database item in your row search criteria exists in more than one table also cited in your row search criteria. Prepend each database item with the appropriate table name. |
| 352   | **Description:** Database item not found.  
**Solution:** Check the spelling of the database item. |
| 367   | **Description:** Sums and averages cannot be computed for character columns.  
**Solution:** Check that you have not included a database item of a string type (VDN, LOGID, and so on) in the aggregate function statement. |
<table>
<thead>
<tr>
<th>Error</th>
<th>Description/Solution</th>
</tr>
</thead>
</table>
| 522   | **Description:** A database item in a field/bar does not exist in the table specified in the field’s row search ID.  
**Solution:** Check the Select statement that has the error. The database item that does not exist in the table will be marked with a circumflex (^). Change or delete the database item or change the table in the field’s row search ID. |
| 809   | **Description:** RDSQL syntax error has occurred.  
**Solution:** Check that you have not misspelled an RDSQL statement, placed key words out of sequence, or included an INFORMIX SQL reserved word in your query. |
| 1202  | **Description:** An attempt was made to divide by zero.  
**Solution:** Check that you are not attempting to divide a numerical column type by a character column type (for example, 16/Jones) or that the value of the divisor does not equal zero. |
| 1203  | **Description:** Values used in a MATCH must both be type CHARACTER.  
**Solution:** Check that the values included in your MATCH condition are both CHAR types. Use an alternate comparison condition for nonCHAR types. |
| 1204  | **Description:** Invalid year in date.  
**Solution:** Acceptable years are 0001 to 9999. If two digits are used, RDSQL assumes that the year is 19xx. Check the value entered in the date field. |
| 1205  | **Description:** Invalid month in date.  
**Solution:** Months must be represented as the number of the month (1 through 12). Check the value entered in the date field. |
## Error Messages

### Phase 2 Historical Report Error Codes

<table>
<thead>
<tr>
<th>Error</th>
<th>Description/Solution</th>
</tr>
</thead>
</table>
| 1206  | **Description:** Invalid day in date.  
      | **Solution:** Days must be represented as the number of the day (01 through 31). Check the value entered in the date field. |
| 1226  | **Description:** Decimal or money value exceeds maximum precision.  
      | **Solution:** Increase the precision of the DECIMAL or MONEY field. |
Phase 2 Real-Time Report Error Codes

This section contains the Real-Time Database Manager error codes. Each code includes a description of the error and a recommended solution.

These errors are reported in the following format:

CMS Database Manager error: <error number>

In addition, a circumflex (^) appears in the listed Select statement(s) to mark the location of an error.

<table>
<thead>
<tr>
<th>Error</th>
<th>Description/Solution</th>
</tr>
</thead>
</table>
| 1     | **Description:** A syntax error has occurred.  
**Solution:** Check the select for misspelled keywords or keywords that are out of order. |
| 2     | **Description:** An illegal character has been found in the select statement.  
**Solution:** Remove the illegal character (often a nonprintable control character). |
| 3     | **Description:** The specified table name is invalid.  
**Solution:** Check the spelling of the table name and for required commas in the From tables field. |
| 4     | **Description:** An invalid column has been specified (it is not found in any of the specified tables).  
**Solution:** Check the spelling of the column names. |
<table>
<thead>
<tr>
<th>Error</th>
<th>Description</th>
<th>Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>5</td>
<td>A mixture of aggregates and nonaggregates are being selected, and this is not allowed in real-time reports. (This error code can also mean mismatched types in comparison.)</td>
<td>Create two identical row search conditions, and apply one to the aggregate columns and one to the nonaggregate columns.</td>
</tr>
<tr>
<td>6</td>
<td>Bad column in the order by clause.</td>
<td>Check that the column name in the order by clause is spelled correctly and that it is being selected by one of the fields included in this row search.</td>
</tr>
<tr>
<td>7</td>
<td>Bad index in order by clause.</td>
<td>Order by clause has to have a column in the “select” clause or a number that indicates a position of the column in the “select” clause.</td>
</tr>
<tr>
<td>8</td>
<td>Bad argument given to an aggregate function. For example, you cannot take the SUM or AVG of a character column.</td>
<td>Check the arguments for the aggregates and be sure that data type is appropriate.</td>
</tr>
<tr>
<td>9</td>
<td>In the Select of one of the fields associated with this row search, an action is being performed with the wrong data types. For example, you cannot use arithmetic with character fields.</td>
<td>Check for these types of errors in the fields associated with the row search.</td>
</tr>
<tr>
<td>10</td>
<td>Error with subquery.</td>
<td>There may be a subquery in the “WHERE” clause that CMS does not support. Check the subqueries. This typically happens with an Agent Group report (a “select” embedded within a “select”).</td>
</tr>
<tr>
<td>11</td>
<td>CMS system error.</td>
<td>Check the error logs.</td>
</tr>
<tr>
<td>Error</td>
<td>Description/Solution</td>
<td></td>
</tr>
<tr>
<td>-------</td>
<td>---------------------------------------</td>
<td></td>
</tr>
</tbody>
</table>
| 12    | **Description**: Memory allocation error.  
       | **Solution**: Check the error logs.     |
| 13    | **Description**: Query cannot select more than one table. 
       | **Solution**: Check the error logs.     |
17 How CentreVu® CMS Stores and Retrieves Data

Introduction

The most important and difficult part of designing a report is defining the data that goes in the report. To define report data, you must first understand how CentreVu® Call Management System (CMS) stores and retrieves data.

This chapter provides the following CentreVu CMS information:

- Standard CentreVu CMS reports that cannot be customized
- CentreVu CMS database items that are not in any standard reports, but can be used in reports
- How CentreVu CMS stores and retrieves data.
How *CentreVu* CMS Stores Data

*CentreVu* CMS stores data in the *CentreVu* CMS database. The database is divided into 52 different tables. A **table** is an array of columns and rows that stores data for a type of ACD element (split/skill, agent, trunk, trunk group, VDN, vector, call work code, forecasting, agent trace, call records, or exceptions) and for a specific time frame (for the current intrahour interval, for past intrahour intervals, for past day - summarized by day, and so on). The following figure shows how a small piece of a table (the Current Interval Agent table, in this case) might look in the database.

<table>
<thead>
<tr>
<th>ACD</th>
<th>LOGID</th>
<th>SPLIT</th>
<th>WORKMODE*</th>
<th>ACDCALLS</th>
<th>ACDTIME</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>1001</td>
<td>1</td>
<td>21</td>
<td>988</td>
<td></td>
</tr>
<tr>
<td>1</td>
<td>1002</td>
<td>1</td>
<td>19</td>
<td>777</td>
<td></td>
</tr>
<tr>
<td>1</td>
<td>1003</td>
<td>1</td>
<td>15</td>
<td>400</td>
<td></td>
</tr>
<tr>
<td>1</td>
<td>1004</td>
<td>1</td>
<td>9</td>
<td>58</td>
<td></td>
</tr>
<tr>
<td>1</td>
<td>1005</td>
<td>1</td>
<td>11</td>
<td>644</td>
<td></td>
</tr>
<tr>
<td>1</td>
<td>1006</td>
<td>1</td>
<td>20</td>
<td>245</td>
<td></td>
</tr>
<tr>
<td>1</td>
<td>1007</td>
<td>1</td>
<td>19</td>
<td>455</td>
<td></td>
</tr>
<tr>
<td>1</td>
<td>1008</td>
<td>1</td>
<td>18</td>
<td>603</td>
<td></td>
</tr>
<tr>
<td>1</td>
<td>1010</td>
<td>1</td>
<td>18</td>
<td>203</td>
<td></td>
</tr>
<tr>
<td>1</td>
<td>2001</td>
<td>2</td>
<td>13</td>
<td>789</td>
<td></td>
</tr>
<tr>
<td>1</td>
<td>2002</td>
<td>2</td>
<td>14</td>
<td>549</td>
<td></td>
</tr>
<tr>
<td>1</td>
<td>2003</td>
<td>2</td>
<td>10</td>
<td>402</td>
<td></td>
</tr>
<tr>
<td>1</td>
<td>2004</td>
<td>2</td>
<td>19</td>
<td>452</td>
<td></td>
</tr>
<tr>
<td>1</td>
<td>2005</td>
<td>2</td>
<td>21</td>
<td>616</td>
<td></td>
</tr>
<tr>
<td>1</td>
<td>2006</td>
<td>2</td>
<td>19</td>
<td>569</td>
<td></td>
</tr>
<tr>
<td>1</td>
<td>2007</td>
<td>2</td>
<td>15</td>
<td>745</td>
<td></td>
</tr>
<tr>
<td>1</td>
<td>2008</td>
<td>2</td>
<td>9</td>
<td>109</td>
<td></td>
</tr>
<tr>
<td>1</td>
<td>2009</td>
<td>2</td>
<td>11</td>
<td>367</td>
<td></td>
</tr>
<tr>
<td>1</td>
<td>2010</td>
<td>2</td>
<td>20</td>
<td>322</td>
<td></td>
</tr>
<tr>
<td>1</td>
<td>3001</td>
<td>3</td>
<td>7</td>
<td>188</td>
<td></td>
</tr>
<tr>
<td>1</td>
<td>3002</td>
<td>3</td>
<td>18</td>
<td>704</td>
<td></td>
</tr>
<tr>
<td>1</td>
<td>3003</td>
<td>3</td>
<td>18</td>
<td>256</td>
<td></td>
</tr>
<tr>
<td>1</td>
<td>3004</td>
<td>5</td>
<td>13</td>
<td>980</td>
<td></td>
</tr>
<tr>
<td>1</td>
<td>3005</td>
<td>3</td>
<td>14</td>
<td>589</td>
<td></td>
</tr>
<tr>
<td>1</td>
<td>3006</td>
<td>3</td>
<td>10</td>
<td>340</td>
<td></td>
</tr>
<tr>
<td>1</td>
<td>3007</td>
<td>3</td>
<td>19</td>
<td>299</td>
<td></td>
</tr>
<tr>
<td>1</td>
<td>3008</td>
<td>6</td>
<td>21</td>
<td>688</td>
<td></td>
</tr>
<tr>
<td>1</td>
<td>3009</td>
<td>3</td>
<td>19</td>
<td>901</td>
<td></td>
</tr>
</tbody>
</table>

* The numeric values for WORKMODE represent agent states that appear in reports. For example, 1 = AVAIL, 2 = ACD, 3 = ACW, and 4 = AUX.

The example above shows data for the current intrahour interval for agents 1001 to 3009. Because data in this table is in real time, data changes second by second. The example represents a snapshot (or the most recent update) of the table.
The following figure shows how a small piece of the Historical Intrahour Interval Split table looks.

The example above shows data from July 1 to July 3, 1993, and simulates data for an ACD that has only three splits, 60-minute intrahour intervals, and activity each day from 8:00 a.m. to 12:00 p.m. only.

The CentreVu CMS database uses names to refer to columns of data in a table. These names are called database items. In the preceding figures, database items are indicated with arrows pointing to their associated columns. The Current Interval Agent and Intrahour Interval Split tables actually contain many more columns (and hence many more database items) than are shown in the figures. For a complete listing of database items, see the CentreVu® CMS R3V8 Database Items and Calculations (585-210-939) document.
Each row in a table contains data that is related by the value(s) of one or more of the columns. For example, each row in the Current Interval Agent table contains data related by agent login ID. If you look at the row for login ID 1006 (displayed in bold), you see that the agent is logged into Split 1 on extension 5671 and is currently in AUX work mode. In addition, up to this point in the current interval, the agent has had:

- 20 ACD calls (ACDCALLS)
- 245 seconds of ACD talk time (ACDTIME).

A column that causes the values in a row to be related is called an index. An index stores data sequentially and adds structure for the storage of data in the other columns. For each value in an index column, the remaining values in the corresponding row are related to that value. Thus, the first figure, the LOGID database item is an index.

In the second figure, each row in the Intrahour Interval Split table contains data related by date, interval, and split. If you look at the row for Split 1 for the 10 o'clock interval on July 1, 1993 (displayed in bold), you see that Split 1 had:

- 509 ACD calls (ACDCALLS)
- 43 abandoned calls (ABANDONS)
- 35,401 cumulative seconds of ACD talk time for all ACD calls (ACDTIME)
- 851 cumulative seconds of wait time for all calls that abandoned before being answered (ABNTIME).
How CentreVu CMS Retrieves Data

CentreVu CMS retrieves data from the database based on three types of information you supply when you design a report:

- The name of the table
- The database items in the table
- The rows of data in the table.

To tell CentreVu CMS how to retrieve data, you must tell CentreVu CMS to access the appropriate database table. Then, for each report field, you assign the appropriate database items. When you run the report, CentreVu CMS will find, in the table, the columns of data associated with the database items.
Next, you identify the appropriate rows that supply data. If you want agents in Split 1, you must tell CentreVu CMS to find rows that have the value 1 for the SPLIT database item. When you run the report, CentreVu CMS finds the appropriate rows of data in the cagent table (see rows with arrows in the following figure).
The data that CentreVu CMS reports is the data found in the intersection of the selected database items and rows. Therefore, the report shows data as shown in the following figure:

<table>
<thead>
<tr>
<th>Split: 1</th>
</tr>
</thead>
<tbody>
<tr>
<td>Agent ID:</td>
</tr>
<tr>
<td>----------</td>
</tr>
<tr>
<td>1001</td>
</tr>
<tr>
<td>1002</td>
</tr>
<tr>
<td>1003</td>
</tr>
<tr>
<td>1004</td>
</tr>
<tr>
<td>1005</td>
</tr>
<tr>
<td>1006</td>
</tr>
<tr>
<td>1008</td>
</tr>
<tr>
<td>1010</td>
</tr>
</tbody>
</table>
Actually, when you design a report, you normally set up the row selection so that the users running the report can choose the rows in the report’s input window. For example, to run the report in the above figure, you would set up the row selection so users would fill out a Report Input window that asked them for a Split number.

As mentioned earlier, CentreVu CMS uses indexes to create a structure for storing data. Similarly, CentreVu CMS uses these indexes to search for data. Indexes allow CentreVu CMS to find data much faster than if data were stored more randomly. Therefore, when you design a report, the rows of data for the report should be defined on the basis of index values.

The indexes for each standard table are fixed and cannot be changed, deleted or added to. However, if you define a custom table in the CentreVu CMS database through INFORMIX SQL, you can define any indexes desired for that new table. See the “SQL Query Basics” chapter for instructions on creating new database tables.

As another example of how CentreVu CMS retrieves report data, if you want a custom intrahour interval split report that lists, by intrahour interval, data for a split in a single day, then you must tell CentreVu CMS to access the hsplit (Historical Intrahour Interval Split) table. You must then assign the appropriate database items to the fields. When you run the report, CentreVu CMS finds the columns of data associated with the database items in the hsplit table (see the following figure).

*INFORMIX is a registered trademark of Informix Software, Inc.
Next, you must identify the appropriate rows that supply data. You might want data for the following:

- Split 1, which means you must identify rows that have the value 1 for the SPLIT database item.

- The date 07/02/93, which means you must identify rows with the value 070293 for the ROWDATE database item.

- The intrahour intervals 8:00 a.m. to 11:00 a.m., which means you must identify rows with the values 0800 through 1100 for the one database item.
CentreVu CMS then finds the appropriate rows of data (see the boxed rows in the following figure).

The data that CentreVu CMS reports is the data found in the intersection of the selected database items and columns. Thus, the report shows data as follows:

| Split: 1  |
| Date: 07/02/93 |

<table>
<thead>
<tr>
<th>ACD</th>
<th>Calls</th>
<th>Abandons</th>
</tr>
</thead>
<tbody>
<tr>
<td>08:00am</td>
<td>399</td>
<td>36</td>
</tr>
<tr>
<td>09:00am</td>
<td>400</td>
<td>46</td>
</tr>
<tr>
<td>10:00am</td>
<td>394</td>
<td>40</td>
</tr>
<tr>
<td>11:00am</td>
<td>418</td>
<td>41</td>
</tr>
</tbody>
</table>

Defining data is the central task of creating and designing a report. However, you must do many other tasks to create a report.
18 SQL Query and CMS Database Table Basics

Introduction

The Call Management System (CMS) is a relational database that is made of a series of database tables. The tables are made up of rows of database items and columns of data. CMS reports retrieve data from the database tables and format the data into readable tables, charts, and fields.

Reports use Structured Query Language (SQL) queries to retrieve specific data from the database tables. You can create and edit queries using the Edit | Queries feature of the Report Designer. This chapter gives you information about SQL queries, concentrating on the use of WHERE clauses. For extensive information on SQL, please refer to your INFORMIX documentation.

The sections in this chapter are as follows:

- SQL Query Basics
- CMS Database Table Basics
- Creating a Custom Data Table
- Modifying a Table

*INFORMIX is a registered trademark of Informix Software, Inc.
About SQL Queries

Reports use SQL queries to retrieve specific data from the database tables. You can create and edit queries using the Edit | Queries feature of the Report Designer. This section gives you information about SQL queries, concentrating on the use of WHERE clauses. For extensive information on SQL, please refer to your INFORMIX documentation.

SQL queries use WHERE clauses to define the rows and columns of data to retrieve from the database tables. The following paragraphs give you information on how to create and use WHERE clauses in your queries.

Basic WHERE Clause

A basic clause has the following format:

**Expression Relational_Operator Value**

The **Expression** can be a database item or calculation. The **Value** is a whole number. Relational operators available for a WHERE clause are as follows:

- `=` equal to
- `<>` or `!=` not equal to
- `>` greater than
- `>=` greater than or equal to
- `<` less than
- `<=` less than or equal to

As an example of a basic WHERE clause, if you are creating a real-time report using data from the Current Interval Split table and you have three report fields for the report:

- **Split**: (the SPLIT database item)
- **ACD Calls**: (the ACDCALLS database item)
- **Average Talk Time**: (the calculation ACDTIME/ACDCALLS)

Then the WHERE clause might be:

**Select rows where SPLIT = 5**
When you run the report, *CentreVu*® CMS finds the row in the table (see the following figure) for Split 5 and fills in the report fields with data from that row (in bold in the figure).

Thus, the report fields show the following data:

- **Split**: 5
- **ACD Calls**: 451
- **Average Talk Time**: 61 (the result of \(27635/451\))

This example of row search criteria would also include the selection of an ACD. See "WHERE Clause for Selecting Rows from an ACD" later in this section.

---

### WHERE Clause with Variable

The previous examples create **hard coded** row search conditions. That is, when you run the report, *CentreVu* CMS always searches for the values you entered in the WHERE clause. However, instead of a hard coded value, you can enter a variable name in a clause. A **variable name** tells *CentreVu* CMS to search for whatever value(s) you or another user choose when you run the report. You must define a variable on the Define Input window before using it in a WHERE clause. The variable name then links a report input field to the WHERE clause that uses the value(s) entered.
Multiple WHERE Clauses

To put two or more clauses in a statement, use **and** or **or**. Use **and** to define two or more clauses where CentreVu CMS finds only rows that meet all conditions. For example, the following statement searches for rows where splits had an average speed of answer greater than 30 seconds and abandons greater than 100.

Select rows where: \( \text{ANSTIME/ACDCALLS} > 30 \) and \( \text{ABANDONS} > 100 \)

Use **or** to define two conditions where CentreVu CMS finds rows that meet either condition but not necessarily both. For example, the following statement searches for rows where splits had too many abandoned calls or too many extension-out calls.

Select rows where: \( \text{ABANDONS} > 15 \) or \( \text{AUXOUTCALLS} + \text{ACWOUTCALLS} > 7 \)

WHERE Clause with a Range/List Variable

If a variable name, as defined in the Define Input window, has been assigned the Multi-Value option, your WHERE clause **must** use the equals sign (=) with the variable name. In addition, if a variable name has the Multi-Value option, the WHERE clause for that variable name should appear in the **Select rows where** field before any WHERE clause that does not have a Multi-Value variable.

If a variable name has the Multi-Value option and the WHERE clause for that variable name appears in the **Select rows where** field after a WHERE clause that does not have a Multi-Value variable, the report will not show accurate data when you run it.

WHERE Clause for Selecting Rows from an ACD

In your WHERE statement, Report Designer always includes a clause to select the ACD \( (\text{ACD} = \$acd) \)

If you use this default clause, you do not need to define the variable in the Define Input window because CMS understands \$acd to be the current ACD. However, if you wish, you can define a different variable name for the ACD database item so the user can specify the desired ACD(s) when ordering the report (such as in Multi-ACD reports). You can also hardcode the ACD in a WHERE clause, as in the following example.

Select rows where: \( \text{ACD} = 1 \)
WHERE Clause for Excluding Rows of Data

If you want to exclude Split 5 from the report, but include all other splits, you might enter a WHERE clause as follows:

Select rows where: SPLIT != 5
or
Select rows where: SPLIT <> 5
The CMS database is a relational database that consists of a series of database tables. The tables are made up of rows of database items and columns of data. CMS reports retrieve data from the database tables and formats the data into readable tables, charts, and fields.

This section teaches you about CMS database items and calculations, which are names given to commonly used combinations of database items. The section also includes a list of all of the available database tables in the CMS.

The following section teaches you to create and edit CMS database tables using *INFORMIX*.

For more information on the CMS database tables and definitions of the database items in each table, see the *CentreVu CMS R3V8 Database Items and Calculations* (585-210-939) document. The *CentreVu CMS* database table names are as follows:

<table>
<thead>
<tr>
<th>Name</th>
<th>Data Stored</th>
</tr>
</thead>
<tbody>
<tr>
<td>csplit</td>
<td>Split/Skill data for the current interval.</td>
</tr>
<tr>
<td>psplit</td>
<td>Split/Skill data for the previous interval.</td>
</tr>
<tr>
<td>cagent</td>
<td>Agent data for the current interval.</td>
</tr>
<tr>
<td>pagent</td>
<td>Agent data for the previous interval.</td>
</tr>
<tr>
<td>ctkgrp</td>
<td>Trunk group data for the current interval.</td>
</tr>
<tr>
<td>ptkgrp</td>
<td>Trunk group data for the previous interval.</td>
</tr>
<tr>
<td>ctrunk</td>
<td>Trunk data for the current interval.</td>
</tr>
<tr>
<td>ptrunk</td>
<td>Trunk data for the previous interval.</td>
</tr>
<tr>
<td>cvector</td>
<td>Vector data for the current interval.</td>
</tr>
<tr>
<td>pvector</td>
<td>Vector data for the previous interval.</td>
</tr>
<tr>
<td>cvdn</td>
<td>VDN data for the current interval.</td>
</tr>
<tr>
<td>pvdn</td>
<td>VDN data for the previous interval.</td>
</tr>
<tr>
<td>ccwc</td>
<td>Call Work Code (CWC) data for the current interval.</td>
</tr>
<tr>
<td>pcwc</td>
<td>CWC data for the previous interval.</td>
</tr>
<tr>
<td>Name</td>
<td>Data Stored</td>
</tr>
<tr>
<td>--------</td>
<td>-----------------------------------------------------</td>
</tr>
<tr>
<td>hsplit</td>
<td>Split/Skill data for each intrahour interval.</td>
</tr>
<tr>
<td>dsplit</td>
<td>Split/Skill data summarized by day.</td>
</tr>
<tr>
<td>wsplit</td>
<td>Split/Skill data summarized by week.</td>
</tr>
<tr>
<td>msplit</td>
<td>Split/Skill data summarized by month.</td>
</tr>
<tr>
<td>hagent</td>
<td>Agent data for each intrahour interval.</td>
</tr>
<tr>
<td>dagent</td>
<td>Agent data summarized by day.</td>
</tr>
<tr>
<td>wagent</td>
<td>Agent data summarized by week.</td>
</tr>
<tr>
<td>magent</td>
<td>Agent data summarized by month.</td>
</tr>
<tr>
<td>htkgrp</td>
<td>Trunk group data for each intrahour interval.</td>
</tr>
<tr>
<td>dtkgrp</td>
<td>Trunk group data summarized by day.</td>
</tr>
<tr>
<td>wtkgrp</td>
<td>Trunk group data summarized by week.</td>
</tr>
<tr>
<td>mtkgrp</td>
<td>Trunk group data summarized by month.</td>
</tr>
<tr>
<td>htrunk</td>
<td>Trunk data for intrahour interval.</td>
</tr>
<tr>
<td>dtrunk</td>
<td>Trunk data summarized by day.</td>
</tr>
<tr>
<td>wtrunk</td>
<td>Trunk data summarized by week.</td>
</tr>
<tr>
<td>mtrunk</td>
<td>Trunk data summarized by month.</td>
</tr>
<tr>
<td>hvector</td>
<td>Vector data for each intrahour interval.</td>
</tr>
<tr>
<td>dvector</td>
<td>Vector data summarized by day.</td>
</tr>
<tr>
<td>wvector</td>
<td>Vector data summarized by week.</td>
</tr>
<tr>
<td>mvector</td>
<td>Vector data summarized by month.</td>
</tr>
<tr>
<td>hvdn</td>
<td>VDN data for each intrahour interval.</td>
</tr>
<tr>
<td>dvdn</td>
<td>VDN data summarized by day.</td>
</tr>
<tr>
<td>wvdn</td>
<td>VDN data summarized by week.</td>
</tr>
<tr>
<td>mvdn</td>
<td>VDN data summarized by month.</td>
</tr>
<tr>
<td>hcwc</td>
<td>CWC data for each intrahour interval.</td>
</tr>
<tr>
<td>dcwc</td>
<td>CWC data summarized by day.</td>
</tr>
<tr>
<td>wcwc</td>
<td>CWC data summarized by week.</td>
</tr>
<tr>
<td>mcwc</td>
<td>CWC data summarized by month.</td>
</tr>
</tbody>
</table>
Database Items

A database item is the name of a column of data in a table, either standard or custom. When you enter a database item, you must always add the name of a table and a period (.) as a prefix if more than one table is included in the query. The format is <table name>.<database item>.

Examples:
- dsplit.ACDCALLS
- hagent.STARTTIME
- ctkgrp.NUMINUSE

Standard Database Items

Standard database items are listed in the Dictionary subsystem as having all upper-case letters (as in the preceding examples).

A standard database item can store:
- Identifiers (for example, SPLIT, VDN, LOGID, and so on)
- Timed data (for example, ACDTIME, ABANTIME, AUXOUTIME, and so on)

### Database Items

<table>
<thead>
<tr>
<th>Name</th>
<th>Data Stored</th>
</tr>
</thead>
<tbody>
<tr>
<td>call_rec</td>
<td>Call record data.</td>
</tr>
<tr>
<td>agex</td>
<td>Agent exceptions.</td>
</tr>
<tr>
<td>spex</td>
<td>Split exceptions</td>
</tr>
<tr>
<td>tgex</td>
<td>Trunk group exceptions.</td>
</tr>
<tr>
<td>vecex</td>
<td>Vector exceptions.</td>
</tr>
<tr>
<td>vdnex</td>
<td>VDN exceptions.</td>
</tr>
<tr>
<td>linkex</td>
<td>Link down exceptions.</td>
</tr>
<tr>
<td>mctex</td>
<td>Malicious call trace exceptions.</td>
</tr>
<tr>
<td>f_cday</td>
<td>Forecast current day configuration data by split/skill.</td>
</tr>
<tr>
<td>f_cdayrep</td>
<td>Current day forecast data by split/skill.</td>
</tr>
<tr>
<td>haglog</td>
<td>Agent login/logout.</td>
</tr>
<tr>
<td>ag_actv</td>
<td>Agent trace.</td>
</tr>
<tr>
<td>call_rec</td>
<td>Call records.</td>
</tr>
</tbody>
</table>
- Event counts (for example, ACDCALLS, INTERFLOWCALLS, ABNCALLS, and so on)
- For real-time and agent trace reports, current state data (for example, WORKMODE, DURATION, NUMINUSE, and so on).

See the CentreVu CMS R3V8 Database Items and Calculations (585-210-939) document for a description of database tables and items including the exceptions, forecast, and login/logout tables.

Standard database items are often shared by more than one table. For example, ABNCALLS can identify a column in the Current Interval Split, Daily Split, or Intrahour Agent tables (or many other tables).

CentreVu CMS can determine the exact database item only when it is identified with a table. The same data item may exist in several CMS database tables, with the same data item name used. If a data item exists in a real-time CMS table as well as an integrated CMS table, its value will usually be different depending on which table is queried. If data items in reports created with Report Designer are returning unexpected values, particularly in integrated reports, check that the correct table is being queried.

**Custom Database Items**

You must enter a custom database item, with the custom table name as a prefix, exactly as you defined it in the Dictionary subsystem. The data identified by a custom database item depends entirely on the data you entered for the item in the custom table.

When you create a custom database table, as described in this chapter, keep in mind that all custom database table names need to begin with the “c_” prefix. If you do not name the tables with the c_, they will not automatically be backed up and they will not show up in the Query Assistant.

**Constants**

A constant is the name of a fixed numerical value (whole number or decimal) that you define in the Dictionary subsystem. Constant names can be up to 20 characters long. A constant could represent a per-minute usage rate for trunks, a daily or hourly wage rate, or a service objective (like number of abandonons, number of ACD calls, or percent within service level). A constant could also represent an average for the estimated dollar loss of an abandoned call, which could then be used to calculate daily loss of revenue due to abandoned calls. No standard constants exist in CentreVu CMS when it is first installed. Therefore, you must define every constant you want to use.
Using constants makes sense only if you have a fixed value that you want to use under one or both of the following conditions:

- The constant is a value that you will use in a number of different custom reports (for example, an average wage rate).

- You would not be able to remember the numerical value, but could remember a name assigned to the value (for example, for the $9.00 hourly wage rate for an agent called Smith, you could have a constant called `Smithwage`.)

The CentreVu CMS real-time database allows only whole numbers in queries. If you need a value to be a decimal (for example, 9.5), use whole numbers and division to arrive at the correct number (so, in order to have 9.5 in a query, you would use 19/2 as the query entry).

### Calculations

A calculation is a combination of database items and arithmetic operators. You can also include constants in a calculation. The arithmetic operators are as follows:

- **add**
- **subtract**
- **multiply**
- **divide**
- **perform first**

Some examples of calculations are:

```
dsplit.ACDCALLS/dsplit.ACDTIME
hagent.AUXOUTTIME+hagent.ACWOUTTIME
100*((cagent.I_ACDTIME+cagent.I_ACWTIME)/cagent.I_STAFFTIME)
```

Arithmetic operations are generally performed in order from left to right. However, multiplication and division operations are performed before addition and subtraction operations, unless the addition or subtraction operations are enclosed in parentheses. Operations in parentheses are always performed first. If more than one set of parentheses is used, the operation in the set farthest to the left is performed first. If one set of parentheses is inside of another set, the operation of the inner set is performed first.
**Calculation names**

A calculation name is a name, as defined in the Dictionary subsystem, that can substitute for the actual calculation. The calculation name can be a standard name (used in standard reports) or a name you define. You cannot append a table name to a calculation name. Therefore, you must specify a table name in the **Table for calculations** field.

A calculation name normally reflects the purpose of the calculation. As a result, entering a name is an easier, more meaningful way to define data for a report field. More importantly, if you use a calculation name in many custom reports and later decide to change the calculation, you can simply make your changes once in the Dictionary subsystem. CentreVu CMS then applies those changes to every report that uses the calculation name.

For example, if there are several different custom split reports, and in each report, a field uses the standard calculation name `<PERCENT_ACD_TIME>`. `<PERCENT_ACD_TIME>` represents the calculation 100*((I_ACDTIME+I_ACWTIME)/I_STAFFTIME). This calculation, when assigned to the Intrahour Split table, finds the percentage of time a split’s agents spent on ACD calls while logged in. The calculation includes talk time (I_ACDTIME) and after-call-work time (I_ACWTIME). If you no longer wish to include after-call-work time in the calculation, then you can change the calculation in the Dictionary subsystem such that `<PERCENT_ACD_TIME>` represents 100*(I_ACDTIME/I_STAFFTIME). Any custom report that uses the calculation name PERCENT_ACD_TIME reflects the new calculation.

If you change the calculation for a standard calculation name, the change affects any standard report, as well as any custom report, that uses that calculation name.

You **should not** add table names to your custom calculations in the Dictionary subsystem. Doing so makes the assigned calculation name less flexible for use in custom reports. Also, if you append table names to the Dictionary calculation and then also assign a table name to the calculation name in the Field window, the report will fail.
Data from More Than One Table

A calculation can merge data from more than one table in a report field. For example, you may want the percentage of a split's ACD calls that an agent handled in a day. Thus, you can enter a calculation that merges data from the Daily Agent and Daily Split tables, as in the following example.

\[ \text{dagent.ACDCALLS/dsplit.ACDCALLS} \]

When you merge data from two tables, you must define your row search conditions in a special way.

You cannot use calculation names for a field in which you merge data from two tables.
Creating a Custom Data Table

The section of the CentreVu™ Call Management System (CentreVu CMS) database that stores historical ACD data uses the INFORMIX®-SQL Relational Database Management System. All historical ACD data available for use in custom reports is stored in tables in the CentreVu CMS database. You can access INFORMIX and the CentreVu CMS database to build your own data tables to contain financial information, schedule information, product or service information, or any other type of information you want. You can then design historical custom reports to display the data, with or without ACD data.

Instructions on the use of INFORMIX SQL appear in this document as a convenience. These instructions are not intended as a substitute for the INFORMIX documentation. Except where noted, the standard rules of INFORMIX SQL apply, as documented in the INFORMIX-SQL Relational Database Management System User Guide for INFORMIX SQL Version 4.10. This document is delivered with your CentreVu CMS software and documents.

CentreVu CMS does not automatically check the database for disk space used by data in custom tables. As a result, you can inadvertently fill up your disk with custom data. When this happens, you can lose or damage custom data and ACD data. Therefore, if you create custom data tables, be careful to check the amount of disk space available regularly. See the CentreVu® CMS R3V8 Administration (585-210-910) document for more information on disk storage.

If you back up data using the Maintenance — Backup Data window, you will save the data stored in custom INFORMIX tables, but you will not save the custom table definitions (table names, column names, data types, and so on) unless the custom tables were named with the “c_” prefix. As a result, if you lose the custom table definitions because of a disk crash, power hit, or some other reason, you cannot restore these table definitions through the Backup Data window nor can you restore custom data saved through the Backup Data window.

Therefore, you should periodically back up data using the UNIX™ system. Then, if you lose INFORMIX table definitions and/or custom data, you can restore the table definitions through UNIX, and then, if necessary, restore the custom data. See the CentreVu® CMS R3V8 Administration (585-210-810) document for procedures on backing up data by way of the UNIX system.

---

* INFORMIX is a registered trademark of Informix Software, Inc.
† UNIX is a registered trademark of Novell, Inc.
To define a custom database table, complete the steps defined in the following sections.

**Step 1: Access the CentreVu CMS Database in INFORMIX**

To perform these procedures, you must have purchased the INFORMIX SQL software.

To access the INFORMIX SQL software, you need to log into the CMS using CentreVu Terminal.

To access the CentreVu CMS database in INFORMIX, use the following steps:

1a. Press the Commands SLK. → The Commands submenu appears.

1b. Select the UNIX option. → All windows and menus disappear, and the UNIX prompt appears.

1c. At the $ prompt, type the following command:

1d. At the $ prompt, type the following pathname:
   `/usr/informix/bin/isql`. Press the Return key. → The INFORMIX logo appears, followed by the INFORMIX Main Menu.
Step 2: Build the Table

In INFORMIX, you can select menu items in one of two ways:

- Use the arrow keys (→ or ←) to move the cursor to the menu option. Then, press [Return].
- Type the first character of the menu option.

To escape from a step and go back to the previous step, press the Delete key on your keyboard.

2a. At the INFORMIX Main Menu, select Table. → The Select Database screen appears.

2b. Type cms, and press [Return]. → The Table menu appears.

2c. Select Create. → The Create Table screen appears.

2d. Type a name of up to 18 characters for the table you are building. The table name must begin with c_ (a lowercase “c” and underscore). For example, type c_workcode. Press the [Return] key. → The Create Table menu appears with a highlighted box beneath “Column Name.”

2e. Select Add. → The Add Name screen appears.
2f. Type a name of up to 18 characters for the column you are adding. If desired, you can use names of standard CentreVu CMS database items only if you enter the name in lowercase letters in the Dictionary subsystem. The Dictionary: Custom Items window accepts only lowercase letters for custom item names that are the same as standard database items. Press the [Return] key.

The available data types are as follows:

<table>
<thead>
<tr>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Char</td>
<td>Character (CHAR) columns store any combination of letters, numbers, and symbols.</td>
</tr>
</tbody>
</table>
| Number | Numeric columns store numbers. The numbers stored can be one of the following five types:  
  - Decimal. A decimal is a number that contains a decimal point.  
  - Smallint. A Smallint column stores integers from -32,767 to +32,767.  
  - Integer. An Integer column stores integers from -2,147,483,647 to +2,147,483,647.  
  - Smallfloat. A Smallfloat column stores floating point numbers with up to seven significant digits.  
  - Float. A Float column stores floating point numbers with up to 14 significant digits. |
| Serial | Serial columns store a unique sequence number in each row of the table.        |
| Date   | Date columns store calendar dates with the format mm/dd/yy or dd/mm/yy, depending on your Windows operating system. |
| date-Time | The date-Time data type is not supported by CMS. You must type T in order to select date-Time.  
A date-Time column allows you to specify a database qualifier of year, month, day, hour, or minute. |
Interval  The Interval data type is not supported by CMS. An interval column allows you to specify an interval qualifier of year, month, day, hour, or minute.

Money  The Money data type is not supported by CMS. If your data will be dollars and cents, you should use Decimal.

2g. Select the type of data that the field will store.

2h. Complete the definition of the column by responding to the additional prompts that appear. The prompts that appear and the order in which they appear depend on the data type you selected. The following table lists the possible prompts.

2i. Repeat Steps 2f through 2h for each column that you want to add.

<table>
<thead>
<tr>
<th>Prompt</th>
<th>What to Do</th>
</tr>
</thead>
<tbody>
<tr>
<td>PRECISION</td>
<td>Select either Smallfloat or Float. PRECISION appears for the Float type.</td>
</tr>
<tr>
<td>INDEX</td>
<td>Enter y if you want to make the column an index. INDEX appears for all types except Serial. A column with the Serial data type automatically becomes an index. Make the column an index only if the column will be used for row searches and the table will contain more than 200 rows of data.</td>
</tr>
<tr>
<td>Prompt</td>
<td>What to Do</td>
</tr>
<tr>
<td>---------------------</td>
<td>------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td><strong>DUPLICATES</strong></td>
<td>Enter <code>y</code> if you want to allow the column to contain the same value in different rows. For example, if the column were to contain the last names of people, you would probably want to allow multiple entries (because, for example, you might have many different people with the last name of Smith). However, if you were creating a column of social security numbers, then you would enter <code>n</code> to prevent multiple entries of the same number. <strong>DUPLICATES</strong> appears for all types except Serial.</td>
</tr>
<tr>
<td><strong>NULLS</strong></td>
<td>Enter <code>y</code> if you want to allow the column to have rows with no values (versus requiring values). For example, if your table is a list of customer data and the column you are adding is for the customer’s employer, you might want to allow the NULL value for the case where the person is unemployed. Enter <code>n</code> if you want to require a value in each row. <strong>NULLS</strong> appears for all types except Serial.</td>
</tr>
<tr>
<td><strong>ADD STARTING NUMBER</strong></td>
<td>Enter the number that <em>INFORMIX</em> should use as a starting point for numbering rows. <em>INFORMIX</em> identifies the first row in the table with the number you enter. As each new row of data is added to the table, <em>INFORMIX</em> assigns that row the next number in the sequence. <strong>ADD STARTING NUMBER</strong> appears only for Serial.</td>
</tr>
<tr>
<td><strong>NUMERIC</strong></td>
<td>Type the first letter of the numeric you want: Integer, Smallint, Decimal, or Float.</td>
</tr>
<tr>
<td><strong>LENGTH</strong></td>
<td>Enter the number of digits the column will store for a single piece of data. <strong>LENGTH</strong> appears for Char and Decimal types</td>
</tr>
<tr>
<td><strong>SCALE</strong></td>
<td>Enter the number of digits that should appear to the right of the decimal point. The decimal digits, but not the decimal point, occupy part of the field length you specified in the <strong>LENGTH</strong> field. <strong>SCALE</strong> appears after the <strong>LENGTH</strong> for Decimal.</td>
</tr>
</tbody>
</table>
Step 3: Add Data to the Table

To help you add data to the table, you must first create a data entry form associated with your table. For more information about forms, see “Creating Your Own Forms” in the INFORMIX-SQL Relational Database Management System User Guide. For more information about adding data, see “Entering Data,” in the same document.

3a. On the Main Menu, select FORM. → The FORM menu appears.

3b. Select GENERATE. → The GENERATE FORM screen appears.

3c. Enter a name (up to ten characters) for the form associated with your table. (If possible, use the same name as the table you created.) Press Return. → The CHOOSE TABLE screen appears.
3d. Enter the name of the table you want to enter data for, and press Return. The Table-selection-complete menu appears.

3e. Select Table-selection-complete. The screen form specification was successfully compiled appears when processing of the form is complete, then the FORM menu appears.

3f. Select Run. The RUN FORM window displays the table you selected.

3g. Press the Return key. The PERFORM menu appears.

3h. Select Add. The cursor moves to the first column in the table.

3i. Enter data for the first column of the table, and press the Return key. The cursor moves to the next column. If you get an error message, you may have entered data in the wrong format.

3j. Repeat Step 3i for each column.

3k. Press the Esc key to save the row of data. Row added appears. The row of data has been added to the table and saved.

3l. Repeat Steps 3h through 3k for each row of data you want to add.

3m. Type e (for Exit) three times to exit INFORMIX. The UNIX prompt appears.

3n. Press Ctrl B. The CentreVu CMS windows and menus that were displayed before you accessed UNIX reappear.
To design a report that uses data from the table, you must also enter the column names (database items) in the Dictionary: Database Item: Custom Items window.

CentreVu CMS does not automatically check the database for disk space used by data in custom tables. As a result, you can inadvertently fill up your disk with custom data. When this happens, you can lose or damage custom data and ACD data. Therefore, if you create custom data tables, be careful to regularly check the amount of disk space available. See the CentreVu® CMS R3V8 Administration (585-210-910) document for more information on disk storage.
Modifying a Table

Use the following steps to add, change, or delete columns in an existing table.

1. On the **INFORMIX Main Menu**, select **Table**. → The **Select Database** screen appears.

2. Press the **Return** key. → The **TABLE** menu appears.

3. Select **Alter**. → The **ALTER TABLE** screen appears. A list of existing tables also appears.

4. Enter the name of the table you want to change, and press **Return**. → The **ALTER TABLE** menu appears.

Adding a Column to a Table

1. Select **Add** to add a new column. → The **ADD NAME** screen appears.

2. Complete the fields for the new column.

3. Press the **Del** key when you have finished adding the column(s), and go to Step 3 of “Deleting a Column.” → The **ALTER TABLE** menu appears.
Changing a Column

1. Select Modify to change a column. → The MODIFY NAME screen appears.

2. Use the arrow keys to select a field to change.

3. Press the [Del] key when you have finished changing the column(s), and go to Step 3 of “Deleting a Column” in this section. → The ALTER TABLE menu appears.

Deleting a Column

1. To delete a column, use the arrow keys to move the cursor to the column. Select Drop. → The REMOVE screen appears.

2. Select YES to remove the column. → The column disappears, and the ALTER TABLE menu appears.

3. At the ALTER TABLE menu, select Exit when you are finished changing the table. → The Build-new-table menu appears.

4. Select Build-new-table to save your changes. Select Discard-new-table to ignore your changes.
Changing Data in a Table

Use the following steps to add, change, or delete data in an existing table.

1. On the INFORMIX Main Menu, select Form. → The FORM menu appears.
2. Select Run. → The RUN FORM screen and a list of forms appear.
3. Enter the name of a form, and press [Return]. → The PERFORM menu appears.

Adding Rows of Data to a Table

1. Select Add to add rows of data. → The table’s column fields appear with the cursor in the first field.
2. Enter data in the fields. Use [Return] or [Tab] to move between fields.
3. Press [Esc] when you have added a row of data. → The PERFORM menu reappears. The message Row added also appears.

Changing Rows of Data in a Table

1. To change data in a row, display the data you want to change. To do this, select Query. → The table’s column fields appear, with the cursor resting in the first field.
2. Enter data in a column you want to search on, and press [Esc]. → The column fields fill with data for that row.
3. Select **Update**, and press the **Return** key.
   → The **Update** screen appears.

4. Use the arrow keys to move the cursor to the data you want to change. Overtype the data, and press **Esc**.
   → The **PERFORM** menu reappears. The message **This row has been changed** also appears.

---

**Deleting Rows of Data From a Table**

1. To delete a row of data, repeat Steps 1 and 2 of "**Changing Rows of Data in a Table**" in this section.
   Press **Esc**.
   → The **PERFORM** menu reappears.

2. Select **Remove**.
   → The **REMOVE ROW** screen appears.

3. Select **YES** to delete the row.
   → The row of data disappears.
   The message **Row deleted** appears.
A Using the Report Designer - Examples

General Information

This appendix provides step-by-step instructions on creating a commonly used report with Report Designer and step-by-step instructions on modifying an existing report.

Creating a Integrated Report Using the Report Designer

This example shows how an integrated report that displays agent states is created using the Report Designer.

Start the Report Designer:

1. From the Lucent CentreVu® Supervisor’s toolbar, click on the Reports button. The Select a Report window appears.
2. Select the New button. The Design Mode window appears. You will create your report from the Design Mode window.

Define Inputs:

3. From the Edit menu, select Inputs. The Edit Inputs (Select inputs for this report.) window appears.
4. From the Input Types: list, click on Split/Skill, and then select the Add button.
5. Select the OK button.

Create a Query:

6. From the Edit menu, select Queries. The Query Assistant (Select an existing query or add a new one.) window appears.
7. Select the New button. The Query Assistant (Select a databox and one or more tables for the query.) window appears.
8. In the Database frame, select the Integrated radio button.
9. Under the Table Name column, click on the isplit table name, and then select the Next button. The Query Assistant (Add the database items and calculations for the SELECT portion of the query. This query is based on the following table(s): isplit.) window appears.
10. From the Database Items: list, select the following database items by clicking on the item, and then selecting the Add button.
   - Abncalls
   - Acdcalls
   - Acdtime
   - Servicelevel.
11. Select the **Next** button. The Query Assistant (Enter the start time for this integrated query.) window appears.

12. Select the **Input Start Time** radio button, and then select the **Next** button. The Query Assistant (Select the input used to indicate the split for this query.) window appears.

13. Select the Split/Skill input, and then select the **Next** button. The Query Assistant (Enter a name for this query.) window appears.

14. Name your query chart, and then select the **Done** button.

15. Close the Query Select window. The Design Mode window appears.

Save Report:

16. From the **Report** menu, select **Save As**.

17. Name your report `<your name> status`, and then select the **Only Me** radio button.

18. Select the **OK** button. Notice that your report is now displayed in the Integrated Designer Category.

Insert a Chart:

19. From the **Insert** menu, select **chart**. The Chart Assistant (Select the query and data items you wish to plot on the chart.) window appears.

20. From the Queries: drop-down list, select **chart**.

21. Select the **Add All>>** button. All data are added to the Data on Chart list.

22. Select the **Next** button.

23. Click on the **2D** radio button.

24. Select **Bar Graph** for your chart type, and then select the **Next** button.

25. Select (none) in the Available Data list, and then select the **Done** button.

26. Save your report.

---

**Modify the Integrated Report Using the Report Designer**

This example shows how to modify an existing report using the Report Designer. You will create a second query and add a table in the report that you just created.

Open Existing Report for Modification:

1. From the Select a Report window, select the **Integrated** tab.
2. In the Category list, select **Designer**.

3. In the Report list, select the report you just created, and then select the **Edit** button.

Create a Second Query:

4. From the **Edit** menu, select **Queries**. The Query Assistant (Select an existing query or add a new one.) window appears.

5. Select the **New** button. The Query Assistant (Select a databox and one or more tables for the query.) window appears.

6. In the Database frame, select the **Integrated** radio button.

7. Under the **Table Name** column, click on the isplit table name, and then select the **Next** button. The Query Assistant (Add the database items and calculations for the SELECT portion of the query. This query is based on the following table(s): isplit.) window appears.

8. From the Database Items list, select the following database items by clicking on the item, and then selecting the **Add** button.
   - AVAILABLE
   - AGINRING
   - INACW
   - INAUX
   - O_ONACD
   - OTHER.

9. Select the **Next** button. The Query Assistant (Enter the start time for this integrated query.) window appears.

10. Select the **Input Start Time** radio button, and then select the **Next** button. The Query Assistant (Select the input used to indicate the split for this query.) window appears.

11. Select the **Split/Skill** input, and then select the **Next** button. The Query Assistant (Enter a name for this query.) window appears.

12. Name your query **table**, and then select the **Done** button.

13. Close the Query Select window. The Design Mode window appears.

Save Report:

14. From the **Report** menu, select **Save**.

Insert a Table:

15. From the Select a Report window, select the **Integrated** tab.

16. In the **Category** list, select **Designer**.
17. In the Report list, select the report you just created, and then select the Edit button.

18. From the Insert menu, select Table. The Table Assistant (Select a query and associated database items for the grid.) window appears.

19. From the Queries drop-down list, click on table, and then select the Add All>> button.

20. Select the Next button. The Table Assistant (Select a grid layout.) window appears.

21. In the Orientation frame, select Vertical.

22. In the Options frame, select Headers On and Grid Line On.

23. Select the Done button. Your report now has a chart and a table.

24. Move the table so that you can see both the chart and table. By default, the second section (your table) will overlay the first section (your chart).

25. From the Report menu, select Save.
B Database Items and Calculations

General Information

Please refer to the *CentreVu® Call Management System R3V8 Database Items and Calculations* document, 585-210-939, for full descriptions of the database items and calculations available through the *CentreVu* Call Management System (CMS).
Index

Symbols

"Where" Clauses
- Basic ............................................. 18-2
- Exclusions ....................................... 18-5
- Multiple ......................................... 18-4
- Range/List Variable .......................... 18-4
- Selecting Rows from an ACD ............. 18-4
- Variable .......................................... 18-3
$ Not Defined ..................................... 16-2
% Axis ............................................... 12-21

Numerics

2-dimensional .................................. 12-20
3D Effects Tab .................................. 12-22
- Depth to Height .................................. 12-24
- Elevation .......................................... 12-22
- Oblique .......................................... 12-23
- Orthogonal ....................................... 12-23
- Perspective ....................................... 12-23
- Projection ........................................ 12-23
- Rotation .......................................... 12-22
- Using .............................................. 12-24
- Viewing Distance .............................. 12-23
- Width to Height ................................. 12-24
3-dimensional ................................... 12-20

A

About .............................................. 4-9
About Supervisor . 1-1, 6-1, 7-1, 8-1, 9-1, 10-1, 12-1, 13-1, 14-1, 15-1, 18-1
Above Point ....................................... 12-11
ACD Name Field .................................. 9-3
Add Bookmark ..................................... 3-2
Add the database items and calculations for the
  SELECT .......................................... 7-17
Add the database items and calculations for the
  SELECT .......................................... 7-4, 7-13, 7-21
Agent .............................................. 6-4
Agent group ....................................... 6-4
Agent state ......................................... 6-4
Agent Trace Data .................................. 3-5
Agent trace data ................................... 3-5
ageX ............................................... 18-8
Align ................................................ 13-8, 14-2
Align Controls .................................... 4-6
Align To Grid ...................................... 4-8
Alphabetical sorting ............................ 13-12
AND button ........................................ 7-10
And/Or, Using in Clauses ....................... 18-4
Appearance of Input Fields ..................... 6-10
Area Chart ........................................ 12-20
Arithmetic Operators ............................ 18-10

Associated ACD .................................. 6-11
Available Data .................................. 12-9, 13-5
AVG .................................................. 7-6
Axis Display ...................................... 12-5
Axis Tab ............................................ 12-5
  - Axis Display .................................. 12-5
  - Category ....................................... 12-5
  - Using .......................................... 12-7

B

Background Color ................................ 12-3
Bar Chart .......................................... 12-20
Base ................................................. 12-11
Basic Tasks of Designing a Custom Report 4-11, 4-13
Basics ............................................. 4-1
Below Point ........................................ 12-11
Bookmark .......................................... 3-2

C

cagent .............................................. 18-6
Calculation Names ................................ 18-11
Calculations ...................................... 7-5, 18-10
Call record data ................................... 3-5
Call Work Code .................................... 6-4
Call Work Code Data ............................ 3-5
call_rec ............................................ 18-8
Cannot Mix Aggregates and Nonaggregates in the
  Select ............................................ 16-2
Cannot Use the SYN Function for Order By .... 16-2
Category ............................................ 12-5
Category Name .................................... 12-12
ccwC ................................................. 18-6
Center ............................................. 12-11
CHAR Columns
  - Definition ..................................... 18-16
Chart .............................................. 4-7, 4-8
Chart Assistant
  - Make category and series selections ........ 8-4
  - Select the query and data items you wish to plot on
    the chart ...................................... 8-2
  - Specify a chart type .......................... 8-3
Chart Type ........................................ 12-20
Charts
  - Creating/Inserting ............................ 8-1
    - Make category and series selections ........ 8-4
    - Placement on the report ...................... 8-1
    - Select the query and data items you wish to plot
      on the chart .................................. 8-2
    - Specify a chart type .......................... 8-3
Formatting ......................................... 12-1
  - 3D Effects Tab ................................ 12-22
Using .............................................. 12-24
<table>
<thead>
<tr>
<th>Index</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Charts, Formatting (continued)</td>
<td></td>
</tr>
<tr>
<td>Axis Tab.</td>
<td>12-5</td>
</tr>
<tr>
<td>Using.</td>
<td>12-7</td>
</tr>
<tr>
<td>Data Labels Tab.</td>
<td>12-11</td>
</tr>
<tr>
<td>Using.</td>
<td>12-12</td>
</tr>
<tr>
<td>Data Tab.</td>
<td>12-9</td>
</tr>
<tr>
<td>Using.</td>
<td>12-9</td>
</tr>
<tr>
<td>Fonts Tab.</td>
<td>12-13</td>
</tr>
<tr>
<td>Using.</td>
<td>12-13</td>
</tr>
<tr>
<td>General Tab.</td>
<td>12-3</td>
</tr>
<tr>
<td>Legend Tab.</td>
<td>12-15</td>
</tr>
<tr>
<td>Using.</td>
<td>12-16</td>
</tr>
<tr>
<td>Series Labels Tab.</td>
<td>12-17</td>
</tr>
<tr>
<td>Using.</td>
<td>12-17</td>
</tr>
<tr>
<td>Title Tab.</td>
<td>12-18</td>
</tr>
<tr>
<td>Using.</td>
<td>12-18</td>
</tr>
<tr>
<td>Type Tab.</td>
<td>12-20</td>
</tr>
<tr>
<td>Using.</td>
<td>12-21</td>
</tr>
<tr>
<td>Using the General Tab.</td>
<td>12-4</td>
</tr>
<tr>
<td>Order of Items</td>
<td>8-2</td>
</tr>
<tr>
<td>Checklist of Design Tasks</td>
<td>4-11 , 4-13</td>
</tr>
<tr>
<td>Choose Font</td>
<td>12-13 , 13-6</td>
</tr>
<tr>
<td>Choose functions for the SELECT items</td>
<td>7-6</td>
</tr>
<tr>
<td>Clauses</td>
<td>18-2</td>
</tr>
<tr>
<td>Close Button</td>
<td>4-10</td>
</tr>
<tr>
<td>Clustered Bar Chart.</td>
<td>12-20</td>
</tr>
<tr>
<td>CMS Reports</td>
<td>3-11</td>
</tr>
<tr>
<td>CMS System Error</td>
<td></td>
</tr>
<tr>
<td>Check the Error Log</td>
<td>16-2</td>
</tr>
<tr>
<td>Data Collection Off</td>
<td>16-2</td>
</tr>
<tr>
<td>Too Much Data Retrieved</td>
<td>16-3</td>
</tr>
<tr>
<td>Updating Translations</td>
<td>16-3</td>
</tr>
<tr>
<td>Column</td>
<td></td>
</tr>
<tr>
<td>Changing.</td>
<td>18-23</td>
</tr>
<tr>
<td>Deleting.</td>
<td>18-23</td>
</tr>
<tr>
<td>Column Names, Custom Tables</td>
<td></td>
</tr>
<tr>
<td>Adding.</td>
<td>18-16</td>
</tr>
<tr>
<td>Column Types</td>
<td>18-16</td>
</tr>
<tr>
<td>Columns in a Table</td>
<td></td>
</tr>
<tr>
<td>Adding.</td>
<td>18-22</td>
</tr>
<tr>
<td>Changing.</td>
<td>18-22</td>
</tr>
<tr>
<td>Deleting.</td>
<td>18-22</td>
</tr>
<tr>
<td>Constants</td>
<td>18-9</td>
</tr>
<tr>
<td>Contents</td>
<td>1-4, 4-9</td>
</tr>
<tr>
<td>Conventions Used in this Document</td>
<td>1-6</td>
</tr>
<tr>
<td>Copy</td>
<td></td>
</tr>
<tr>
<td>To a File</td>
<td>3-2, 4-6</td>
</tr>
<tr>
<td>copy.</td>
<td>3-7</td>
</tr>
<tr>
<td>Copy a report to Designer</td>
<td>3-8</td>
</tr>
<tr>
<td>Copy and Paste</td>
<td>4-13</td>
</tr>
<tr>
<td>Copy from diskette</td>
<td>5-2, 5-3</td>
</tr>
<tr>
<td>Copy Query</td>
<td>3-9</td>
</tr>
<tr>
<td>Copy Report</td>
<td>3-4</td>
</tr>
<tr>
<td>Copy to diskette</td>
<td>3-8</td>
</tr>
<tr>
<td>Copying a Designer Report from a File</td>
<td>3-9</td>
</tr>
<tr>
<td>Copying a Designer Report to a File</td>
<td>3-7</td>
</tr>
<tr>
<td>Copying a Query</td>
<td>7-25</td>
</tr>
<tr>
<td>Copying a Report to the Designer Category</td>
<td>3-4</td>
</tr>
<tr>
<td>Create a New Report</td>
<td>4-11</td>
</tr>
<tr>
<td>Creating a Field</td>
<td>9-1</td>
</tr>
<tr>
<td>Creating a Real-Time or Historical Query</td>
<td>7-3</td>
</tr>
<tr>
<td>Creating a Table</td>
<td>10-1</td>
</tr>
<tr>
<td>Creating an Integrated Query</td>
<td>7-12</td>
</tr>
<tr>
<td>Creating Queries</td>
<td>7-1</td>
</tr>
<tr>
<td>Creating Text</td>
<td>11-1</td>
</tr>
<tr>
<td>csplit.</td>
<td>18-6</td>
</tr>
<tr>
<td>ctkgrp.</td>
<td>18-6</td>
</tr>
<tr>
<td>crunk.</td>
<td>18-6</td>
</tr>
<tr>
<td>Current ACD</td>
<td>6-11</td>
</tr>
<tr>
<td>Custom Database Items</td>
<td>18-9</td>
</tr>
<tr>
<td>Custom Reports</td>
<td>3-11 , 4-2</td>
</tr>
<tr>
<td>Custom Tables</td>
<td>18-13</td>
</tr>
<tr>
<td>Adding Data</td>
<td>18-24</td>
</tr>
<tr>
<td>Changing a Column</td>
<td>18-23</td>
</tr>
<tr>
<td>Changing Data</td>
<td>18-24</td>
</tr>
<tr>
<td>Deleting a Column</td>
<td>18-23</td>
</tr>
<tr>
<td>Deleting Data</td>
<td>18-25</td>
</tr>
<tr>
<td>Cut.</td>
<td>4-5</td>
</tr>
<tr>
<td>Cut Items</td>
<td>5-4</td>
</tr>
<tr>
<td>Cutting an Item from the Report</td>
<td>5-4</td>
</tr>
<tr>
<td>cvdn.</td>
<td>18-6</td>
</tr>
<tr>
<td>cvector.</td>
<td>18-6</td>
</tr>
<tr>
<td>D</td>
<td></td>
</tr>
<tr>
<td>dagent.</td>
<td>18-7</td>
</tr>
<tr>
<td>Data</td>
<td></td>
</tr>
<tr>
<td>Adding Data in a Custom Table</td>
<td>18-24</td>
</tr>
<tr>
<td>Changing Data in a Custom Table</td>
<td>18-24</td>
</tr>
<tr>
<td>Deleting Data in a Custom Table</td>
<td>18-25</td>
</tr>
<tr>
<td>Merging.</td>
<td>1-1</td>
</tr>
<tr>
<td>Data Expressions</td>
<td></td>
</tr>
<tr>
<td>Calculation Names</td>
<td>18-11</td>
</tr>
<tr>
<td>Calculations</td>
<td>18-10</td>
</tr>
<tr>
<td>Constants</td>
<td>18-9</td>
</tr>
<tr>
<td>Data from More Than One Table</td>
<td>18-12</td>
</tr>
<tr>
<td>Data in a Table</td>
<td></td>
</tr>
<tr>
<td>Adding.</td>
<td>18-19 , 18-24</td>
</tr>
<tr>
<td>Changing.</td>
<td>18-24</td>
</tr>
<tr>
<td>Deleting.</td>
<td>18-24</td>
</tr>
<tr>
<td>Data Items Fields</td>
<td>9-4</td>
</tr>
<tr>
<td>Data Labels</td>
<td>12-11</td>
</tr>
<tr>
<td>Data Labels Tab</td>
<td></td>
</tr>
<tr>
<td>Above Point</td>
<td>12-11</td>
</tr>
<tr>
<td>Base.</td>
<td>12-11</td>
</tr>
<tr>
<td>Below Point</td>
<td>12-11</td>
</tr>
<tr>
<td>Category Name</td>
<td>12-12</td>
</tr>
<tr>
<td>Center.</td>
<td>12-11</td>
</tr>
<tr>
<td>Inside.</td>
<td>12-11</td>
</tr>
<tr>
<td>Left.</td>
<td>12-11</td>
</tr>
<tr>
<td>None.</td>
<td>12-11</td>
</tr>
<tr>
<td>Outside.</td>
<td>12-11</td>
</tr>
<tr>
<td>Index</td>
<td>CentreVu® CMS R3V8 Upgrades and Migration</td>
</tr>
<tr>
<td>-------</td>
<td>------------------------------------------</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Data Labels Tab (continued)</th>
<th>12-9, 13-5</th>
</tr>
</thead>
<tbody>
<tr>
<td>Percent</td>
<td>12-12</td>
</tr>
<tr>
<td>Right</td>
<td>12-11</td>
</tr>
<tr>
<td>Series Name</td>
<td>12-12</td>
</tr>
<tr>
<td>Using</td>
<td>12-12</td>
</tr>
<tr>
<td>Value</td>
<td>12-12</td>
</tr>
<tr>
<td>Data on Chart</td>
<td>12-9</td>
</tr>
<tr>
<td>Data on Table</td>
<td>13-5</td>
</tr>
<tr>
<td>Data Retrieval</td>
<td>17-5</td>
</tr>
<tr>
<td>How CMS Retrieves Data</td>
<td>17-5</td>
</tr>
<tr>
<td>Data Storage</td>
<td>17-2</td>
</tr>
<tr>
<td>How CMS Stores Data</td>
<td>17-1</td>
</tr>
<tr>
<td>Data Tab</td>
<td>12-9, 13-5</td>
</tr>
<tr>
<td>Available Data</td>
<td>12-9, 13-5</td>
</tr>
<tr>
<td>Data on Chart</td>
<td>12-9</td>
</tr>
<tr>
<td>Data on Table</td>
<td>13-5</td>
</tr>
<tr>
<td>Using</td>
<td>12-9, 13-5</td>
</tr>
<tr>
<td>Database</td>
<td>7-4</td>
</tr>
<tr>
<td>How CMS Retrieves Data</td>
<td>17-5</td>
</tr>
<tr>
<td>How CMS Stores Data</td>
<td>17-1</td>
</tr>
<tr>
<td>What is a Database Item</td>
<td>17-3</td>
</tr>
<tr>
<td>What is a Database Table</td>
<td>17-2</td>
</tr>
<tr>
<td>Database Item</td>
<td>17-3</td>
</tr>
<tr>
<td>What is It</td>
<td>17-3</td>
</tr>
<tr>
<td>Database Items</td>
<td>7-5</td>
</tr>
<tr>
<td>Custom</td>
<td>18-9</td>
</tr>
<tr>
<td>Standard</td>
<td>18-8</td>
</tr>
<tr>
<td>Database Table Names</td>
<td>18-6</td>
</tr>
<tr>
<td>Date</td>
<td>6-4</td>
</tr>
<tr>
<td>dcwc</td>
<td>18-7</td>
</tr>
<tr>
<td>Default Value</td>
<td>6-11</td>
</tr>
<tr>
<td>Define Input Window</td>
<td>6-2</td>
</tr>
<tr>
<td>Defining</td>
<td>18-11</td>
</tr>
<tr>
<td>Calculation Names</td>
<td>18-11</td>
</tr>
<tr>
<td>Constants</td>
<td>18-9</td>
</tr>
<tr>
<td>Input Fields</td>
<td>6-2</td>
</tr>
<tr>
<td>Rows</td>
<td>18-5</td>
</tr>
<tr>
<td>Defining Queries</td>
<td>7-2</td>
</tr>
<tr>
<td>Delete</td>
<td>3-2, 4-6</td>
</tr>
<tr>
<td>Delete Input Fields</td>
<td>6-8</td>
</tr>
<tr>
<td>Delete Items</td>
<td>5-5</td>
</tr>
<tr>
<td>Deleting a Query</td>
<td>7-26</td>
</tr>
<tr>
<td>Deleting an Item from the Report</td>
<td>5-5</td>
</tr>
<tr>
<td>Deleting Input Fields from the Input Window</td>
<td>6-8</td>
</tr>
<tr>
<td>Depth to Height</td>
<td>12-24</td>
</tr>
<tr>
<td>Description</td>
<td>3-3, 3-5</td>
</tr>
<tr>
<td>Design Mode</td>
<td>4-2, 5-1</td>
</tr>
<tr>
<td>Designing Reports</td>
<td></td>
</tr>
<tr>
<td>Basic Tasks</td>
<td>4-11, 4-13</td>
</tr>
<tr>
<td>Document</td>
<td></td>
</tr>
<tr>
<td>Contents</td>
<td>1-4</td>
</tr>
<tr>
<td>Documents</td>
<td></td>
</tr>
<tr>
<td>Related</td>
<td>1-7</td>
</tr>
<tr>
<td>Drag-and-Drop to Arrange Items on the Report</td>
<td>5-6</td>
</tr>
<tr>
<td>dsplit</td>
<td>18-7</td>
</tr>
<tr>
<td>dtkgrp</td>
<td>18-7</td>
</tr>
<tr>
<td>dtrunk</td>
<td>18-7</td>
</tr>
</tbody>
</table>

| dvdn                          | 18-7       |
| dvector                       | 18-7       |

| E                              |            |
| Edit                          | 3-2, 3-12, 6-3 |
| Edit | Inputs      | 6-1        |
| Edit | Queries     | 7-1        |
| Edit an Existing Report        | 4-13       |
| Edit Inputs                    |            |
| Select inputs for this report  | 6-3        |
| Edit Menu                      | 4-5        |
| Align Controls                 | 4-6        |
| Copy                          | 4-6        |
| Cut                           | 4-5        |
| Delete                        | 4-6        |
| Inputs                        | 4-6        |
| Paste                         | 4-6        |
| Queries                       | 4-6        |
| Undo Align Controls           | 4-5        |
| Undo Cut/Delete               | 4-5        |
| Edit Query Items              | 7-5        |
| Editing an Existing Integrated Query | 7-21      |
| Editing an Existing Real-Time or Historical Query | 7-17 |
| Editing an Existing Report     | 4-13       |
| Editing the Appearance of Input Fields | 6-10   |
| Editing the Order of Input Fields | 6-9   |
| Elevation                     | 12-22      |
| Enter a name for this query   | 7-11, 7-16 |
| Enter the SQL WHERE criteria  | 7-8, 7-19  |
| Enter the start time for this integrated query | 7-14, 7-23 |

<table>
<thead>
<tr>
<th>Error Codes</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>16-11</td>
</tr>
<tr>
<td>10</td>
<td>16-12</td>
</tr>
<tr>
<td>11</td>
<td>16-12</td>
</tr>
<tr>
<td>12</td>
<td>16-13</td>
</tr>
<tr>
<td>13</td>
<td>16-13</td>
</tr>
<tr>
<td>2</td>
<td>16-11</td>
</tr>
<tr>
<td>3</td>
<td>16-11</td>
</tr>
<tr>
<td>4</td>
<td>16-11</td>
</tr>
<tr>
<td>5</td>
<td>16-12</td>
</tr>
<tr>
<td>6</td>
<td>16-12</td>
</tr>
<tr>
<td>7</td>
<td>16-12</td>
</tr>
<tr>
<td>8</td>
<td>16-12</td>
</tr>
<tr>
<td>9</td>
<td>16-12</td>
</tr>
<tr>
<td>Historical</td>
<td>16-5</td>
</tr>
<tr>
<td>Real-Time</td>
<td>16-11</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Error Messages</th>
<th>16-1, 16-2</th>
</tr>
</thead>
<tbody>
<tr>
<td>$ Not Defined</td>
<td>16-2</td>
</tr>
<tr>
<td>Cannot Mix Aggregates and Nonaggregates in the Select</td>
<td>16-2</td>
</tr>
<tr>
<td>Cannot Use the SYN Function for Order By</td>
<td>16-2</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>CMS System Error</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Check the Error Log</td>
<td>16-2</td>
</tr>
<tr>
<td>Data Collection Off</td>
<td>16-2</td>
</tr>
<tr>
<td>Too Much Data Retrieved</td>
<td>16-3</td>
</tr>
<tr>
<td>Updating Translations</td>
<td>16-3</td>
</tr>
</tbody>
</table>
Index

Error Messages (continued)
- Historical ............................................. 16-5
- INFORMIX-SQL ........................................ 16-5
- Keyword AVG Invalid in Where Clause .......................... 16-3
- Keyword BETWEEN Invalid for Real-Time .................... 16-3
- Keyword COUNT Invalid in Where Clause ................... 16-3
- Keyword MAX Invalid in Where Clause ..................... 16-3
- Keyword MIN Invalid in Where Clause ..................... 16-3
- Keyword SUM Invalid in Where Clause .................... 16-4
- Keyword SYN Invalid in Where Clause ................... 16-4
- Real-Time ............................................. 16-11
- Exceptions Data ........................................ 3-5
- Exceptions data ...................................... 3-5
- Excluding Rows of Data .................................. 18-5
- Exit ..................................................... 4-5
- Exiting the Report Designer ................................. 4-3
- Extension .............................................. 6-4

F

- f_cday ................................................. 18-8
- f_cdayrep ............................................. 18-8
- Field .................................................. 4-7, 4-8
- Field Assistant ....................................... 9-1
  - Select a field type ................................ 9-2
  - Select a query and associated data item for this field 9-4
  - Select an input for your field ...................... 9-5
- Field Content Format ................................ 14-2
- Field Format Options ................................ 14-2
  - Using .............................................. 14-4
- Field Label Location ................................ 14-2
  - Location of legend ................................ 14-2
  - Visible ............................................ 14-2
- Fields
  - Creating/Inserting ................................ 9-1
  - ACD Name .......................................... 9-3
  - Data Items ......................................... 9-4
  - Input Values ...................................... 9-5
  - Placement .......................................... 9-3
  - Report Data Start Time Field ........................ 9-6
  - Select a field type ................................ 9-2
  - Select a query and associated data item for this field 9-4
  - Select an input for your field ...................... 9-5
  - Time Report Run ................................... 9-7
- Defining ............................................ 7-6, 7-7, 18-9, 18-11, 18-12
- Formatting ........................................... 14-1, 14-4
  - Align .............................................. 14-2
  - Field Content Format ................................ 14-2
  - Field Label Location ................................ 14-2
  - Font ................................................ 14-2
  - Format ............................................. 14-3
  - Show Value as Name ................................ 14-3
  - FormattingLabel .................................... 14-2
  - Fixed Columns .................................... 13-3
- Fixed Rows ........................................... 13-3
- Folder ............................................... 3-5
- Font .................................................. 14-2
- Fonts ................................................. 12-13, 13-6
- Fonts Tab ............................................. 12-13, 13-6
  - Choose Font ...................................... 12-13, 13-6
  - Fonts .............................................. 12-13, 13-6
  - Using .............................................. 12-13, 13-7
- Forecast Data ........................................ 3-5
- Format ................................................. 13-8, 14-3
- Format | Chart ........................................ 12-1
- Format | Field ........................................ 14-1
- Format | Table ........................................ 13-1
- Format | Text .......................................... 15-1
- Format Menu ......................................... 4-7
  - Chart .............................................. 4-7
  - Field .............................................. 4-7
  - Sort by ............................................ 4-7
  - Table .............................................. 4-7
  - Text .............................................. 4-7
- Format Tab .......................................... 13-8
  - Align .............................................. 13-8
  - Format ............................................. 13-8
  - Item .............................................. 13-8
  - Merge with Next ................................... 13-9
  - Show All Formats ................................ 13-8
  - Show Value As ..................................... 13-8
  - Using .............................................. 13-9
  - Zeros as Blanks .................................. 13-9
- Formatting Chart Reports ................................. 12-2
- Formatting Grid Reports ................................. 12-2
- Reports ................................................
  - Formatting ........................................
    - Grid ..............................................
      - Formatting Text on the Report ................... 15-3
      - Function ....................................... 7-6

G

- General Tab .......................................... 12-3, 13-3
- Background Color ...................................... 12-3
- Fixed Columns ....................................... 13-3
- Fixed Rows .......................................... 13-3
- Options .............................................. 12-3
- Orientation ......................................... 13-3
- Real-Time ........................................... 12-3
- Rolling Chart ........................................ 12-3
- Show Gridlines ...................................... 13-3
- Using .............................................. 12-4, 13-4
- Graphics
  - Use of ........................................... 1-6
- Graphs
  - see Charts ........................................ 8-1

H

- hagent ............................................... 18-7
## Index

| Legend Tab | 12-15 |
| Location | 12-15 |
| Using | 12-16 |
| Visible | 12-15 |
| Line Chart | 12-20 |
| lineex | 18-8 |
| Location | 12-15, 12-18 |
| Location ID | 6-5 |
| Location of legend | 14-2 |
| Login ID | 6-5 |

### M
- magent . 18-7
- Make category and series selections . . 8-4
- MAX . . . . . 7-6
- Maximize Button . . . . . 4-10
- mcex . . . . . 18-8
- mcwc . . . . . 18-7
- Menu Bar . . . . . 4-4
- Menus . . . . . 4-4
- Merge with Next . . 13-9
- Merging Data . . 1-1
- MIN . . . . . 7-6
- Minimize Button . . . . 4-10
- msplit . . . . . 18-7
- mtkgrp . . . . . 18-7
- mtrunk . . . . . 18-7
- MULTI_ACD . . . . . 7-11
- Multi-ACD Reports . . . . . 6-12
- Inputs . . . . . 7-11
- WHERE clause . . . . . 7-11
- Multiple Clauses . . . . . 18-4
- Multi-value . . . . . 6-10
- mvdn . . . . . 18-7
- mvector . . . . . 18-7

### N
- Name . . . . . 3-3, 3-5
- New . . . . . 3-2, 3-12
- New Input . . . . 7-10
- New Report . . . . 4-11
- None . . . . . 12-11
- Number . . . . . 6-5

### O
- Oblique . . . . . 12-23
- Opening the Report Designer Using the Edit or New Button . . . 3-12
- Operand1 box . . . . . 7-10
- Operand2 box . . . . . 7-10
- Operator box . . . . . 7-10
- Operators . . . . . 18-4
- And/Or . . . . . 18-4
- Arithmetic . . . . . 18-10

### Operators (continued)
- Relational . . . . . 18-2
- Options . . . . . 12-3
- Options Menu . . . . . 4-8
- Align To Grid . . . . . 4-8
- Status Bar . . . . . 4-8
- OR button . . . . . 7-10
- Order of Input Fields . . . . . 6-9
- Orientation . . . . . 13-3
- Orthogonal . . . . . 12-23
- Other . . . . . 7-5
- Outside . . . . . 12-11
- Overview of CMS Database . . . . . 17-1
- Overwrite the existing report . . . . . 3-10
- Owner . . . . . 3-3

### P
- pagent . . . . . 18-6
- Paste . . . . . 4-6, 5-2, 5-3
- Pattern Matching . . . . . 6-7
- pcwc . . . . . 18-6
- Percent . . . . . 12-12
- Permissions . . . . . 6-7, 12-23
- For using Report Designer . . . . . 4-2
- Perspective . . . . . 12-23
- Phase 1 Error Messages . . . . . 16-2
- Pie Chart . . . . . 12-20
- Projection . . . . . 12-23
- Prompt . . . . . 6-11
- Properties . . . . . 3-2, 4-13
- Changing . . . . . 3-3
- Vieing . . . . . 3-3
- psplit . . . . . 18-6
- ptkgrp . . . . . 18-6
- ptrunk . . . . . 18-6
- pvdn . . . . . 18-6
- pvector . . . . . 18-6

### Q
- Queries . . . . . 4-6, 4-11
- Copying . . . . . 7-25
- Creating . . . . . 7-1
- Creating Historical . . . . . 7-3
- Creating Integrated . . . . . 7-12
- Creating Real-Time . . . . . 7-3
- Defining . . . . . 7-2
- Deleting . . . . . 7-26
- Editing . . . . . 7-26
- Add the database items and calculations for the SELECT . . . . . 7-17
- Add the database items and calculations for the SELECT . . . . . 7-4, 7-13, 7-21
- Choose functions for the SELECT items . . . . . 7-6
- Enter a name for this query . . . . . 7-11, 7-16
- Enter the SQL WHERE criteria . . . . . 7-8, 7-19
### Index

**Query Assistant**
- Add the database items and calculations for the query
- Add the database items and calculations for the SELECT
- Choose functions for the SELECT items
- Enter a name for this query
- Enter the SQL WHERE criteria
- Enter the start time for this integrated query

**Query Items**
- Choose functions for the SELECT items
- Enter the SQL WHERE criteria
- Enter the start time for this integrated query

**Query Select**
- Choose functions for the SELECT items
- Enter the SQL WHERE criteria
- Enter the start time for this integrated query

**Querier, Editing (continued)**
- Add the database items and calculations for the query
- Add the database items and calculations for the SELECT
- Choose functions for the SELECT items
- Enter a name for this query
- Enter the SQL WHERE criteria
- Enter the start time for this integrated query

**Report Designer Basics**
- Choose functions for the SELECT items
- Enter the SQL WHERE criteria
- Enter the start time for this integrated query

**Report Data Start Time**
- Choose functions for the SELECT items
- Enter the SQL WHERE criteria
- Enter the start time for this integrated query

**Report Properties**
- Choose functions for the SELECT items
- Enter the SQL WHERE criteria
- Enter the start time for this integrated query

**Report Designer Menus**
- Add the database items and calculations for the query
- Add the database items and calculations for the SELECT
- Choose functions for the SELECT items
- Enter a name for this query
- Enter the SQL WHERE criteria
- Enter the start time for this integrated query

**Report Items**
- Choose functions for the SELECT items
- Enter the SQL WHERE criteria
- Enter the start time for this integrated query

**Saving**
- Choose functions for the SELECT items
- Enter the SQL WHERE criteria
- Enter the start time for this integrated query

**S**

- Save
- Save As
- Save the report being copied as
- Save a query
- Select a database and one or more tables for the query
- Select a field type
- Select a query and associated database items for the table
- Select a query and associated data item for this field
- Select a table layout
- Select an existing query for the Summary line on your table
- Select an input for your field
- SELECT box
- Select inputs for this report
- Select the input used to indicate the xxx for this query

**Rows**
- Defining
- With User Inputs

**Run**
- Run

**Start Time**
- Start Time

**Start Time**
- Start Time

**Charts**
- Using

**Comparison**
- Using

**Series Labels Tab**
- Using

**Series Name**
- Using

**Sort by**
- Using

**spec**
- Using

**Starting Report Designer**
- Using

### R

- Range/List Variable
- Real-Time
- Related Documents
- Relational Operators
- Remove Input Fields
- Report Data Start Time
- Report Designer Basics
- Report Designer Menus
- Report Destination
- Report Input Fields
- Report Manager
- Report Menu
- Exit
- Run
- Save
- Save As
- Report Properties
- Formatting
- Chart
- see also Formatting Chart Reports
- see also Formatting Grid Reports
- Naming

**Resizing Items**
- Resizing Items
- Resizing Items

**Retrieving Data**
- Retrieve Data

**Right**
- Right

**Rolling Chart**
- Rolling Chart

**Rolling Charts**
- Rolling Charts

**Rows**
- Defining
- With User Inputs

**Run**
- Run

**Select**
- Select

**Select the input used to indicate the xxx for this query**
- Select the input used to indicate the xxx for this query

**Selecting Multiple Items on the Report**
- Selecting Multiple Items on the Report

**Selecting Rows from an ACD**
- Selecting Rows from an ACD

**Series Labels Tab**
- Series Labels Tab

**Series Name**
- Series Name

**Show All Formats**
- Show All Formats

**Show Gridlines**
- Show Gridlines

**Show Value As**
- Show Value As

**Show Value as Name**
- Show Value as Name

**Start**
- Start

**Starting Report Designer**
- Starting Report Designer

**SQL WHERE criteria**
- SQL WHERE criteria

**Stacked**
- Stacked

**Spex**
- Spex

**SQL Queries**
- SQL Queries

**Stacked**
- Stacked

**SQL WHERE criteria**
- SQL WHERE criteria

**Standard CMS Reports**
- Standard CMS Reports

**Save**
- Save

**Save As**
- Save As

**Save the report being copied as**
- Save the report being copied as

**Save a query**
- Save a query

**Select a database and one or more tables for the query**
- Select a database and one or more tables for the query

**Select a query and associated database items for the table**
- Select a query and associated database items for the table

**Select a query and associated data item for this field**
- Select a query and associated data item for this field

**Select an existing query for the Summary line on your table**
- Select an existing query for the Summary line on your table

**Select an input for your field**
- Select an input for your field

**SELECT box**
- SELECT box

**Select inputs for this report**
- Select inputs for this report

**Select the input used to indicate the xxx for this query**
- Select the input used to indicate the xxx for this query

**Select the query and data items you wish to plot on the chart**
- Select the query and data items you wish to plot on the chart

**Select the query and data items you wish to plot on the chart**
- Select the query and data items you wish to plot on the chart

**Selecting Multiple Items on the Report**
- Selecting Multiple Items on the Report

**Selecting Rows from an ACD**
- Selecting Rows from an ACD

**Series Labels Tab**
- Series Labels Tab

**Series Name**
- Series Name
<table>
<thead>
<tr>
<th>Topic</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Status Bar.</td>
<td>4-8</td>
</tr>
<tr>
<td>Step 1</td>
<td></td>
</tr>
<tr>
<td>Access the Define Input Window</td>
<td>6-3</td>
</tr>
<tr>
<td>Step Chart</td>
<td>12-20</td>
</tr>
<tr>
<td>Steps to Create a New Report</td>
<td>4-11</td>
</tr>
<tr>
<td>Steps to Edit an Existing Report</td>
<td>4-13</td>
</tr>
<tr>
<td>Store Data</td>
<td>17-2</td>
</tr>
<tr>
<td>String</td>
<td>6-5</td>
</tr>
<tr>
<td>SUM</td>
<td>7-6</td>
</tr>
<tr>
<td>Summary Options</td>
<td>13-13</td>
</tr>
<tr>
<td>Summary Tab.</td>
<td>13-13</td>
</tr>
<tr>
<td>Using</td>
<td>13-14</td>
</tr>
<tr>
<td>Supervisor definition</td>
<td></td>
</tr>
<tr>
<td>1-1, 6-1, 7-1, 8-1, 9-1, 10-1, 12-1, 13-1, 14-1, 15-1, 18-1</td>
<td></td>
</tr>
<tr>
<td>Supervisor Reports</td>
<td>3-11</td>
</tr>
<tr>
<td>System Menu Box</td>
<td>4-10</td>
</tr>
<tr>
<td>Tables, Formatting (continued)</td>
<td></td>
</tr>
<tr>
<td>Title</td>
<td>4-7</td>
</tr>
<tr>
<td>Definition</td>
<td>17-2</td>
</tr>
<tr>
<td>Table Assistant</td>
<td>10-2</td>
</tr>
<tr>
<td>Select a query and associated database items for the grid</td>
<td>10-2</td>
</tr>
<tr>
<td>Select a table layout</td>
<td>10-3</td>
</tr>
<tr>
<td>Select an existing query for the Summary line on your table...</td>
<td>10-4</td>
</tr>
<tr>
<td>Table Header</td>
<td>13-10</td>
</tr>
<tr>
<td>Tables</td>
<td></td>
</tr>
<tr>
<td>Building</td>
<td>18-15</td>
</tr>
<tr>
<td>Creating Custom</td>
<td>18-13</td>
</tr>
<tr>
<td>Creating/Inserting</td>
<td>10-1</td>
</tr>
<tr>
<td>Select a query and associated database items for the table</td>
<td>10-2</td>
</tr>
<tr>
<td>Select a table layout</td>
<td>10-3</td>
</tr>
<tr>
<td>Select an existing query for the Summary line on your table...</td>
<td>10-4</td>
</tr>
<tr>
<td>Formatting</td>
<td>13-1</td>
</tr>
<tr>
<td>Data Tab</td>
<td>13-5</td>
</tr>
<tr>
<td>Using</td>
<td>13-5</td>
</tr>
<tr>
<td>Fonts Tab</td>
<td>13-6</td>
</tr>
<tr>
<td>Using</td>
<td>13-7</td>
</tr>
<tr>
<td>Format Tab</td>
<td>13-8</td>
</tr>
<tr>
<td>Using</td>
<td>13-9</td>
</tr>
<tr>
<td>General Tab.</td>
<td>13-3</td>
</tr>
<tr>
<td>Using</td>
<td>13-4</td>
</tr>
<tr>
<td>Headers Tab.</td>
<td>13-10</td>
</tr>
<tr>
<td>Using</td>
<td>13-10</td>
</tr>
<tr>
<td>Sort Tab.</td>
<td>13-11</td>
</tr>
<tr>
<td>Using</td>
<td>13-12</td>
</tr>
<tr>
<td>Summary Tab.</td>
<td>13-13</td>
</tr>
<tr>
<td>Using</td>
<td>13-14</td>
</tr>
<tr>
<td>Undo Align Controls</td>
<td>4-5</td>
</tr>
<tr>
<td>Undo Cut/Delete</td>
<td>4-5</td>
</tr>
<tr>
<td>Update Rate in Seconds</td>
<td>6-6</td>
</tr>
<tr>
<td>User Permissions</td>
<td>4-2</td>
</tr>
<tr>
<td>Using the 3D Effects Tab</td>
<td>12-24</td>
</tr>
<tr>
<td>Using the Axis Tab</td>
<td>12-7</td>
</tr>
<tr>
<td>Using the Data Labels Tab</td>
<td>12-12</td>
</tr>
<tr>
<td>Using the Data Tab</td>
<td>12-9, 13-5</td>
</tr>
<tr>
<td>Using the Field Format Options Window</td>
<td>14-4</td>
</tr>
<tr>
<td>Using the Fonts Tab</td>
<td>12-13, 13-7</td>
</tr>
<tr>
<td>Using the Format Tab</td>
<td>13-9</td>
</tr>
<tr>
<td>Using the General Tab</td>
<td>12-4, 13-4</td>
</tr>
<tr>
<td>Using the Headers Tab</td>
<td>13-10</td>
</tr>
<tr>
<td>Using the Legend Tab</td>
<td>12-16</td>
</tr>
<tr>
<td>Using the Series Labels Tab</td>
<td>12-17</td>
</tr>
</tbody>
</table>
Using the Sort Tab .......................... 13-12
Using the Summary Tab .................... 13-14
Using the Title Tab ......................... 12-18
Using the Type Tab .......................... 12-21
Using This Document ....................... .1-4

V

Value ........................................... 12-12
Variable Name ................................ 18-3
VDN .............................................. 6-6
vdnex .......................................... 18-8
vecex .......................................... 18-8
Vector .......................................... 6-6
Vertical ....................................... 13-3
Viewing Distance ............................ 12-23
Viewing or Changing a Report's Properties . . 3-3
Viewing the Input Window ................... 6-15
Visible .......................................... .12-15, 12-18, 14-2

W

wagent ......................................... 18-7
wcwc ........................................... 18-7
WHERE box .................................... 7-10
WHERE clause ................................. 7-8, 7-11
Width to Height ............................. 12-24
Window
  Define Input .................................. 6-2
wsplit ......................................... 18-7
wtkgrp ........................................ 18-7
wtrunk ........................................ 18-7
wvdn ........................................... 18-7
wvector ...................................... 18-7

Z

Zeros as Blanks ............................... 13-9
How Are We Doing?

Document Title: CentreVu® Report Designer Version 8 User Guide

Document No.: 585-210-930 Issue 1 Date: December 1999

Lucent Technologies welcomes your feedback on this document. Your comments are of great value in helping us to improve our documentation.

1. Please rate the effectiveness of this document in the following areas:

<table>
<thead>
<tr>
<th></th>
<th>Excellent</th>
<th>Good</th>
<th>Fair</th>
<th>Poor</th>
<th>Not Applicable</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ease of Use</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Clarity</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Completeness</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Accuracy</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Organization</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Appearance</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Examples</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Illustration</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Overall Satisfaction</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

2. Please check the ways you feel we could improve this document:

☐ Improve the overview/introduction
☐ Improve the table of contents
☐ Improve the organization
☐ Include more figures
☐ Add more examples
☐ Add more detail
☐ Make it more concise/brief
☐ Add more step-by-step procedures/tutorials
☐ Add more troubleshooting information
☐ Make it less technical
☐ Add more/better quick reference aids
☐ Improve the index

Please provide details for the suggested improvement. ________________________________________
____________________________________________________________________________

3. What did you like most about this document?

____________________________________________________________________________
____________________________________________________________________________

4. Feel free to write any comments below or on an attached sheet.

____________________________________________________________________________
____________________________________________________________________________
____________________________________________________________________________
____________________________________________________________________________

If we may contact you concerning your comments, please complete the following:

Name: _______________________________ Telephone Number: (_____)__________________

Company/Organization: _____________________________ Date: ________________________

When you have completed this form, please fold, tape, and return to address on back or you can fax the form to 303-538-2195.